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1. About this manual

1.1. Copyrights
The information in this document is subject to change without notice and should not 
be construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for 
any errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or 
consequential damages of any nature or kind arising from the use of this document, 
nor shall ABB Oy be liable for incidental or consequential damages arising from use 
of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written 
permission from ABB Oy, and the contents thereof must not be imparted to a third 
party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license 
and may be used, copied, or disclosed only in accordance with the terms of such 
license.

Copyright © 2006 ABB Oy  
All rights reserved.

1.2. Trademarks
ABB is a registered trademark of ABB Group. All other brand or product names 
mentioned in this document may be trademarks or registered trademarks of their 
respective holders.

1.3. Guarantee
Please inquire about the terms of guarantee from your nearest ABB representative.

1.4. General
This manual provides thorough information on the SMS 510, Substation Monitoring 
System software and its applications. This document complies with the SMS 510 
version 1.3.0.

Pictures shown are examples only, and they may represent older program versions.

Additional information such as the Release Note and README.TXT can be found 
on the program distribution media.

ABB Oy regularly provides standard training courses on its main products.The 
training program is available on the Internet at  
http://www.abb.com/substationautomation. Contact your ABB representative for 
more information.
11
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1.5. Use of symbols
This publication includes warning, caution, and information icons that point out 
safety related conditions or other important information. It also includes tip icons to 
point out useful information to the reader. The corresponding icons should be 
interpreted as follows:

Although warning hazards are related to personal injury, and caution hazards are 
associated with equipment or property damage, it should be understood that 
operation of damaged equipment could, under certain operational conditions, result 
in degraded process performance leading to personal injury or death. Therefore, 
comply fully with all warning and caution notices.

1.6. Abbreviations

1.7. Related documents
MicroSCADA Status Codes is not included in the delivery of the electronic 
documentation.

The latest versions can be obtained from the Internet. See the page: www.abb.com/
substationautomation.

The caution icon indicates important information or warning related 
to the concept discussed in the text. It might indicate the presence of 
a hazard which could result in corruption of software or damage to 
equipment or property.

The information icon alerts the reader to relevant facts and 
conditions.

The tip icon indicates advice on, for example, how to design your 
project or how to use a certain function.

HSB Hot Stand-By
LAN Local Area Network
LON Local Operating Network, 

communication protocol developed by Echelon
PSN Project Structure Navigator
PST Parameter Setting Tool
RAS Remote Access Service
SMSCT SMS Conversion Tool
SPA Data communication protocol developed by ABB
SSS System Self Supervision
UNC Universal Naming Convention
12
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In column Use, E stands for Engineering type of tasks while O stands for Operation.

1.8. Document revisions

Name of the manual: Use Document ID

Installation and commissioning
SMS 510  
Installation and Commissioning Manual

E 1MRS751265-MEN

LON Gateways Configuration, 
Configuration Guide

E 1MRS751870-MEN

Relay Tools 
LIB, CAP and SMS,  
Tools for Relays and Terminals,  
User's Guide

Applicable on:
RED Relay object types
SPACOM Relay object types
SPACOM Relay Setting Tool
RED Relay Setting Tool
Graphical I/O Setting Tool
DR-Collector Tool
SPA Terminal Emulator
Disturbance Draw Tool
Event Log Viewer

E+O 1MRS752008-MUM

Parameter Setting Tool (PST)  
User's Manual

O 1MRK511114-UEN

REB 500/REB 500sys 
Operating Instructions

O 1MRB520292-Uen

CAP2/316 O 1MRB520271-Uen
SPTO Configuration Tool,  
Configuration Guide

E 1MRS751906-MEN

HV/Collect User's Manual O 1MRK511117-UEN
REB500 Selector, Description O 1KHA000967-AEN

Other
SMS 510 Release Note E,O
MicroSCADA Status Codes manual O 1MRS750850-MEN

Version SW Revision number Date History
C 1.2.0-1 05.01.2005 Maintenance updates
D 1.3.0 07.02.2006 - New Chapter 9.  �Gateway 

  object types (COM 610)�
- Maintenance updates
13
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2. Introduction to SMS 510

This chapter introduces SMS 510, its documentation, operational features, base 
system, user interface, functional description and tools.

2.1. General
SMS 510, the Substation Monitoring System, is a monitoring and parametrization 
software system product for medium and high voltage relays in the RED 500 series, 
SPACOM series, REx 216/316 series, REB 500, REx 5xx and RET 521.

SMS 510 can be used locally in a substation, at a remote location or in a distributed 
system both with a local and a remote SMS.

SMS 510 is the successor of the well-proven SMS 010.

2.2. Documentation guidance
The SMS 510 documentation, which comprises this User�s Guide and the manuals 
listed in Section 1.7. Related documents, is comprehensive. This section shortly 
describes how to use the SMS 510 documentation.

2.2.1. Documentation in general
The functions and tools are described in their own stand-alone chapters or in 
manuals of their own. That makes it easier to find information about the function or 
tool and to get a detailed description of it. The documentation contains screen shots 
to make it easy to orientate in the manuals and to present examples.

2.2.2. Navigating in the SMS 510 User�s Guide
The manual contains references and links within the texts to tables, pictures and 
other related chapters and sections, a table of contents list at the beginning of the 
manual as well as an index at the end of the manual, all in order to make it easier to 
navigate. Just click the linked item (no links for indexes), and the target destination 
is brought into focus.

2.2.3. SMS 510 User�s Guide contents
The chapters in this SMS 510 User�s Guide are stand-alone descriptions of the 
function or tool in question and can be used during operation of SMS 510, as well 
as technical references.

The following chapters in particular are recommended for those not yet familiar with 
SMS 510:

SMS 510 system introduction
An introduction to SMS 510 as a whole can be found in Chapter 2. Introduction to 
SMS 510.
15
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Getting started 
A guidance in form of an example of building a project with levels and relays is 
found in Chapter 3. Quick start example.

Tools and functions 
Refer to Section 2.7. SMS 510 functions and tools for a description of SMS 510 
functions and tools and corresponding documentation.

2.2.4. Separate documentation
The SMS 510 Installation and Commissioning manual describes the installation of 
SMS 510 and basic SMS 510 system configuration.

The Relay Tools and Disturbance Recordings Uploading Tools are described in 
stand-alone manuals, see Section 1.7. Related documents.

2.3. Operational features
This is a summary of functions provided by SMS 510:

� Product engineering (bay level)
� On-line and off-line engineering
� Framework for relay tools
� Loading of parameters to the relay
� Loading of parameters from the relay
� Loading of recorded values from the relay
� Comparison of present and saved values
� Uploading of disturbance recordings from the relay
� Graphical presentation of disturbance recordings (COMTRADE format)
� Project management
� Object oriented project data management
� User Management
� Integrated System Self Supervision
� Supervision Log Viewer
� Local/remote communication
� Time synchronization of connected units
� Setting of time/date
� Scheduler for defining of tasks to be performed on a regular basis
� Automatic dial-up of substations
� Task Monitor for monitoring the progress of tasks defined in the Scheduler 
� Relay Event Log Viewer
16
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2.4. User interface
The user interface of the SMS 510 system consists of the following components:

� Login view
� Project Structure Navigator for tool selection and object management
� Various tools and views

2.5. Base system
The SMS 510 system contains a base system and a communication system.

Supported communication protocols are:

� SPA, through the relay rear or front panel interfaces.

� LON communication, through LonTalk adapter to the relay rear panel interface
� Supported LON communication cards are:

� PCC-10 PC Card
� PCLTA-20 Card
� RER 109 PCLTA Card (in windows NT only)

2.6. Applications
A station control and protection system contains a wide variety of components and 
functions. SMS 510 is used for handling data and tools during relay engineering 
projects and for continuous follow-up and maintenance.

2.7. SMS 510 functions and tools
The following sections contain an overview of functions and tools provided within 
SMS 510. When the function or tool is described within this manual, the 
corresponding chapter or section is mentioned, otherwise the documentation is 
found in a separate manual, see Section 1.7. Related documents.

2.7.1. Project Structure Navigator
The Project Structure Navigator provides the tools for building a project tree with 
objects and a navigator for navigating in the project tree. User-defined views can 
also be made. Furthermore, the Project Structure Navigator manages insertion and 
configuration of objects, e.g. relays and launching of relay tools.

This is described in Chapter 4. Project Structure Navigator.

2.7.2. Project handling

Organize projects
The Organize Projects tool is used for project management purposes like deletion, 
duplication, and creation of projects. In addition to this, the tool is used when a 
project is to be transferred to another system or brought into the current collection 
of projects.

This is described in Chapter 5. Project Export/Import Tool.
17
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SMS Conversion Tool
With the SMS Conversion Tool, applications from SMS 010 can be imported to 
projects for use in SMS 510.

This is described in Chapter 17. SMS Conversion Tool.

2.7.3. System configuration

Plant Structure Settings
The Plant Structure Settings Tool is used for defining the attributes for the plant 
structure object types. 

This is described in Chapter 6. Plant Structure Settings, see also Chapter 8. User 
Structure object types.

System Configuration Tool
The System Configuration Tool is used for configuring the projects� system.

The System Configuration Tool contains three pages:

1. Communication 

The Communication page is used for setting of the basic communication 
configuration and time synchronization settings for communication over the serial 
ports and LON. This is described in the SMS 510 Installation and Commissioning 
manual.

2. Scheduler

The Scheduler is a function for defining scheduled task lists to be performed on a 
regular basis according to given time intervals. The Scheduler also allows 
suspension of defined tasks and/or task scheduling for an arbitrary period of time.

This is described in Chapter 15. Task scheduling.

3. General Settings 

The General Settings page contains the means for enabling/disabling the automatic 
logoff from SMS 510. This is described in Section 13.3. General Settings.

The General Settings page also contains the means for enabling/disabling the 
System Self Supervision.

This is described in Section 10.4. Enabling System Self Supervision and Section 
10.5. Disabling System Self Supervision.

The General Settings page also contains the MicroSCADA user password for remote 
connections. This is described in Section 13.3.3. MicroSCADA user settings for 
remote connections.

Device communication settings
The Communication page, which is opened by selecting the properties function for 
devices in the project tree, is used for configuring the communication settings, e.g. 
addressing of the device objects.
18
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Remote connections
The Remote Connections tool is used for setting up various kinds of connections:

� LAN over the local area network to another SMS 510, SYS 500 or COM 500 
installation.

� Dial-Up (SPA) over the telephone network
� Remote (RAS) to another SMS 510, SYS 500 or COM 500 installation

This is described in Chapter 12. Remote connections.

User management
The User Management tool is used for defining SMS 510 users with designated 
authorization levels in SMS 510.

This is described in Chapter 14. User Management.

Time/Date
With the Time/Date tool the operator can check the time and date of the system 
within the SMS 510 program and also, when needed, change the time and date of the 
PC.

This is described in Section 13.1. Time/Date Settings.

2.7.4. Monitoring functions

System Self Supervision
The System Self Supervision supports the operator in diagnosing errors encountered 
in the system.

This is described in Chapter 10. System Self Supervision.

Supervision Log Viewer
The Supervision Log viewer presents operational events in the SMS 510 system. 
Events generated in the relay modules are not included.

This is described in Chapter 11. Supervision Log Viewer.

Task Monitor
The task monitor displays both historical and actual progress of the tasks that have 
been defined in the Scheduler. 

This is described in Chapter 16. Task monitoring.

Event Log Viewer
The Event Log Viewer is used for uploading and viewing event logs from the  
RED 500 terminals. An event log is a snapshot of the current events in the event 
view of the connected terminal. This tool is documented in the Tools for Relays and 
Terminals manual.
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Relay Setting tools
The Relay Setting Tools provide service data, e.g. measurement values, counters and 
registered data from the relays.

2.7.5. Relay Setting tools
The Relay Setting tool (several occurrences depending on selected relay type) is 
used for parametrization of the relay units. The parameters are set on-line or off-line 
and downloaded to the relay or uploaded from the relay over a communication port.

The following Relay Setting tools are available in SMS 510 (for manuals, see 
Section 1.7. Related documents):

RED Relay Setting Tool for
� Parametrization of RED 500 series of relays
� REF54x - REF 54_ relay series
� REM54x - REM 54_ relay series
� REC52x - REC 52_ relay series
� RET54x - RET 54_ relay series
� REJ5xx - REJ 5_ relay series
� REU5xx - REU 5_ relay series
� REX52x - REX 52_relay series
� REx61x - RE_ 61_ relay series
� SPA communication
� LON communication

SPACOM Relay Setting Tool for
� Parametrization of SPACOM series of relays
� SPA communication

CAP 2/316 Tool for
� Parametrization of REx 216/316 series of relays
� SPA communication
� LON communication

REBWIN Tool for
� Parametrization of REB 500 relays
� Serial communication on dedicated serial port

Parameter Setting Tool (PST) for
� Parametrization of the REx 5xx series of relays and RET 521 
� SPA communication
� LON communication
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Graphical I/O Setting Tool
Graphical I/O Setting Tool is a setting tool for REX 521 relays used for the 
following tasks:

� Setting of digital inputs, digital outputs and alarm LED signals with graphical 
matrices

� On-line and off-line parametrization
� Uploading or downloading a group of parameters

The Graphical I/O Setting Tool is complementary to the RED Relay Setting Tool; a 
change of parameter setting in the Graphical I/O Setting Tool will be visible in the 
RED Relay Setting Tool, and vice versa.

SPTO Configuration Tool
This tool targets the control modules SPTO 1D2, SPTO 1D5, SPTO 1D6 in SPAC 
300 series and SPTO 6D3 in the SPAC 500 and 600 series in the SPACOM range of 
products.

The tool can be used to configure the SPTO 1D2, 1D5, 1D6 in the SPAC 300 series, 
when the default setting groups in the modules are not applicable, or whenever it is 
desirable to make an own configuration.

This tool is documented in the SPTO Configuration Tool manual.

2.7.6. Disturbance recording tools
SMS 510 provides the following tools for uploading of recordings from disturbance 
collecting relays (for manuals see Section 1.7. Related documents):

DR-Collector Tool
With the DR-Collector Tool, disturbance records can be uploaded from the RED 500 
and SPACOM series of relays. The supported recording file format is COMTRADE.

HV/Collect
With the HV/Collect Tool, disturbance records can be uploaded from the REx 5xx 
series of relays and RET 521. The supported recording file formats are 
COMTRADE and REVAL.

CAP 2/316 Tool for
� Disturbance file uploading 
� SPA communication
� LON communication
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2.7.7. Disturbance evaluation tools

Disturbance Draw 
With the Disturbance Draw Tool disturbance recordings in COMTRADE format 
can be graphically presented.

2.7.8. Additional tools 

MicroSCADA Service Access manager
The user groups that can start and use SMS 510 are defined with this tool. This tool 
is documented in the SMS 510 Installation & Commissioning manual.

SPA Terminal Emulator
The SPA Terminal Emulator is used for manual sending of SPA messages to 
SPACOM relays, e.g. for address changing or communication test purposes. 
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3. Quick start example

About this chapter
This chapter discusses the basic steps for getting started with SMS 510 and is 
intended to serve as an introductory reading to users not familiar with SMS 510.

The quick start example:

� Guides you through the process of constructing a representation of a simple 
station with bays with RED 500, SPACOM, REx 216/316, REB 500, REx 5xx 
relays, familiarizing you with basic functions such as adding, configuring and 
moving objects in a project.

� Illustrates one solution to organize the project by means of user views.

3.1. Inserting objects, to observe
You can insert different object types to the project in almost any order. This example 
starts by inserting the relay objects to the root level of the project. As the next step, 
the structure with station and bays is inserted and the relay objects are moved to bay 
level. You can also start by creating the tree level structure with stations and bays 
and later insert the relays directly to the target location.

This Quick Start example features a moving of objects operation, as an illustration 
of how it is done. Moving objects is not a part of the ordinary insertion procedure. 
Furthermore, you can have the relay devices inserted on several levels in the project, 
starting from the root level. 

You should try using project structuring and correct naming conventions, in order to 
make your project easy to handle and use. You can later change the names of the 
objects you have inserted.

3.2. Summary of steps
The steps for project building, i.e. insertion and preparation of objects, system 
configuration (basic communication) for the project and device level addressing, are 
listed below. The steps are not numbered because the order is not critical, but use it 
as a recommendation. (These steps are illustrated in this Quick Start chapter together 
with launching of object tools).

� Insert the objects to the project
� Use the Properties function to select the proper Object type (relay family)
� Use the Attributes function (when needed) to assign relay modules
� Give the Communication address of the devices

When your project is prepared and ready, you can start configuring other functions 
or taking additional functions into use, e.g. from the System Tools menu. You can 
also start launching tools for the objects.

In this example, it is assumed that you have completed 
commissioning of the SMS 510 software, which is explained in the 
SMS 510 Installation and Commissioning manual.
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3.3. Projects
SMS 510 supplies an initial empty project titled �SOST�. Initially, the SOST project 
is set as the default project, meaning that this project will contain the new objects 
unless another project is explicitly created and opened, e.g. the Quick Start project, 
using the Create� function in the Project Export/Import Tool, see Fig. 5.2.-1 and 
Section 5.3.10. Creating a new project. For detailed information on working with 
SMS 510 projects, see Chapter 5. Project Export/Import Tool.

3.4. Views
The Project Structure Navigator provides the possibility to define different view 
contexts. This feature makes it possible to group the inserted objects arbitrarily, 
which is a useful feature when the number of inserted objects is large. For detailed 
information on working with project views, see Section 3.13. Using user views.

3.5. Object types
There are three main categories of object types, i.e. level object types, device object 
types and compound object types.

The level object types are used for building the structure of the projects and their 
views.

The device object types are used when a physical device is to be configured. For 
example, REF54x is a device object type.

Compound object types combine behaviour of both level and device object types. In 
essence, compound object types participate in the structuring of a project but they 
also have configurable properties, similar to the device object types. For instance, 
you can use Station and Bay objects to build a representation of a station and its 
bays. Another example is the communication gateway object types, e.g. LSG (LON/
SPA Gateway). Device objects can be hosted by a gateway object, for which you 
define correct communication settings to enable communication through the 
gateway.

3.6. Object type groups
Each object type belongs to one named object type group, which provides similar 
functionality.

Four object type groups are available:

User Structure Object types of this group serve the purpose of project 
structuring.

Plant Structure Object types of this group serve the purpose of project 
structuring.

Gateway Object types of this group serve the purpose of project 
structuring and representation of communication gateway 
devices.

Protection & Control Object types of this group serve the purpose of 
representing protection and control devices.
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3.7. Starting SMS 510
To start SMS 510, select the Start SMS 510 icon from the SMS 510 program folder, 
created by the SMS 510 installation program, see Fig. 3.7.-1.

Start_SMS

Fig. 3.7.-1 Starting SMS 510

The SMS 510 Login window, see Fig. 4.6.-1, appears. Click the Login button to 
open the Project Structure Navigator with the default project opened in the Master 
Design View mode.

3.8. Exiting SMS 510
By selecting Exit from the File menu in the Project Structure Navigator, a logout is 
performed and the Login window appears, see Fig. 4.6.-1. By selecting Exit in the 
Login window, the SMS 510 session is ended completely.

3.9. Insertion of objects
In this section, you begin by inserting four RED 500 device objects and one 
SPACOM device object to the project. Then you add a simple representation of a 
station with three bays, illustrating how to move the device objects in the project 
structure.

Device object insertion
At this point, your project contains only the abstract root node, which is titled 
�ROOT�. Click on the root node, so that the navigator knows where to insert the new 
object in the project structure. Next, choose Insert Object on the navigator�s Edit 
menu, which causes the Add Project Object dialog to appear, see Fig. 3.9.-2. An 
alternative and quicker way to insert device objects is to use the Insert Object button, 
see Fig. 3.9.-1, but the easiest way is to press the <Ins> key on the keyboard.

Fig. 3.9.-1 The Insert Object button
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Fig. 3.9.-2 Adding a new object to the project

This dialog displays the object type groups and the object types present in the 
system. As you are now inserting a device object, the interest group is �Protection & 
Control�, which groups the RED 500 series, SPACOM series, REx 216/316, REB 
500, REx 5xx series and RET 521 object types.

To insert a device object representing a REF54x relay terminal of the RED 500 relay 
series, click on the Protection & Control list item. As a result, the list of Protection 
& Control object types appears on the screen. The first available object type is 
automatically selected, as shown in Fig. 3.9.-3.

add_proj_obj

Fig. 3.9.-3 Selecting the type of the object

The appropriate object type (REF54x) is already selected. To insert it, click OK, 
which opens the New Object�s Properties dialog for entering the object's name and 
title, see Fig. 3.9.-4.

�Object Name� is used for SMS 510 object managing and should be unique within 
the project. �Object Title� is the object description that is presented to the user in the 
Project tree for the particular object. Object Name and Object Description can later 
on be changed in the Properties/General Object Attributes dialog, see Fig. 3.12.2.-2.
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Fig. 3.9.-4 Entering the name and title for the object

Type in the name and title and click OK, so that the dialog closes and the object is 
inserted under the root node. Now your project should look like the one shown in the 
figure below:

qs3b

Fig. 3.9.-5 The inserted REF54x device object in the project view

Repeat this insertion procedure twice, specifying �OUT1� and �OUT2� as the names 
and �Protection and control� as the title for both of the objects. These new REF54x 
objects will also be inserted under the project�s root node, as the project does not yet 
contain any compound objects being able to host the device objects. Your project 
should now look like the one shown in Fig. 3.9.-6.

qs4b

Fig. 3.9.-6 Three REF54x device objects in the project
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Now you have three REF54x device objects in the project. As you may recall, the 
aim is to also insert a device object of the SPACOM type.

To accomplish this, repeat the insertion procedure, with the exception that you select 
the SPACOM object type from the Protection & Control group. For the object�s 
name and title, specify �INCOMER2� and �Differential protection�. When you are 
ready, the project should look like the one shown in Fig. 3.9.-7.

qs5b

Fig. 3.9.-7 Four device objects in the project view

Notice that in terms of usability, these newly inserted device objects are somewhat 
abstract, since they lack essential information about the physical relay terminals they 
represent. These objects need to be configured before they can be used. The 
configuration procedure is explained later.

As you now have some device objects, you can proceed to add compound objects to 
the project, in order to organize the contents of the project.

Compound object insertion - Plant Structure
Next, you will build a simple representation of a station with three bays. 

Start by selecting the project�s root node that will be the insert-location for the 
Station object. In fact, the only location where you can insert a Station object is the 
project's root node.

In the Edit menu, choose Insert Object to bring up the Add Project Object dialog. 
Since the Station object type belongs to the Plant Structure group, select Plant 
Structure group as shown in Fig. 3.9.-8.

Fig. 3.9.-8 Selecting a Station object
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To insert the Station object, click OK. The dialog that now appears for entering 
attributes for the object is specific for insertion of Plant Structure objects, as 
illustrated in Fig. 3.9.-9. Enter �Eastwick� as the object�s title and �STA1� as its 
name.

Fig. 3.9.-9 Inserting a Plant Structure object - Station

Click OK to insert the station object. Now your project should look like the one in 
Fig. 3.9.-10.

qs8b

Fig. 3.9.-10 The new Station object in the project view

You now have a Station object capable of hosting the bays. Next, you will insert 
three Bay objects under the station. Eventually, the project�s device objects will be 
moved under these bays.

As the station will be the parent for the bays, select the Station object to set the 
correct insert-location.

Invoke the Add Project Object dialog. The navigator is aware of the currently 
selected object�s type (Station) and displays the available object groups and types 
accordingly, see Fig. 3.9.-11.
29



1MRS751267-MUM

User�s Guide

SMS 510
Fig. 3.9.-11 Selecting the Bay object type

To insert the object, click OK and specify the name and title as in Fig. 3.9.-12.

Fig. 3.9.-12 Specifying name and title for the Bay object

Next, add two bays similarly, specifying �Bay2�, �Bay3� and �Outgoing 1�, 
�Outgoing 2� as their names and titles. Now your project should look like the one 
shown in Fig. 3.9.-13.
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Fig. 3.9.-13 The station hosting three bays

You are now ready to organize the project further by moving the device objects to 
more appropriate locations in the project structure.

3.10. Moving objects in the project
In this section, the existing device objects are moved to new locations in the project 
structure.

Fig. 3.10.-1 illustrates the intended final organization of the device objects in the 
Master Design View.

qs12b

Fig. 3.10.-1 Objects in their final locations
31



1MRS751267-MUM

User�s Guide

SMS 510
The procedure for moving objects in the project�s views consists of the following 
steps:

1. Select the object you intend to move by clicking it.
2. On the Project Structure Navigator�s Edit menu, select Object Properties to 

bring up the General Object Attributes dialog or press <Alt>+<Enter> on the 
keyboard.

3. Click Move on the General Object Attributes dialog to bring up the Move 
Object dialog.

4. From the project structure, select the target compound object, which will host 
the moved object.

5. Click Move Here on the Move Object dialog to move the object to the selected 
target location.

Following this procedure, move the objects one at a time to the locations shown in 
Fig. 3.10.-1. Notice that moving a device object under a bay object causes the station 
node to collapse. A collapsed node is expanded by either double-clicking it or by 
clicking the plus sign (+) on the node's left-hand side.

3.11. System configuration
The system communication should also be configured at some point. It has to be 
done before you configure the communication settings on device (relay) level, see 
Fig. 3.12.2.2.-3. You need to make the basic communication definitions for the 
serial ports and LON channels. From the System Tools menu, select item System 
Configuration and page Communication, see Fig. 3.11.-1.

Sys_Conf

Fig. 3.11.-1 Setting up the serial ports
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How to set up the LON channel is described in the SMS 510 Installation and 
Commissioning manual.

Use the Add button to add a serial port. Usually the default settings are sufficient. 
Press OK, to save and to exit.

Next, you will advance by configuring the project's device objects.

3.12. Configuration of device objects

3.12.1. General
Prior to using an inserted device object, the object must be configured. Otherwise, 
attempts to launch an object tool result in notifications requesting you to configure 
the object.

For instance, configuring a REF54x device object means that the object is assigned:

1. The software configuration (SW), which is a set of hardware dependent files. 
The software configurations are supplied solely by ABB.

2. The application (Apl) configuration, which is a set of application dependent 
files. An application configuration is either supplied by ABB or created within 
the SMS 510 environment, which is why it has been saved in the application 
library of the object�s object type.

3.12.2. Relay configuration procedure
A device object is configured in the Master Design View by means of a dialog, 
which is dependent on the device object�s type. To enter this type-dependent dialog:

1. Select the device object in the project structure.
2. Select Object Properties on the Edit menu to open the General Object 

Attributes dialog for the object or press <Alt>+<Enter> on the keyboard. You 
can use the Properties button as well, see Fig. 3.12.2.-1.

Fig. 3.12.2.-1 The Properties button

3. Click Attributes to open the object�s configuration dialog, see  
Fig. 3.12.2.-2. (No attribute function is needed for setting of REx 5xx and RET 
521 relays).
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Fig. 3.12.2.-2 General page for INCOMER1

3.12.2.1. RED 500 relay object types
1. In the SW library, select the SW configuration that matches the relay terminal 

that is to be used.
2. Select an application in the Apl library, or if the application is unknown, some 

of the RED relay object types allow uploading of the configuration from the 
relay terminal. The uploaded configuration is available for selection in the Apl 
library list.

Close the object�s configuration dialog by clicking OK to return to the General 
Object Attributes dialog. For more information on configuring device objects, see 
the Tools for Relays and Terminals manual.

Configuring quick start device objects
To proceed with the example, you need to configure the device objects in the order 
they appear in the project. Once you are done, the objects are configured as shown 
in Table 3.12.3-1.

To proceed, select the device object �INCOMER1� which is titled �Incomer 
protection and control�. On the Edit menu, select Object Properties to bring up the 
General Object Attributes dialog. The tabbed page titled General is active, 
displaying general information on the object. Notice that in this dialog, you can 
change some of the object�s attributes in the Master Design View.

To configure the REF54x device, click Attributes and you enter the REF54x 
Configuration dialog, shown in Fig. 3.12.2.1.-1.
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Fig. 3.12.2.1.-1 The configuration dialog for REF54x device objects 

Assigning software configuration
As stated in Table 3.12.3-1, this object�s software configuration should be �REF543-
1MRS118501 rev. F�, which means that the software configuration suggested by 
default has to be changed. In the dialog�s upper area, the Select New check box is 
checked, allowing you to select the appropriate software configuration.

To change the configuration, select the configuration named �REF543-
1MRS118501� from the list titled SW library and select revision �F� from the list 
titled �Rev�.

Assigning application configuration
To complete this object�s configuration, you need to assign the intended application 
configuration for the object, in this example it is �1MRS114502� revision �A�.

To assign it, select the application configuration �1MRS114502� from the list titled 
Apl library and the revision �A� from the list titled Rev. Next, click OK to apply the 
configuration, saving it to the project database. You now returned to the General 
Object Attributes dialog, close it by clicking OK.
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Uploaded application configurations in REF54x, REM54x, REC52x and  
RET54x object types

The REF54x, REM54x, REC52x and RET54x object types provide an alternative to 
use an application configuration, which you can upload from the relay terminal. 
Upon completion of the upload, you save the uploaded configuration into the object 
type�s user-application library. These application configurations are stored without 
revision information and are available through the Apl library list, shown in 
Fig. 3.12.2.1.-1. The use of uploaded application configurations is outlined below: 

1. Insert the device object to the project.
2. Configure the object as explained above, assigning an empty application 

configuration, which you eventually will replace with the uploaded 
configuration. Apply the configuration normally and then return to the Project 
Structure Navigator.

3. Reopen the General Object Attributes dialog selecting the Communication 
page to provide communication settings for the object. Select the 
communication protocol and enter the communication settings that match the 
settings in the relay unit. Connect the communication cable, if not done yet.

4. Open the object type's configuration dialog. Click Apl Utils� and enter the 
dialog for maintaining the user application library.

5. By clicking Receive, the upload starts bringing up a progress indicator dialog. 
Upon completion of the upload, you provide the name for the uploaded 
configuration. This name will appear in the Apl library list.

6. Close the user-application library management dialog by clicking Close. Now, 
to assign the newly uploaded application configuration, check the Select New 
check box and select the configuration from the Apl library list.

7. Close the object type�s configuration dialog by clicking OK. You are prompted 
to confirm the replacement of the application configuration, click Yes to enforce 
the new configuration.

To proceed with the example, configure the other two REF54x device objects 
(�OUT1� and �OUT2�) using Table 3.12.3-1 as reference.

3.12.2.2. SPACOM relay object types
At this point, the SPACOM device object (�INCOMER2�) is still not configured. To 
configure it, enter the object�s configuration dialog as you did with the REF54x 
objects (Attributes button). The configuration dialog that appears (see Fig. 3.12.2.2.-
1) differs from the one you used for the REF54x objects (see Fig. 3.12.2.1.-1). For 
more information on configuring device objects, see the Tools for Relays and 
Terminals manual.
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Fig. 3.12.2.2.-1 The configuration dialog for SPACOM device objects

Now locate the module named �SPAD 346� from the Modules: list and click  
Add -> when you have selected the module. The dialog should look like the one 
shown in Fig. 3.12.2.2.-2.

Fig. 3.12.2.2.-2 The selected SPACOM configuration

To apply the configuration, click OK and you return to the General Object 
Attributes dialog.

Before you can make the communication setup for the individual objects, you have 
to set up the system configuration as described in Section 3.11. System 
configuration. Alternatively, you can click the System Configuration button in the 
General Object Attributes dialog (see Fig. 3.12.2.2.-3), which brings up the System 
Configuration dialog (see Fig. 3.11.-1). 
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Fig. 3.12.2.2.-3 Communication addresses for some modules using SPA protocol

After having configured the system, you can make the communication setup for the 
devices. The presentation may vary depending on the selected device.

3.12.2.3. REx 216/316 relay object types
The general object attributes, see Fig. 3.12.2.-2, have two parts: general data and 
communication data. Configuring the communication data is possible only after the 
general data has been set. This is done after creating the device object as follows:

1. Select the General page
2. Click the Attributes� button. A panel with an OK button appears, and for a 

short moment, an Initialising� window is shown. Another panel appears 
telling you that you may not use this function a second time.

3. Click the OK button on the panels. There are no parameters to be set, only the 
initialization has to be done and is now done.

4. Select the Communication page and set the communication parameters in the 
same way as for any other device.

If the device has been initialized once, no parameter change by means of the 
Attributes� button is possible nor is it necessary. Changing communication 
parameters on the Communication page can be done if necessary, as for all other 
devices. RExx16 devices support two protocols: Direct SPA communication via 
PC_NET (protocol SPA), or via the front connector and LON (protocol LON).

When you now operate a relay of the type REx 216/316, the appropriate setting tool 
CAP2/316 appears. All relay settings as well as the upload of disturbance data are 
handled with this tool (see separate Getting Started CAP2/316 manual for the 
appropriate relay type).
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3.12.2.4. REB 500 relay object type
The general object attributes only have the General data part, and there are no 
additional parameters to be set here. Communication parameters are set within the 
REBWIN setting tool, which already may be launched at this stage.

3.12.2.5. REx 5xx relay object types
The general object attributes have three parts: General data, Communication data 
and Terminal Version data. Configuring the communication data is possible only 
after the general data has been set. This is done after creating the device object as 
follows:

1. Select the General page. Notice that no attribute function is needed for setting 
REX 500 and RET 521 relays, therefore the Attributes� button is disabled.

2. Select Terminal Version page and select the Terminal Type of the REx 5xx 
relay, either RET or REX. Terminal Version also has to be assigned.

3. Select the Communication page and set the communication parameters in the 
same way as for any other device.

4. Click the OK button to save the configuration and exit.

Fig. 3.12.2.5.-1 General object attributes for REx 5xx types of relays

Changing communication parameters on the Communication page can be done as 
necessary as for any other device. REx 5xx devices support two protocols: Direct 
SPA communication via PC_NET (protocol SPA) and via the front connector as 
well as LON (protocol LON).

When you now operate a relay of type REx 5xx, the appropriate setting tool PST 
appears. All relay settings are handled with this tool, while disturbance uploading is 
done by HV/Collect. (See the Parameter Setting Tool (PST) User's Manual and the 
HV/Collect User�s Manual for functions).

The COM port selected for communication within the REBWIN 
setting tool must not be one of those used by the SMS 510 System 
Configuration. That is, if REBWIN uses COM1, the SMS 510 SPA 
communication must not use COM1, but COM2 instead (or the other 
way around).
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3.12.3. Summary
For example, the following devices with the following configuration have been 
added to the project:

At this stage, you have almost completed the example. Next, you can familiarize 
yourself with the use of user views in projects. Remember that regarding views, the 
example project only contains the Master Design View, which is the only view 
allowing you to insert device objects to the project and configure them.

3.13. Using user views

General
No specific rules for the use of user views exist in regard to their logical contents or 
amount.

Creating user views
In this example, you will create two rather self-explanatory user views, namely one 
named �Outgoing� and another named �Incoming�. You will also populate these 
views with the previously inserted device objects.

To proceed building the example project, select Create view on the Views menu of 
the Project Structure Navigator. This opens the Project View Properties dialog 
shown in Fig. 3.13.-1.

Table 3.12.3-1 Example device configuration

REF54x device SW Configuration Apl Configuration
INCOMER1 REF543-1MRS118501 rev. F 1MRS114502 rev. A
OUT1 REF541-1MRS118500 rev. C 1MRS114501 rev. A
OUT2 REF541-1MRS118500 rev. C 1MRS114501 rev. A

SPACOM device Relay Description
INCOMER2 SPAD 346

Rexx16 device
OUT3 Rexx16

REB500 device
OUT4 REB500

REx5xx device Terminal Type Terminal Version
440KVLINE REX REX500_20
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Project_view_prop.

Fig. 3.13.-1 Entering information for the new user view

Specify the information for the view as shown in the figure above. You can later 
change these properties of views, by selecting the View Properties menu item on 
the Views menu. Click OK to create the view. The navigator opens the view 
immediately. Notice that the Views menu now contains the newly added view below 
the Master Design View menu item.

Next, add the other user view similarly and specify �Outgoing� for the view�s 
properties. Now your Views menu should contain the menu items shown in 
Fig. 3.13.-2.

Fig. 3.13.-2 User view menu items in place

Adding objects to a user view
The final step of this example is to populate the user views with the device objects.

The procedure for adding objects to user views is simplified compared to Master 
Design View, since the objects already have been assigned names and other basic 
information.

If the �Outgoing� view is not currently active, activate it by selecting the �Outgoing� 
menu item on the Views menu. Now, select Insert Object on the Edit menu to bring 
up the �Add object from Master Design View� dialog, see Fig. 3.13.-3. The dialog 
lists all device objects that exist in the project, displaying both the titles and the 
names of the objects. Object names are displayed in parentheses.
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Fig. 3.13.-3 List of objects in Master Design View

Notice the Add Level button in the dialog. By clicking this button, you can add 
Level objects to the user view for organizing the view�s contents.

The intention is to add the objects �OUT1� and �OUT2� into this view. Select the 
object named �OUT1� from the list and click OK to add the object and close the 
dialog. The contents of the view should now be as shown in Fig. 3.13.-4.

qs19b

Fig. 3.13.-4 Object 'OUT1' in place

Similarly, add the object named 'OUT2' to this view.

Next, switch the view by selecting the �Incoming� menu item on the Views menu. 
Add the remaining device objects �INCOMER1� and �INCOMER2� to this view.

3.14. Launching object tools
Object tools are launched as follows (see Fig. 3.14.-1):

1. Select the target device object in the project. Object tools are available in all 
views of a project.

2. Double-click the object tool on the Object Tools list or
3. Select the tool from the Object Tools list and press <Enter> on the keyboard.

The Project Structure Navigator allows only one object tool to be used at a time. 
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Fig. 3.14.-1 Ready to launch the Relay Setting Tool for selected object

Documentation for each SMS 510 tool is supplied, references are listed in Section 
1.7. Related documents.

3.14.1. Launching tools for RED 500
When you select a relay of type RED 500, the Relay Setting Tool is the only tool 
available. It launches the RED Relay Setting Tool. All relay settings (upload, 
download and offline configuration) and detailed device diagnostics are available 
with this tool.

3.14.2. Launching tools for SPACOM
When you select a relay of type SPACOM, the Relay Setting Tool is the only tool 
available. It launches the SPACOM Relay Setting Tool. All relay settings (upload, 
download and offline configuration) and detailed device diagnostics are available 
with this tool.

3.14.3. Launching tools for REx 216/316
When you select a relay of type RExx16, the Relay Setting Tool is the only tool 
available. It launches the CAP2/316. All relay settings (upload, download and 
offline configuration) as well as upload of disturbance data and detailed device 
diagnostics are available with this tool (see separate Getting Started CAP2/316 
manual for the appropriate relay type/version).

If you forget to close the setting tool before you exit/shut down SMS 510, an 
exception error message may appear. Just press the message button to ignore it; SMS 
510 finishes its shut down, and the setting tool enters into offline mode and can be 
exited as usual.

3.14.4. Launching tools for REB 500
When you select a relay of type REB 500, the Relay Setting Tool is the only tool 
available. It launches the REBWIN program. All relay settings (upload, download 
and offline configuration) as well as upload of disturbance data and detailed device 
diagnostics are available with this tool (see separate REB 500/REB 500sys 
Operating Instructions manual for the appropriate relay type/version).
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3.14.5. Launching tools for REx 5xx
When you select a relay of type REx 5xx, the PST is the only tool available. It 
launches the Parameter Setting Tool. All relay settings (upload, download and 
offline configuration) and detailed device diagnostics are available with this tool.
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4. Project Structure Navigator

This chapter describes the elements and functionality of the Project Structure 
Navigator.

4.1. General
The Project Structure Navigator is your workspace for managing data and tools. It 
provides you with access to the SMS 510 tools and project-based object-oriented 
data management.

4.2. Projects
In SMS 510, projects are the containers for object-oriented data management and 
storage. Projects allow you to build representations of power stations and their 
protection and control devices. The maximum number of projects in SMS 510 is 
limited only by the available disk space on your computer.

The navigator allows you to build projects and operate these by means of a 
hierarchical tree structure. The structure is comprised of nodes where each node is 
an instance of an object type. Initially, all projects are empty, meaning that the 
project tree contains only one node (root level) that gives you a starting point to build 
the project upon.

The Project Structure Navigator works in one of two modes, the Master Design 
View mode, or the user view mode.

4.2.1. Master Design View
The Master Design View allows insertion of all available object types in SMS 510. 
It is the only view, in which you can:

� Insert objects to the project
� Configure the objects
� Configure the communication settings of the objects

The device objects are also available for use in the user views. The Master Design 
View is a built-in view, meaning that it is always available in every project and 
cannot be deleted.

4.2.2. User views
User views are intended for designing browsable operator views, e.g. for showing 
only objects with importance to the user. The object hierarchy in a user view may 
differ from the one in the Master Design View. Object types of the User Structure 
object types group provide you with the means of arranging the hierarchy of user 
views. The device objects, which are available in the Master Design View, can be 
inserted into the user views.
45



1MRS751267-MUM

User�s Guide

SMS 510
4.3. Object types
The Project Structure Navigator handles objects of three types, namely:

Level object types Level object types serve as structuring items in a project. 
A level object type does not set restrictions on what object 
types can be inserted underneath it. In many respects, 
levels behave like directories in a file system since 
directories may contain files and subdirectories. An 
example of level object type is the Level type.

Device object types Device object types control physical devices. A device 
object stores parameters about physical hardware, e.g. a 
REF 541 terminal.

Compound object types Compound object types combine the behaviour of level 
and device object types. In a project, a compound object 
has both object properties and structuring properties. As a 
result, a compound object has private object settings and 
a view level, under which it is possible to insert objects of 
object types allowed by the object type. The main 
difference between views of a level object type and a 
compound object type is that compound object types set 
restrictions on what object types can be represented in its 
views. Examples of compound object types are plant 
structures and communication gateways.

4.4. Object type groups
Each object type belongs to one named object type group, whose member types 
provide common functionality.

Four object-type groups are available:

User Structure Object types of this group serve the purpose of project 
structuring. Contains level object types only.

Plant Structure Object types of this group serve the purpose of 
MicroSCADA compatible project structuring. Contains 
compound object types only.

Gateway Object types of this group serve the purpose of project 
structuring and representation of communication gateway 
devices. Contains compound object types only.

Protection & Control Object types of this group represent protection and control 
devices. Contains device object types only.

4.5. User interface 
Access to the various tools and functions is provided by means of a toolbar, menus 
and keyboard shortcuts. Fig. 4.5.-1 illustrates the navigator�s user interface and its 
elements.
46



1MRS751267-MUM SMS 510

User�s Guide
psn3

Fig. 4.5.-1 The user interface of the Project Structure Navigator

User interface elements
Caption bar Displays the name of the current view. In Fig. 4.5.-1, it is 

the Master Design View. The caption bar also contains the 
standard operating system�s window management 
commands for minimising, maximising and closing the 
window.

Menu bar File, Edit, Views, System Tools and Help menu.
Toolbar The toolbar contains shortcuts for quick access to the 

frequently used functions.
Object tools list An object-selection sensitive list of object tools that are 

available for the object currently selected in the project 
structure.

Structure Displays the objects in the current project view for object 
selection and navigation.

Status bar Displays the path of the current project and the type of the 
object currently selected in the project structure. The 
right-hand box shows alerts from the System Self 
Supervision. By clicking the alert, the System Self 
Supervision Tree is brought into focus, see Chapter 10. 
System Self Supervision.
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The following icon symbols are used for different object type groups in the project  
view:

The menu contents and buttons in Fig. 4.5.-1 are described later in this chapter.

4.6. Entering the Project Structure Navigator
To enter Project Structure Navigator, proceed as follows:

1. In the SMS 510 program folder, select the shortcut Start SMS 510, see 
Fig. 3.7.-1. This starts the MicroSCADA service bringing up the SMS 510 
Login window. Fig. 4.6.-1 illustrates the login panel of the window.

2. In the SMS 510 Login window, click Login to enter the Project Structure 
Navigator. 

Login1

Fig. 4.6.-1 The login panel of the SMS 510 Login window

Notice that if you attempt to start a second instance of SMS 510, which is not 
allowed, you are notified that SMS 510 is already running, see Fig. 4.6.-2.

Table 4.5.-1 Symbols for different object type groups
 
User Structure or Plant Structure
 
Gateway

 
etc.

 
Protection & Control
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Fig. 4.6.-2 Notification that SMS 510 is already running

Dismiss the notification by clicking OK. 

4.7. File menu
The File menu, see Fig. 4.7.-1, contains the project handling functions and exit.

File_menu

Fig. 4.7.-1 The File menu

4.7.1. File Open

Keyboard entry: <Ctrl>+<O>

Toolbar entry:

By selecting the File Open alternative, the currently open project is closed and the 
Open Project dialog is opened, see Fig. 4.7.1.-1.

Fig. 4.7.1.-1 The Open Project dialog 
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To open a project into the navigator view, first select the project and then click 
Open. This also enforces the project�s communication configuration, which you can 
view and modify by means of the System Configuration Tool and the 
Communication page.

4.7.2. File Close
File Close closes the currently open project.

4.7.3. Organize Projects
When selecting Organize Projects, the Project Export/Import Tool is started. This 
tool is described in Chapter 5. Project Export/Import Tool.

4.7.4. File History List
The File menu includes a file history list of the previously opened projects. It helps 
to open some recently used local project quickly.

The five last opened projects (if any) are listed and sorted so that the last used project 
is the first name on the list. By clicking the project name or by entering the order 
number from the keyboard, the currently open project is closed and the requested 
project is opened.

4.7.5. Exit

Keyboard entry: <Alt><F4>
By selecting Exit, the tool session is terminated and you enter the SMS 510 Login 
window.

4.8. Edit menu
The Edit menu contains functions for adding and deleting objects and for invoking 
the General Object Attributes dialog for the currently selected object.

Accessibility to the menu items depends on the currently selected object. For 
instance, the Delete Object item in Fig. 4.8.-1 is disabled, indicating that the 
currently selected object cannot be deleted.

Fig. 4.8.-1 The Edit menu

 
To close SMS 510, click Exit on the SMS 510 Login window; this 
will stop the MicroSCADA service.
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4.8.1. Insert Object

Keyboard entry: <Insert>

Toolbar entry:

Through this menu alternative, you initiate the insertion of objects in the project.

Insert Object in the Master Design View
When you select the Insert Object function in the Master Design View, the Add 
Project Object dialog (shown in Fig. 4.8.1.-1) appears, allowing you to specify the 
type of the object to be added to the currently selected location.

Fig. 4.8.1.-1 Insertion of an object

The Project Structure Navigator displays all object type groups currently available 
in the SMS 510 environment. However, the object types of these groups are filtered 
according to the currently selected object, which will host the new object.

To insert the object, first choose the appropriate object type group. Select the type 
for the new object and click OK to enter the dialog, where you give the basic 
properties for the new object, see Fig. 4.8.1.-2. Notice that this dialog varies 
according to the type of the new object.

Fig. 4.8.1.-2 Providing properties for the new object

Type in the title and the name for the object and click OK to complete its insertion.
51



1MRS751267-MUM

User�s Guide

SMS 510
�Object Name� is used for SMS 510 object managing and should be unique within 
the project. �Object Title� is the object description that is presented to the user in the 
Project tree for the particular object. Object Name and Object Description can later 
be changed from Properties/General Object Attributes dialog, see Fig. 4.8.3.1.-1.  

Fig. 4.8.1.-3 The limitation of project object instances is exceeded

Insert Object in the user views
When you select the Insert Object function in a user view, the Add object from 
Master Design View dialog appears, allowing you to select the object to be added to 
the currently selected location.

Fig. 4.8.1.-4 Inserting a device object to a user view

To insert a device object, select it from the object list and click OK to close the 
dialog.

If you do not fill in the Object Name field, the Project Structure 
Navigator still generates a name.

The maximum number of STA objects in a SMS 510 project is 
limited to a total of two hundred (200). One object instance can 
reserve more than one STA object, so the actual maximum object 
count in a project may be smaller than 200. If you try to add more 
than 200 objects, the following notification dialog will be shown:

All device objects that you have inserted in the Master Design View 
are available for selection. However, you can insert a device object 
only once to a given user view.
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This dialog also allows you to insert Level objects, which you can use for organizing 
the contents of the user view. This is accomplished through the Add Level button, 
see Fig. 4.8.1.-4.

To insert a Level object, either select the root node of the view or another Level 
object and click Add Level to enter the dialog for providing the title of the object, 
see Fig. 4.8.1.-5.

Fig. 4.8.1.-5 Inserting a Level object to a user view

Give a unique title in the view's scope and click OK to close the dialog.

4.8.2. Delete Object

Keyboard entry: <Delete>

Toolbar entry:

To delete the currently selected object, use the function Delete Object. You can 
delete only such objects, which do not contain any subordinate objects.

If you are working in a user view, the deleted object remains in the project database 
and it can thus be re-added to any user view in the project. However, deleting an 
object from the Master Design View permanently removes the object from the 
project database, which in essence means erasing the object�s file storage from the 
hard disk.

4.8.3. Object Properties

Keyboard entry: <Alt>+<Return>

Toolbar entry:

To bring up the General Object Attributes dialog for the currently selected object, 
select Object Properties.

Notice that if you select the root node, this function brings up the dialog for changing 
and viewing properties of the project (in the Master Design View) or properties of a 
user view (in a user view).
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4.8.3.1. General Object Attributes dialog
The General Object Attributes dialog, see Fig. 4.8.3.1.-1, is a central tool for project 
object management. The dialog contains two tabbed pages; General and 
Communication for setting and viewing of objects� attributes. The General page is 
available for all objects in all views, whereas the Communication page is displayed 
only in the Master Design View for objects that require communication settings. 
With the dialog's buttons, you invoke the object's configuration dialog (if supported 
by the object type) and the dialog for moving the object in the project hierarchy.

Fig. 4.8.3.1.-1 The General Object Attributes dialog

The following table describes the elements found in Fig. 4.8.3.1.-1.

The Communication page is not documented here. For detailed 
information on configuring the communication settings, refer to the 
manual describing the respective object type (e.g. the Tools for 
Relays and Terminals manual).

Table 4.8.3.1-1 General Object Attributes dialog items

Field Explanation
Object Title A read/write attribute in the Master Design View, read-only in user 

views. 
Object Name A read/write attribute in the Master Design View, read-only in user 

views. 
Object Type The type of the object, read-only in all views.
Version The version of the object�s type, read-only in all views.
Group The group of the object�s type, read-only in all views.
Remarks Remarks on the object. A read/write attribute in the Master Design 

View, read-only in user views. 
Note! Data is automatically truncated to 253 characters without notice.

Button
OK Closes the dialog saving the changes to the object's general 

attributes. 
Cancel Closes the dialog discarding the changes to the object's general 

attributes. 
Note! This button does not have any impact on changes to the 
object's configuration.
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4.8.3.2. Moving objects
Objects can be moved only within the current view. The procedure involves using 
the Move Object dialog, see Fig. 4.8.3.2.-1. The dialog is invoked using the General 
Object Attributes dialog (button Move). You can access this function only if the 
currently selected object�s type supports moving objects.

Fig. 4.8.3.2.-1 The Move Object dialog

To move an object: 

1. Select the object you intend to move.
2. From the Edit menu, select Object Properties to open the General Object 

Attributes dialog.
3. Click Move to open the Move Object dialog.
4. In the project structure, select the node, which will host the moved object. 

Notice that you can work with the project tree in a normal manner, i.e. expand 
and collapse nodes.

5. On the Move Object dialog, click Move Here to move the object. The Move 
Object dialog closes causing the project structure to collapse. Notice that in case 
the Project Structure Navigator detects that the currently selected target node 
cannot host the object you are about to move, you are not allowed to perform the 
move operation. This means that clicking Move Here has no effect.

To cancel moving the object, click Cancel in the Move Object dialog.

4.9. Views menu
The Views menu contains view manipulation functions and the list of user views, if 
such have been created in the current project. For example, in Fig. 4.9.-1 below, the 
project contains one user view, titled �'User view 1�, while �Master Design View� 
shows the entire project. �ROOT� and �SSS-System Self Supervision� are used for 
changing views in the navigator. �ROOT� or the name assigned to the root of the 
project, see Fig. 4.9.1.-1 and Fig. 4.9.3.-1, is showing the active view (in this case 

Attributes Invokes the dialog for configuring the object. Enabled in Master 
Design View only, on the condition that the object's type supports 
object configuration, otherwise this button is disabled. 

Move If the object's type supports moving objects, this button invokes the 
dialog for moving the object within the current view, otherwise this 
button is disabled. For details on moving objects, see Section 4.8.3.2. 
Moving objects. 

Table 4.8.3.1-1 General Object Attributes dialog items
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either �Master Design View� or �User View 1�) with devices and access to tools from 
the System Tools menu, while �SSS - System Self Supervision� shows the status of 
the entire SMS 510 system.

Fig. 4.9.-1 The Views menu

4.9.1. Create View
With this menu option it is possible to create new user views.

CreateView2

Fig. 4.9.1.-1 Creating a new view

New user views are created by defining the view name, i.e. the instance name, and 
the view description, i.e. a logical name for the view. The root name is the name of 
the root node in the new view and can be given a more descriptive name.

Different view colors can be used to differentiate separate projects and/or separate 
views of one project. By clicking the button next to the "Own color" sample color 
box, a Color Chooser dialog is opened for selecting a color. The "Default color" 
option reverts to the default light blue color.
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ViewColors

Fig. 4.9.1.-2 Defining own view color

4.9.2. Delete View
This option deletes the current view, but only user views can be deleted, i.e. you 
cannot delete the Master Design View.

4.9.3. View Properties
By selecting this option, the current view�s properties can be changed.

Proj_properties

Fig. 4.9.3.-1 The Project Properties dialog

The project name is the instance name and the project description is a logical name 
for the project. The root name is the name of the root node, i.e. the very first element 
in the project view presented by the project navigator. The root name can be given 
a name suitable for the presentation in the project navigator.
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The background color for the view can be changed by clicking the button next to the 
"Own color" sample color box, or the default light blue color selected with the 
"Default color" option.

4.9.4. View List
The view list is a list of all views defined for the project. By selecting one of the 
views, the navigator changes the active view. Only the �Master Design View� is 
always available, user views are optional. 

The difference between �ROOT� (or the name given to it, see Fig. 4.9.1.-1 or 
Fig. 4.9.3.-1) and �SSS - System Self Supervision� is that Root shows the selected 
view e.g. �Master Design View� or �User View 1�, while �SSS - System Self 
Supervision� shows the entire project from the System Self Supervision point of 
view. SSS is also generated automatically from the project.

4.10. System Tools menu
The System Tools menu, Fig. 4.10.-1, contains the tools that are available for use at 
the SMS 510 system level.

SyTo_Customize

Fig. 4.10.-1 The System Tools menu

You can modify the contents of the menu by selecting the Customize� option, see  
Section 4.10.1. Customize.... By default, menu items for invoking the User 
Management, Time_Date, System Configuration, Plant Structure Settings, DR-
Collector Tool, SMS Conversion Tool and Supervision Log functions are available.

For detailed information on the System Configuration tool/Communication, refer to 
the SMS 510 Installation and Commissioning manual.

For detailed information on the DR-Collector Tool, refer to the Tools for Relays and 
Terminals manual.

See also the following chapters and sections in this manual:

Chapter 14. User Management.

Chapter 15. Task scheduling.

Section 13.1. Time/Date Settings.

Chapter 6. Plant Structure Settings.

Chapter 17. SMS Conversion Tool.

Chapter 11. Supervision Log Viewer.
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4.10.1. Customize...
The Customize� menu alternative, see Fig. 4.10.1.-1, makes it possible to add and 
remove tools to and from the System Tools menu.

StoolCust1

Fig. 4.10.1.-1 The customization dialog

By selecting a system tool from the right hand list and clicking <<, the tool is added 
to the System Tools menu. By selecting a tool from the left-hand list and clicking 
Remove, the tool is removed from the System Tools menu.

4.11. Help menu
The Help menu, see Fig. 4.11.-1, contains the function for invoking the About dialog 
of the Project Structure Navigator and SMS 510.

Help

Fig. 4.11.-1 The Help menu

4.11.1. About Project Structure Navigator
This About dialog contains information about the current version of the Project 
Structure Navigator and the Project Manager.

4.11.2. About SMS 510

Keyboard entry: <F1>
The About dialog contains information about the current version of SMS 510.

The information presented in the About SMS 510 dialog should be 
available when contacting your local support. It can be copied to the 
Windows clipboard in a textual format by clicking the Copy button 
on the About dialog.
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5. Project Export/Import Tool

5.1. General
The Project Export/Import Tool is used for copying, exporting, importing, deleting, 
duplicating, creating of new projects and selecting of the project that is to be 
regarded as local.

In network environments, this tool can be used to transfer projects to/from e.g. SMS 
510, CAP 501, CAP 505, SYS 500 and COM 500.

5.2. Starting the Project Export/Import Tool
The Project Export/Import Tool is started from the File menu by selecting Organize 
Projects..., see Fig. 5.2.-1.

Fig. 5.2.-1 File menu with Organize Projects...

The user interface of the Project Import/Export Tool is shown in Fig. 5.2.-2.

Fig. 5.2.-2 The user interface of the Project Export/Import Tool

Table 5.2.-1 presents the project-management functionality provided by the Project 
Export/Import Tool.
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5.3. Features

5.3.1. Updating the project list
The operating principle of the Project Export/Import Tool is to first select a project 
collection to the list view. The project list is updated by selecting the Source button. 
The project list can be one of the following:

� The user�s SMS 510 application projects. By default, the project list displays this 
selection.

� MicroSCADA application projects on a logical drive, which may also be a 
network drive.

� Projects stored in an arbitrary user-specified directory.

The project list displays project names in the format APL/ProjectName. When APL 
is SMS 510 or CAP 505, it means that the project is in the SMS 510 or in the CAP 
505 project collection respectively. Any other APL indicates the MicroSCADA 
application and project name.

The Source button invokes the following dialog for choosing one of the alternatives 
above:

Fig. 5.3.1.-1 The Project Source Directory dialog

Table 5.2.-1 Description of the Project Export/Import dialog buttons:
Close For closing the dialog.
About PEIT... Provides additional information about the tool and 

System Information.
Copy to... For copying projects.
Export... For exporting projects from the SMS 510 project 

collection to an arbitrary user-defined location.
Import... For importing projects from an arbitrary user-

defined location to the SMS 510 project 
collection.

Properties... Provides information about the project folder.
Delete... For deleting projects from the SMS 510 project 

collection.
Duplicate... For duplicating projects in the SMS 510 project 

collection.
Create... For creating projects in the SMS 510 project 

collection.
Source For defining the Project Source Directory. It can 

be the computer you are using or the 
MicroSCADA environment. You can also define 
the path manually.
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The MicroSCADA Apl On Drive and Path entries allow you to access both local 
and network computers.

To use the MicroSCADA Apl On Drive option, specify the drive letter followed by 
a colon (:), for example �R:�. The Path entry allows using the Universal Naming 
Convention (UNC) format in addition to the standard format: <drive:>\<directory 
path>. Sample UNC entries are provided below: 

Using a share name
\\WORKSTA\Backup\SMS510\Projects

where;

WORKSTA is the name of the target computer.
BACKUP is a share name on the target computer.
SMS510\PROJECTS is a directory path under the share name.

Using an administrative share name
\\WORKSTA\C$\Backup\SMS510\Projects

where;

WORKSTA is the name of the target computer.
C$ is an administrative share name on the target computer, 

the root directory of the drive 'C'.
Backup\SMS510\Projects

is a directory path under the share name.

5.3.2. Project Storage
In SMS 510, projects are stored in the PRJ directory, for example:

<DRIVE:>\SMS510\PRJ

The MicroSCADA application projects are stored under the directory:

<DRIVE:>\SC\APL\APLNAME\PROTECTION\PRJ

where;

APLNAME is the name of the MicroSCADA application.

5.3.3. Copying projects between network computers
In network environments, projects can be copied from the local computer to/from 
other computers in the network, see Fig. 5.3.3.-1. Other computers are referred to by 
using their computer name, which is a feature of the operating system. You should 
be granted full access to the share name if the intention is to copy projects to the 
network computer�s project database collection.

The destination can be one of the following alternatives:

� The SMS 510 project collection on the local computer
� A MicroSCADA library application on a drive letter
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� A network directory
� A MicroSCADA library application on a network computer

Also notice that a project�s system configuration is transferred along with the 
project. Depending on the communication settings of the project�s objects and the 
communication capabilities of the target computer, the system configuration and/or 
objects� communication settings may have to be modified to enable correct 
communication for all objects in the project.

When a project is copied to a MicroSCADA application, it is copied to the 
application�s PROTECTION\PRJ directory, e.g. when the application is named 
PKS, the destination would be \SC\APL\PKS\PROTECTION\PRJ. Since a 
MicroSCADA library application can process one project only, it is named PRJ.

If a project already exists in the destination directory, you are prompted to replace 
the project or abort the operation. In addition, if you enter a destination directory, 
which is the same as the source directory, you will be notified that the copying 
cannot continue.

The Copy To button brings up the dialog shown in Fig. 5.3.3.-1, for choosing a 
destination for the selected project in the project list view.

Fig. 5.3.3.-1 The Copy Project dialog

The object types are not copied along with the project. Before the 
project is copied, it is up to you to verify that the object types and 
tools in the project are compatible or equal on the remote system. If 
the project contains objects of later versions or foreign object types, 
the remote system may encounter problems if the project is using 
object types of other versions than what is expected by the object 
types and tools.

In Hot Stand-By base systems (HSB) it is important that 
MicroSCADA is shut down while the project is being copied.
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In order for the option MicroSCADA APL on Drive to operate, the drive letter must 
refer to the root directory of the drive on which MicroSCADA has been installed. 
The network computer name is entered in UNC format, for example 
\\L40017\MYPRJ. In this example, the computer name is L40017 and MYPRJ is the 
share name.

The option MicroSCADA APL on Network \\Computer\Share refers to the APL 
directory on the MicroSCADA computer, for example 
\\L40017\D_root\SC\APL. Press <Enter> when your option is MicroSCADA 
APL on Drive or MicroSCADA APL on Network \\Computer\Share to update the 
list of MicroSCADA APL applications.

5.3.4. Choosing storage location for temporary projects
A temporary project is a compressed project that has been exported from SMS 510 
or another product. It is recommended to save such projects in a special-purpose 
directory outside the directory structure of SMS 510, for example C:\EXPORTS.

5.3.5. Exporting projects
Exporting a project means that all associated object entries in a project are 
duplicated to some other location specified by you, see Fig. 5.3.5.-1. The destination 
location can be on the local system or on a network drive: the destination location is 
specified as a directory path, for example C:\EXPORTS. Notice that the destination 
directory must exist when you issue the export command.

The output result in the specified directory is a compressed archive file with the file 
extension �.AR�. For example, if the project file name (which is also the actual 
directory name for the project) is KRISTIINANKAUPUNKI, the compressed 
archive file name is truncated to KRISTIIN.AR.

The object types used in the project are not exported along with the project, which 
means that the functionality in a sense is the same as with copying the projects, as 
described in Chapter 5. Copying projects between network computers.

Fig. 5.3.5.-1 The Export Project dialog

Especially avoid using the directory \SMS510\TEMP for such 
purposes, since the SMS 510 kernel may choose to erase its contents 
at any time.

When the project is later imported, the full project name must be 
used, although its compressed project file name is only eight (8) 
characters in length.
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5.3.6. Importing projects
Importing a project is done similarly as exporting, except for the directory entry: the 
source directory is the location from where the project is copied to your project 
collection, see Fig. 5.3.6.-1. The source directory can be a directory on your local 
computer system or on a network drive. The directory entry must be the full 
directory path to the project, for example 
C:\EXPORTS\KRISTIINANKAUPUNKI means that a compressed project 
archive file KRISTIIN.AR is in the directory C:\EXPORTS.

Notice that the project must be specified using its complete project file name 
although its compressed archive file name is only eight (8) characters in length.

If the compressed archive was distributed to you on several disks, you must first 
copy the contents from all disks to a common directory on a hard disk drive and 
import the project from there, see the note in the figure below: 

Fig. 5.3.6.-1 The Import Project dialog

The source directory is the path to the project in the export directory. For example, 
if a project �DEMO� was exported to X:\EXPORTS then the source directory would 
be X:\EXPORTS\DEMO (if the drive letter X: is mounted to the same location on 
both systems).

The system configuration of the project (i.e. the communication 
settings in the System Configuration and the object level addresses) 
is preserved when the project is imported. If the communication 
settings are obsolete or the current communication environment 
differs too much from the source environment, the communication 
settings of the project can later be reset from the System 
Configuration dialog (see Section 3.11. System configuration in this 
manual). The applicable settings are automatically converted, if the 
source project is detected to have been exported from another 
compatible tool product.
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Fig. 5.3.6.-2 The communication settings reset dialog

5.3.7. Project properties
The General Project Properties dialog shows the file name of the selected project, 
see Fig. 5.3.7.-1:

Fig. 5.3.7.-1 The General Project Properties dialog

5.3.8. Deleting a project
Deleting a project is an irreversible operation that cannot be undone,  
see Fig. 5.3.8.-1.

Fig. 5.3.8.-1 Deleting a project
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5.3.9. Duplicating a project
Duplicating a project means that an exact copy of the selected project is copied to 
your project collection, see Fig. 5.3.9.-1. During the process of duplication, you can 
specify a different project name and description. The project file name is actually a 
folder name (directory name) which will become the project�s home directory. The 
project file name may not already exist.

Fig. 5.3.9.-1 The Duplicate Project dialog

5.3.10. Creating a new project
Creating a new project is done in a dialog similar to duplicating a project. The newly 
created project is assigned an empty system configuration, that is, no LON or serial 
port communication channels exist in the project's system configuration. Regarding 
project creation, the same restrictions that apply to the project duplication also apply 
here, see Section 5.3.9. Duplicating a project.

5.3.11. Set As Local
The function Set As Local sets a project as �Local�. Local means that the project is 
�owned� by the current SMS 510 installation and that it is used for direct connection 
to the relay units, also via telephone modem or other direct communication. This 
project is also available during logoff mode.

In the list of projects, select the project that you want to use as local and press Set 
As Local, see Fig. 5.2.-2. The project set as �Local� is shown on the row Local 
Connection Project. The name of the local connection project is visible also on the 
SMS 510 Login dialog, see Fig. 5.3.11.-1.

The �Project Filename� must be a single-word name without spaces 
or characters other than:  
- A - Z 
- 0 - 9
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local_project

Fig. 5.3.11.-1 Local connection project name on Login dialog

Notice that you can still open and use any of your other projects in the Project 
Structure Navigator even if one is set as local.

Set As Local is used in the following cases:

� Connecting one SMS 510 to another SMS 510 over LAN or Remote/RAS (the 
project to connect to should be set as local)

� Using the Scheduler and e.g. DR-Collector Tool and/or HV/Collect 

When choosing the project to be used when uploading disturbance recordings, you 
can only select among the project set as local (same SMS 510 installation) and 
projects defined as Remote connection projects (another SMS 510 installation) in 
the Scheduler. The remote projects are located in the SMS 510 to be connected to.

For more details on using and setting up Remote connections and the Scheduler, see 
Chapter 12. Remote connections and Chapter 15. Task scheduling.

5.3.12. Errors accessing remote disk resources
If you attempt to access a disk resource on a remote computer, which does not 
contain matching MicroSCADA user account, you will receive errors illustrated in 
Fig. 5.3.12.-1 and Fig. 5.3.12.-2.

Fig. 5.3.12.-1 Notification about a failed export operation
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Fig. 5.3.12.-2 Notification about a failed import operation

To recover from such a situation, ensure that the target computer�s MicroSCADA 
user account is assigned the same password as your local computer.

 
The notification in Fig. 5.3.12.-2 also appears if the specified project 
does not exist.
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6. Plant Structure Settings

This chapter describes the functionality of the Plant Structure Settings tool.

6.1. General
To be able to define the attributes for the plant structure object types that are 
applicable to the whole project, this system level tool is available. The tool provides 
the possibility to modify the predefined attributes and define the properties of the 
undefined levels in the object type. For more information on the Plant Structure 
Object Types, see Chapter 7. Plant Structure object types.

The lowest tree levels are disabled because there are no use for them in the SMS 510 
environment.

6.2. Starting the Plant Structure Settings Tool
Start the tool by selecting the Plant Structure Settings on the System Tools menu 
in the Project Structure Navigator, see Fig. 6.2.-1.

SyTo_PSS

Fig. 6.2.-1 Starting the Plant Structure Settings tool

6.3. Attributes of Plant Structures
The attributes of the plant structure, see Fig. 6.3.-1, are applicable to the whole 
project, i.e. there cannot be several definitions of the plant structure�s attributes. The 
attributes that can be modified through this tool are:

� Level Id (see Section 6.3.1. Level Id)
� Level Description (see Section 6.3.2. Level Description)
� Field Length (see Section 6.3.3. Field Length)

These attributes are described in more detail in the following chapters.
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Fig. 6.3.-1 Plant Structure Settings

The default values have been chosen on the basis of the corresponding functionality 
in the MicroSCADA Network Control system. 

6.3.1. Level Id
The Level Id attribute defines what the identifier is for recognising a certain level in 
a plant structure. 

The defaults are:

� �STA� that is used for recognising station level objects
� �BAY� that is used for recognising bay level objects
� �DEV� that is used for recognising device level objects

6.3.2. Level Description
The Level Description attribute is used for describing the different levels in the Add 
Object dialog when an object is inserted. 

The defaults are:

� �Station�
� �Bay�
� �Device�

6.3.3. Field Length
The Field Length attribute defines the maximum possible length of the instances� 
names when adding an object of the plant structure type to the project. 

The defaults are:

� �10�
� �15�
� �5�

It is not recommended to change the default values, as such a change 
probably would cause compatibility problems when e.g. exporting 
projects to MicroSCADA. 
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7. Plant Structure object types

This chapter describes the object types included in the plant structure object group.

7.1. Overview
The plant structure object types are intended to be used when building 
MicroSCADA compatible project structures. It is possible to define five structure 
levels, although three of them are predefined. For more information on structure 
level definition, see Chapter 6. Plant Structure Settings.

7.2. General
The plant structure object types are level sensitive. This means that it is only possible 
to insert predefined objects under each level of the structure. For example, it is not 
possible to insert a bay object under the root level, while the same operation is 
allowed under the station level.

7.3. Field Length
The length of the instance name in the plant structure object type is restricted to the 
value defined for the level in the Plant Structure Settings, see Chapter 6. Plant 
Structure Settings for more information.

Fig. 7.3.-1 Notification about the instance name length

If the instance name is longer than defined in the Plant Structure Settings, the 
notification shown in Fig. 7.3.-1 appears. When this happens, the correct thing to do 
is to shorten the instance name to the maximum number of characters indicated by 
the notification.

7.4. Station
The station level is intended to be used in conjunction with a subsequent bay level. 
Highlight the project�s root node and select Insert Object from the Edit menu to 
open the Add Project Object dialog, see Fig. 7.4.-1.
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Fig. 7.4.-1 Adding a station level object

Insert the station object by selecting the Plant Structure object group and then the 
Station object type and click OK to open the station level object dialog, see 
Fig. 7.4.-2. (Notice that in the Project Structure Navigator�s status bar, the displayed 
object type is �OI� for objects of Station type).

Fig. 7.4.-2 Adding a Station level object

Type in an appropriate name and title for the object and click OK to have the station 
level object inserted.

The name of the object identifies the unique instance in the structure. The instance 
name length is restricted to the number of characters defined in the Plant Structure 
Settings. The maximum length of the name is also displayed on the dialog.

The title of the object is a symbolic description and it is visible in the Project 
Structure Navigator.

7.5. Bay
Highlight a station level object of a plant structure and select Insert Object from the 
Edit menu to open the Add Project Object dialog, see Fig. 7.5.-1.
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Fig. 7.5.-1 Adding a Bay level selection

Insert the bay object by selecting the Plant Structure object group and then the Bay 
object type and click OK to open the bay level object dialog, see Fig. 7.5.-2. (Notice 
that in the Project Structure Navigator�s status bar, the displayed object type is �OI� 
for objects of Bay type).

Fig. 7.5.-2 Adding a Bay level object

Type in an appropriate name and title for the object and click OK to have the bay 
level object inserted.

The name of the object identifies the unique instance in the structure. The instance 
name length is restricted to the number of characters defined in the Plant Structure 
Settings. The maximum length of the name is also displayed in the dialog.

The title of the object is a symbolic description and it is visible in the Project 
Structure Navigator.
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8. User Structure object types

This chapter describes the object types included in the User Structure object group.

8.1. Overview
User Structure object types are intended to serve as structuring objects for structures 
that have other structuring requirements than MicroSCADA compatibility. The 
level structure can be built as deep as is required for the purpose intended.

8.2. General
The user structure object types can be used in both the Master Design View and in 
the user views. 

The main difference between User Structure object types and Plant Structure object 
types is that the User Structure does not have the guided insertion order which means 
that the levels and their purposes are defined by the user.

8.2.1. Inserting Level objects
Highlight a level object and select Insert Object from the Edit menu to open the 
Add Project Object dialog, see Fig. 8.2.1.-1. Notice that in every view, the root node 
is also a Level object.

Fig. 8.2.1.-1 Adding a User Structure object

To insert the level object, select the User Structure object group and then the Level-
Level object type. Click OK to open the Add Level dialog shown in Fig. 8.2.1.-2.

Fig. 8.2.1.-2 Adding a Level object

Enter a title for the object and click OK to insert it into the tree structure. The title 
is visible in the Project Structure Navigator and it must be unique in the scope of its 
view, that is, you cannot have two Level objects having the same title in a single 
view.
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9. Gateway object types (COM 610)

SMS 510 supports the following gateways:

� LON/SPA Gateway SPA-ZC 100/102 (LSG)
� LON Star Coupler RER 111
� COM 610 communication gateway

The two LON gateway object types are described in a separate LON Gateways 
Configuration manual (see Section 1.7. Related documents). This chapter describes 
only the COM 610 object type.

9.1. General
In SMS 510, the COM 610 communication gateway can be used as a SPA router for 
the following relays and terminals:

� RED 500 series
� SPACOM family

Being a communication gateway, the task of a COM 610 is to make protocol 
conversions between process communication and remote communication. The 
protocol used in process communication is called the master protocol (protocol 
between COM 610 and relay/terminal), and the protocol used in remote 
communication is called the slave protocol (protocol between SMS 510 and COM 
610). In general, the master protocol can be selected independently on the selected 
slave protocol.

For the protocol conversions to be possible, cross-references between different 
protocols must be done with the engineering tools provided by COM 610. This 
engineering includes also the mapping of the protocol addresses.

9.2. Supported protocols
The following master/slave protocols supported by COM 610 can be used in SMS 
510.

Slave protocol:

� COM 610 object can be connected to SMS 510 only via SPA router protocol.

Master protocols:

� COM 610 object allows SPA or LON protocols to be defined as the master 
protocol for the RED 500 series.

� COM 610 object allows only SPA protocol to be defined as the master protocol 
for the SPACOM family.

Installation, configuration and usage of a COM 610 communication 
gateway itself is not described here. The documentation and tools 
accompanying the gateway must be utilized.
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9.3. Insertion

COM 610 objects can be inserted only in the Master Design View mode of the 
Project Structure Navigator, and cannot be used in a project's user views. However, 
the device objects hosted by a COM 610 object are normally visible also in the user 
views.

You can insert COM 610 objects into the following locations of a project:

� Under the root node of the project
� Under a Station object
� Under a Bay object
� Under a Level object

In contrast to other objects, COM 610 objects are non-movable. This means that 
once inserted, a COM 610 object cannot be moved elsewhere in the tree structure.

The modifiable attributes of COM 610 objects are the same as for the other object 
types (see Fig. 9.3.-1).

Gen_obj_attr.

Fig. 9.3.-1 General object attributes for COM 610 objects

SPA relays connected to a SPA-ZC 400/402 Ethernet adapter and 
using an IEC 61850 OPC server in COM 610 are also supported. In 
that case, the SPA must be selected as the protocol for the device 
object in SMS 510.

Adding and using a COM 610 object in a project is mandatory only 
in the situation, where the relay is connected to a COM 610 gateway 
with LON protocol. If the devices are using SPA protocol, then the 
device objects can be added to the project with or without a COM 
610 object.
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9.4. Communication setting
Due to the nature of a communication gateway usage, the communication settings 
for both the master and the slave protocol must be defined separately. These settings 
together define the complete communication settings of a single relay/terminal.

In addition, since the cross-reference tables between the master and slave protocols 
must have been done for COM 610, also the protocol addresses are mapped. In other 
words, the SPA address of a relay/terminal to be used in SMS 510 is not necessarily 
the same as defined in the physical relay/terminal.

9.4.1. Communication settings of COM 610 object
In order to be able to configure the communication settings of the COM 610 object, 
the project's system configuration must contain one or more serial ports.

The communication settings of COM 610 objects are configured on the 
Communication page of the General Object Attributes dialog in the Project Structure 
Navigator (see Fig. 9.4.1.-1).

Comm_settings_1

Fig. 9.4.1.-1 Communication settings for COM 610 objects

The only required definition is the serial port to be used. For the protocol there are 
no other choices, and the SPA address is not applicable for the gateway itself.

9.4.2. Communication settings of device object
In order to be able to configure the communication settings of the device object, the 
parent COM 610 object's communication settings must have been defined first.

The communication settings of device objects are configured on the Communication 
page of the General Object Attributes dialog in the Project Structure Navigator (see 
Fig. 9.4.2.-1).

SPA addresses behind one COM 610 object must be unique in  
SMS 510.
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Comm_settings_2

Fig. 9.4.2.-1 Communication settings for RED 500 series terminal with COM 
610 as master.

Irrespective of the protocol to be selected (SPA or LON), the only required address 
definition is the SPA address.

9.5. Using COM 610 object
Here is an example of a configured COM 610 object: 

Using_COM610_obj

Fig. 9.5.-1 COM 610 object hosting a REC52X object

Address mappings between SMS 510 and COM 610 are based on 
SPA addresses with all the master protocols.
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10. System Self Supervision

This chapter describes the System Self Supervision function in SMS 510. The 
examples are taken from a project named �Model Switchyard� using two serial ports 
and having 5 remote devices connected on each.

10.1. General
The intention with System Self Supervision (SSS) is to provide the user with on-line 
information about the status of the SMS 510 system and devices connected to it. The 
SSS project view shows the active project in form of a tree using both status icons 
and texts for the monitored objects, see example in Fig. 10.3.1.-1. Thereby the SMS 
510 operator is provided with information about alerts from the supervised objects. 
The operator can also switch to the SSS project view to check the state of objects of 
interest.

SSS is operating in the background for currently open projects in the Project 
Structure Navigator. One project is supervised at a time. Alerts from SSS are shown 
in red text in an �alert box� down in the right-hand corner in the Project Structure 
Navigator, see example in Fig. 10.6.-1.

10.2. System Self Supervision activation
By default, the System Self Supervision is not activated in SMS 510. Therefore you 
have to activate the SSS functionality before you can get the System Self 
Supervision running, see Section 10.4. Enabling System Self Supervision. When 
you build projects and work off-line in SMS 510, it is convenient to have SSS 
inactive, see Section 10.5. Disabling System Self Supervision.

10.3. Objects supervised by System Self Supervision
The following types of objects are supervised by SSS:

� Application state (see Section 10.7.3. Application State supervision)
� Application state
� Application memory pool supervision

� Line Communication (see Section 10.7.4. Line Communication supervision)
� (Serial) ports
� LON Channels
� Devices

� Operating System (see Section 10.7.5. Operating System Events supervision)
� Application events from the operating system
� System events from the operating system
� Security events from the operating system

Since the System Self Supervision view is just another view in the 
project, its background color can be changed by selecting View 
Properties from the View menu. This view can be made easily 
recognizable by some other color, if wanted. 
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10.3.1. System Self Supervision object presentation
System Self Supervision presents the objects of the project as a tree, as in 
Fig. 10.3.1.-1. It shows the entire project with all objects, even if the user might have 
defined his own views with fewer objects, see Section 3.13. Using user views.

The Supervision Log Viewer also presents information provided by the System Self 
Supervision, but in list format, see Chapter 11. Supervision Log Viewer. 

SSS_active_project

Fig. 10.3.1.-1 System Self Supervision for the active project

10.3.2. System Self Supervision object maintenance
The System Self Supervision project is created automatically from the active project 
in the Project Structure Navigator (PSN) upon starting SMS 510 or by opening 
another project. When the project is modified in the PSN, the SSS project is rebuilt 
automatically. This means that the operator does not need to create or modify any 
SSS project or views, since it is done automatically by the PSN.

10.4. Enabling System Self Supervision
Enabling SSS is easy. Select System Configuration from the System Tools menu 
(see Fig. 15.5.-1) and select the General Settings page (see Fig. 10.4.-1). Check the  
System Self Supervision enabled check box, and save and exit by clicking OK or 
apply the change by clicking Apply. 

When the SSS project is in focus in the Navigator, other project 
functions belonging to the project view are disabled. Thus, you 
cannot modify objects in the project or start tools like DR-Collector 
Tool, System Configuration etc.
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Fig. 10.4.-1 System Self Supervision enabled

The SSS project is created automatically for the project you have open in the Project 
Structure Navigator and therefore no additional steps are needed.

10.5. Disabling System Self Supervision
When you want to disable the System Self Supervision, you reverse the operation 
described in the above Section 10.4. Enabling System Self Supervision. 

Remove the �x� from the check box by clicking at it, see Fig. 10.5.-1. No additional 
measures need to be taken.

Fig. 10.5.-1 System Self Supervision disabled

10.6. Opening the System Self Supervision view
The System Self Supervision tree structure is accessible either by clicking the alerts 
in the Project Structure Navigator alert box or on demand by the operator in the 
Views menu.

Proceed as follows:

� By clicking the Alert message as in Fig. 10.6.-1, the SSS view is opened. Status 
code is in parentheses.

The Supervision Log Viewer (Chapter 11. Supervision Log Viewer) 
is not updated as to the items Common System Messages and 
Unknown Process Messages when SSS is disabled. History is still 
available.
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SSS_Sel1

Fig. 10.6.-1 Opening the SSS view by clicking the alert 

� To manually open the SSS view, select SSS - System Self Supervision in the 
Views menu, see Fig. 10.6.-2.

Fig. 10.6.-2 Entering the SSS view

�SSS-System Self Supervision� is not shown in the Views menu when SSS is not in 
use.

10.6.1. Exiting the System Self Supervision view
Having examined the SMS 510 system in SSS you can return to the project by 
selecting a view from the Views menu. In Fig. 10.6.-2, the project is called Model 
Switchyard (default name is ROOT). The SSS session can also be ended by 
choosing File menu/Exit and thereby exiting SMS 510.

10.7. SSS object status representation
The following describes the graphical representation, icons used, texts and reasons 
for alerts from the SSS function and some measures to solve the cases.

10.7.1. Status information
In Fig. 10.3.1.-1 and Fig. 10.7.4.-2, there is a field to the right containing Status 
Information which gives the status of the object currently selected in the SSS tree 
structure.
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Status Code
The code for the status. There is an exception for OK, which does not show any 
code. For instance, code 13251 means that the device is suspended, that is, no 
contact to the device. The codes are listed in the MicroSCADA Status Codes Manual.

Status text
The status text is the text for the status code of the selected object, but also other texts 
provided by the system. The status text can be e.g. Device OK, Device Suspended, 
System initialized.

10.7.2. Status icons
The status of the supervised objects are presented by icons as shown in the following 
sections. Depending on the type of alerts, different types of measures can or should 
be taken. Some alerts are not severe and can occur during the configuration or 
creation of the project. For some icons (select the icon in the SSS project tree), a 
technical explanation of the deviation is given. This technical explanation is 
intended for expert analysis. The list of corrective measures for each icon lists 
measures that can be taken to solve the reported deviation.

10.7.2.1. Icon OK

Fig. 10.7.2.1.-1 Status OK

Reason for occurrence
The icon in Fig. 10.7.2.1.-1 represents the �OK� situation for a supervised object 
and the object is operational. It is, however, possible that the icon is shown even 
though the device reports a warning indication, but in such cases the warning is not 
critical or indicates any errors.

10.7.2.2. Icon Not OK

Fig. 10.7.2.2.-1 The object is not operational

Reason for appearance
The most probable reasons for the icon in Fig. 10.7.2.2.-1 to appear are:

1. Communication with the device is lost or fails
2. The communication software is temporarily inactive (e.g. when the operator 

edits the system configuration)

Other possible reasons are:

3. SSS kernel malfunction
4. The SSS configuration file contains invalid or incomplete data
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5. The SSS configuration and the system configuration does not match
6. The device status code is unknown to the SSS kernel

Corrective measures
Measures for correcting the status of the objects are listed in Table 10.7.4-1.

10.7.2.3. Icon Dimmed

Fig. 10.7.2.3.-1 Data about the object is not available

Reason for appearance
The reason for the icon in Fig. 10.7.2.3.-1 to appear is that data for the object is 
missing, possible reasons are:

1. Device communication settings are incorrect in the system configuration
2. The device is disconnected or switched off
3. The device has not communicated since the system configuration was activated

Corrective measures
1. Check the communication settings of the object
2. Check the system Configuration communication settings
3. Check that the object is powered on

10.7.2.4. Icon NoConf 

Fig. 10.7.2.4.-1 Icon for object not known to SSS (internal)

Reason for appearance
The icon in Fig. 10.7.2.4.-1 appears when the project�s SSS structure includes an 
object entry that is not in the SSS kernel station list.

The icon appears as a result of an internal consistency malfunction due to interrupted 
structure updates during parametrization or project entry deletion.

This icon is used when the SSS entry is loaded and it remains unchanged for the rest 
of the project session.

Corrective measures
Measures to correct the status is to turn the Self Supervision off (see Section 10.5. 
Disabling System Self Supervision) and then turn it back on (see Section 10.4. 
Enabling System Self Supervision), to rebuild the SSS project objects.
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10.7.2.5. Icon Stop

Fig. 10.7.2.5.-1 Data about object in database inconsistent (internal)

Reason for appearance
The icon in Fig. 10.7.2.5.-1 indicates that the SSS kernel fails in executing its 
program code. The reason for this is most likely internal due to invalid/incomplete 
data or corrupted program code.

Corrective measures
Measures to correct the status are:

1. Turn the Self Supervision off, (see Section 10.5. Disabling System Self 
Supervision) and then turn it back on (see Section 10.4. Enabling System Self 
Supervision) to rebuild the SSS project objects.

2. Create a dummy project, open it and make the system configuration for it. After 
this operation, open the original project again and the SSS project is rebuilt.

3. Stop SMS 510 (by Exit in the Login window as in Fig. 4.6.-1) and then start 
SMS 510 again.

4. In case of a persisting indication, delete the object from your project and add it 
again.

10.7.2.6. Icon No

Fig. 10.7.2.6.-1 Fault reported by internal status code (internal)

Reason for appearance
The icon in Fig. 10.7.2.6.-1 appears when the internal status code for the item�s 
attributes indicates a failure or malfunction.

Corrective measures
Delete the object from your project and add it again.

10.7.3. Application State supervision
Application State supervision is supervising the SMS 510 application in general and 
available memory.

The part of the project tree belonging to Application State supervision is shown in 
Fig. 10.7.3.-1, together with the designations that are used in the object box (shows 
selected object). The same applications are shown in the Supervision Log Viewer.
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Fig. 10.7.3.-1 Application State Monitoring objects with terms

Alerts generated by the Application State are listed in the following table.

10.7.4. Line Communication supervision
Line Communication supervision is supervising the serial communication over the 
serial port(s) to the communication equipment and relay devices for both LON and 
SPA protocols.

The part of the project tree belonging to Line Communication supervision is shown 
in Fig. 10.7.4.-1, together with the designations that are used in the object box 
(shows selected object). The same applications are shown in the Supervision Log 
Viewer.

Line_comm.

Fig. 10.7.4.-1 Line Communication objects with terms

The reason for alerts by Line Communication are listed in the following table.

Table 10.7.3-1 Application state supervision items, alerts and measures

Supervised item Reason for alerts Corrective measure
Application state 
(APL_ST)

The SMS 510 system has severe 
problems.

Restart SMS 510.

Application memory pool 
supervision
(APL_POOL)

The memory pool reserved to the 
application is running low

Restart SMS 510.

Table 10.7.4-1 Line Communication supervision items, alerts and measures

Supervised item Reason for alerts Corrective measure
Line Communication 
(NODE)

System Configuration might be 
faulty or inconsistent

Check the settings of the 
communication channels in the 
System Configuration and that 
you have proper equipment 
connected 

COMx /Line x
(LINE)

Serial port hardware error or wrong 
settings made for the serial port 
initialization in the System 
Configuration, therefore it cannot 
be detected and messages cannot 
be sent or received

Check the settings of the 
communication channels in the 
System Configuration and that 
you have proper equipment 
connected 

Device 
(STATION)

The external device is not 
responding to communication or 
communication not properly 
configured or communication 
broken

Check the communication 
settings of the unit; protocol, 
serial port, address, and the 
System Configuration of the 
project. Furthermore, check that 
the object is powered on and 
that possible cables and fibres 
are properly connected.
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Line Communication alert, example
Fig. 10.7.4.-2 shows an example of a relay module on COM1 not responding to the 
system.

SSS2

Fig. 10.7.4.-2 A unit on COM1, module SPCD 2D55 address 12 is not responding

10.7.5. Operating System Events supervision
The Operating System (OS) events generated by the OS are available by using the 
Event Viewer in Administrative Tools. The part of the project tree belonging to 
Operating System is shown in Fig. 10.7.5.-1, together with the designations that are 
used in the object box (shows selected object).

Fig. 10.7.5.-1 Operating System objects with terms

The operating system alerts reference sections are listed in the following table.

Operating System based events are generated by the operating system (OS) and the 
information in the log file is consistent with events visible through the Event Viewer 
provided by the OS. Three different event types are generated by the OS: System, 
Security and Application.

Table 10.7.5-1 Operating System supervision items, alerts and measures

Supervised item Reason for alerts Corrective measure
System events See Section 11.2.3.1. System events. Check with your IT support
Security events See Section 11.2.3.2. Security events. Check with your IT support
Application events See Section 11.2.3.3. Application 

events.
Check with your IT support
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11. Supervision Log Viewer

This chapter describes the usage of Supervision Log Viewer

11.1. Overview
The Supervision Log Viewer is used to monitor the information that has been 
collected by the System Self Supervision and the operating system (OS).

The information that the Supervision Log Viewer presents can be ordinary run-time 
events occurring during normal operations or events generated during faults or other 
similar situations when there is need to examine the system.

The Supervision Log Viewer displays the information included in several log file 
types stored on the hard disk. These files contain information in form of events 
originating from both hardware and software.

Filters can also be used to focus on information from certain objects of interest. The 
user can only view the log entries in the Supervision Log Viewer, editing is not 
possible. The updating of the Supervision Log Viewer display is manual. That is, the 
display has to be refreshed to show new information that has been entered since the 
display was opened.

The information collected by System Self Supervision can also appear in event and 
alarm lists (not available in SMS 510), but by default always in the generated log 
files.

11.1.1. Supervision Log Viewer users
Some examples of users benefiting from information provided by the system 
information provided by Supervision Log Viewer are listed in the table below:

11.2. Types of log events
Each type of log information can be viewed only from the appropriate menu item in 
the Log menu. One log event type at a time can be viewed in Supervision Log 
Viewer.

Supervision Log viewer is based on the System Self Supervision 
functions. SSS has to be enabled to collect information for the 
Supervision Log Viewer. Activating SSS is described in Section 
10.4. Enabling System Self Supervision.

Table 11.1.1-1 Users and their need of system information

User Needed information
Operators Accurate information about system parts that inhibit or limit 

operation or events occurring during normal operation
Maintenance people Detailed information about failing system parts that must be 

replaced
Engineers and after sales 
support engineers

Incorrect engineering and behaviour of the system needs to 
be reported, e.g. application load, communication load.
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Views presenting SMS 510 system information:

� Common System Messages
� Unknown Process Messages

Views presenting Operating System logs:

� System Events from Operating System
� Security Events from Operating System
� Application Events from Operating System

Event codes coming from the relay modules are not presented in the Supervision 
Log Viewer.

11.2.1. Glossary
Some terms used in the Supervision Log Viewer might need explanation. The 
terminology is common within MicroSCADA.

MicroSCADA = In this case SMS 510

NET = Communication

Net Line = Communication Line, e.g. Serial port

Running = Connection established to a device

Station = Device, e.g. relay module

Station 30 = Device with SPA address 30

Suspended = e.g. communication is lost to a device

Events with the same time stamp are generally related to the same topic, i.e. there 
can be a general and a more detailed level of description for a certain event.

11.2.2. Common events
Common events, see Fig. 11.2.2.-1, include events from the communication unit as 
well as predefined events in stations and in the SMS 510. Predefined events occur, 
for example, when a connection to a remote device is lost or re-established, whereas 
occurrences of SMS 510 events are related to a certain event from the printer, 
communication unit or external clock connected to the system.

The Operating System events that are shown in the Supervision Log 
Viewer are restricted to events concerning the SMS 510 
(MicroSCADA) system. All OS events are available from the Event 
Viewer in Administrative Tools provided by the Operating System.
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Fig. 11.2.2.-1 Common Events view

Common system messages contain the following information:

� Time stamp with milliseconds, e.g. 2003-06-12 11:32:49.521
� Object type, e.g. Station (relay module)
� Object number, e.g. 115 (module address)
� Communication unit (NET) number (if any), e.g. 2
� Communication unit line (NET Line) number (if any), e.g. 1
� Status code, e.g. Device suspended [13371] (system message from the 

communication unit) or text, e.g. Running (if application or base system event)

11.2.3. Operating System events
Operating System based events are generated by the operating system, e.g. Windows 
NT, Windows 2000 or Windows XP. The information in log file is consistent with 
events visible through the OS Event Viewer. Three different event types generated 
by the OS are System, Security and Application. These incoming events are, if 
defined so, stored into own types of files by the Supervision, described in separate 
sections below.

11.2.3.1. System events
An example of an OS System event is shown in Fig. 11.2.3.1.-1.
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Fig. 11.2.3.1.-1 System Events view, details for the selected event shown

System events contain the following information:

� Time stamp with seconds, e.g. 1999-12-03 08:30:52
� Source specific event id, which together with the name of the source identifies the 

message, e.g. 9
� Type of event (e.g. ERROR, WARNING, INFORMATION, AUDIT_SUCCESS, 

AUDIT_FAILURE)
� Source-specific sub category. This information is shown only in the Event Details 

dialog.
� Active user (if possible to define) at the time the event was logged, e.g. 

Administrator
� Name of the computer that generated the event, e.g. FIMIT-RVS-S11
� Domain name of the computer that generated the event
� Name of the source, i.e. application, service, driver, subsystem that generated the 

entry, e.g. Print
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� Log type of the event is always SYSTEM. When SYSTEM events are shown in 
Supervision Log Viewer, it is not possible to view SECURITY or 
APPLICATION events simultaneously.

� Source specific message string. 

If N/A (Not Applicable) is shown for an event, it means that the specified item is not 
included in the received event information.

11.2.3.2. Security events
Security events contain the following information:

� Time stamp with seconds, e.g. 1999-12-03 08:30:52
� Source specific event id, which together with the name of the source identifies the 

message, e.g. 9
� Type of event (e.g. ERROR, WARNING, INFORMATION, AUDIT_SUCCESS, 

AUDIT_FAILURE)
� Source specific sub category. This information is only shown in the Event Details 

dialog.
� Active user (if possible to define) at the time the event was logged, e.g. 

Administrator
� Name of the computer that generated the event, e.g. FIMIT-RVS-S11
� Domain name of the computer that generated the event
� Name of the source, i.e. application, service, driver, subsystem that generated the 

entry, e.g. Print
� Log type of the event is always SECURITY. When SECURITY events are shown 

in Supervision Log Viewer, it is not possible to view SYSTEM or 
APPLICATION events simultaneously.

� Source specific message string. This information is shown only in the Event 
Details dialog.

If N/A (Not Applicable) is shown for an event, it means that the specified item is not 
included in the received event information.

11.2.3.3. Application events
Application events contain the following information:

� Time stamp with seconds, e.g. 1999-12-03 08:30:52
� Source specific event id, which together with the name of the source identifies the 

message, e.g. 9
� Type of event (e.g. ERROR, WARNING, INFORMATION, AUDIT_SUCCESS, 

AUDIT_FAILURE)
� Source specific sub category. This information is shown only in the Event Details 

dialog.
� Active user (if possible to define) at the time the event was logged, e.g. 

Administrator
� Name of the computer that generated the event, e.g. FIMIT-RVS-S11
� Domain name of the computer that generated the event
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� Name of the source, i.e. application, service, driver, subsystem that generated the 
entry, e.g. Print

� Log type of the event is always APPLICATION. When APPLICATION events 
are shown in Supervision Log Viewer, it is not possible to view SYSTEM or 
SECURITY events simultaneously.

� Source specific message string. This information is shown only in the Event 
Details dialog.

If N/A (Not Applicable) is shown for an event, it means that the specified item is not 
included in the received event information.

11.3. Starting Supervision Log Viewer
The Supervision Log Viewer is started from the System Tools menu by selecting 
Supervision Log as in Fig. 11.3.-1.

SyTo_SL

Fig. 11.3.-1 Starting the Supervision Log Viewer from the System Tools menu

11.4. Toolbar and menus
The following section describes the toolbar buttons and the menus in the 
Supervision Log Viewer.

In the table below, the buttons are presented as a group, but also one by one when 
the matching menu items are presented. Some of the toolbar buttons and menu items 
are enabled only when a certain function or view is selected in the Log menu.

Table 11.4.-1 Toolbar buttons and the corresponding functions

Button Function
Exit the Supervision Log Viewer.

Log Settings, select the amount of events to be shown.

Setting of Mechanism Parameters for the Unknown Process Object. This button 
is disabled in SMS 510.
Select operating System Events and Events Types. The button is enabled when 
the view System Messages from the Operating System is active.
Scroll one page backward on the list.

Scroll one page forward on the list.
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11.4.1. Log menu
In the Log menu, see Fig. 11.4.1.-1, you can select different views of events and exit 
the Supervision Log Viewer.

Fig. 11.4.1.-1 Log menu for selecting the types of events to be shown

Common System Messages
This selection shows events in the scope of Common System Events. More 
information is given in Section 11.2.2. Common events.

Unknown Process Objects
This function is not available in SMS 510.

System Events from Operating System
This selection shows events in the scope of System Events from the Operating 
System. More information is given in Section 11.2.3. Operating System events.

Security Events from Operating System
This selection shows events in the scope of Security Events from the Operating 
System. More information is given in Section 11.2.3.2. Security events.

Application Events from Operating System
This selection shows events in the scope of Application Events from the Operating 
System. More information is given in Section 11.2.3.3. Application events.

Define color settings for the Supervision Log Viewer and view the system colors.

Define font settings for the Supervision Log Viewer and view the font settings of 
the MicroSCADA base system.
View the About Supervision Log Viewer dialog.

Table 11.4.-1 Toolbar buttons and the corresponding functions

Button Function
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Clear All Events
Before the deletion of the appropriate log type, the following dialog is displayed (see 
Fig. 11.4.1.-2). If you click Yes, the contents of the log type will be cleared.

Fig. 11.4.1.-2 Dialog for confirming the clearing of events

Exit
Exit ends the Supervision Log Viewer session.

Keyboard entry: <Alt>+<F4>

Toolbar entry:

11.4.2. View menu
The View menu, see Fig. 11.4.2.-1, contains several functions, which are described 
in the following sections. All the menu items in the View menu have effect on the 
view selected from the Log menu.

Fig. 11.4.2.-1 View menu items

All Events
Displays all events of the selected log type, events to be shown are not filtered. This 
is the default selection, if not otherwise defined in the Supervision Log profile by 
the user.
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Use Event Filter
By selecting the option Use Event Filter, the filtering is activated according to the 
definitions in Supervision Log profile dialog in the Filters menu.

Newest First
Sorts the events in the view, with the newest event on top. This is the default 
selection, if not otherwise defined into Supervision Log profile by the user.

Oldest First
Sorts the events in the view, with the oldest event on top.

Details�

Keyboard entry: <Enter>
Displays all the event information in the Details dialog for the selected event in the 
view. It is applicable only when some of the Operating System log types are active 
in Supervision Log Viewer, i.e. System Events, Security Events or Application 
Events.

The third way to present details is to double click an event line in the view, see 
example in Fig. 11.2.3.1.-1.

Fig. 11.4.2.-2 Event Details dialog
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The following table explains the buttons shown in Fig. 11.4.2.-2 above.

Next Page

Keyboard entry: <Ctrl>+<N>

Toolbar entry:

Next Page scrolls forward one page in the list. The count of events to be shown in 
the view page in the Supervision Log Viewer is defined in the Log Settings dialog 
accessible from the Options menu.

Previous Page

Keyboard entry: <Ctrl>+<N>

Toolbar entry:

Previous Page scrolls backward one page in the list. The count of events to be shown 
in the view page in the Supervision Log Viewer is defined in the Log Settings dialog 
accessible from the Options menu.

Refresh

Keyboard entry: <F5>
The Supervision Log Viewer is not automatically updated if new events are received 
into log files when the Supervision Log Viewer is open. When the user refreshes the 
view, these new events are displayed in the view. Note that if the Oldest First 
selection is active in the View menu, the newest events are included at the bottom 
of the last page.

11.4.3. Filter menu
The Filter Menu, see Fig. 11.4.3.-1, is used to select filters and Supervision Log 
profile.

Table 11.4.2-1 Buttons and functions in Event Details

Button Explanation
Close Closes the presentation of event details
Next Shows details of the event on the next line
Previous Shows details of the event on the previous line
102



1MRS751267-MUM SMS 510

User�s Guide
Fig. 11.4.3.-1 Filter Menu

Unknown Process Objects

Toolbar entry:

This function is not available in SMS 510.

Operating System Events

Toolbar entry:

The Operating System Events function, see Fig. 11.4.3.-2, is used to display how the 
Operating System Events are to be supervised in the system.

The function Operating System Events can be activated when any of the Operating 
System events views is active, i.e. selected from the Log Menu.

Fig. 11.4.3.-2 Check boxes for selecting Operating System events
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A description of the options in Fig. 11.4.3.-2 is given in the following table:

Supervision Log Profile
By using Supervision Log Profile, see Fig. 11.4.3.-3, it is possible to filter the 
displayed event information in Supervision Log Viewer. Only events found in the 
log files that fulfil the filter conditions are shown in the Supervision Log Viewer. 
This way it is easier to focus on events received from certain supervised object 
items.

The Supervision Log Profile menu item is available for log types selected from the 
Log menu. By means of this function you can select events for all log types:

� Events from the first event to the last event
� Events within a certain period of time
� Events after last system start up

With this function, you can also select the following for an Unknown Process Object 
log type: 

� Station items of interest to monitor

Table 11.4.3-1 The check boxes available in the Operating System Events 
dialog

Selection Explanation
Handler State Indicates whether the Operating System Events are to be supervised 

in the SMS 510 (Enabled) or not (Disabled). If the handler is in the 
enabled state, it is possible to log five types of events. If the 
appropriate dialog item for ERROR, WARNING, INFORMATION, 
AUDIT SUCCESS or AUDIT FAILURE is selected in the Operating 
System Events dialog, it means that it has been configured to be 
supervised into the SMS 510.

ERROR Error events indicate significant problems that the user should be 
informed about. These types of events usually indicate a loss of 
functionality or data.

WARNING Warning events indicate problems that are not significant 
immediately, but that may cause problems in future.

INFORMATION Information events indicate typically infrequent, but important and 
successful operations in the OS. For instance, when Microsoft SQL 
Server is initialized successfully, there may be a need to log an 
information event stating that �SQL Server has started successfully.�

AUDIT SUCCESS Success audit events are security events that occur when an audited 
access attempt has been successful, e.g. a successful logon has 
occurred in the OS.

AUDIT FAILURE Failure audit events are security events that occur when an audited 
access attempt has failed, e.g. an unsuccessful logon has occurred 
in the OS.

The settings in Fig. 11.4.3.-2 are settable on-line via HSI and are in 
use until SMS 510 is shut down.
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With this function you can also select the following for a Common System Message 
log type:

� Communication unit, communication unit line and station items of interest to 
monitor

Fig. 11.4.3.-3 Supervision Log Profile

In the figure above, events from stations 4, 5 and 11 are selected. The buttons and 
corresponding functions in Fig. 11.4.3.-3 are listed in the table below:

The profile settings are immediately taken into effect and are also active at the next 
start-up of the Supervision Log Viewer. In other words, the settings are active until 
they are changed or another profile is loaded. The profiles are user-specific.

11.4.4. Options menu
The Options menu, see Fig. 11.4.4.-1, provides settings for changing the 
environment in the Supervision Log Viewer. The definitions done in the Supervision 
Log Viewer by using these menu items have an immediate effect on the functionality 

Table 11.4.3-2 Buttons and explanations to Supervision Log Profile

Button Explanation
Load New� Opens the File Chooser for loading Supervision Log profile from 

specified folder. Supervision Log profile files include extension .evt
Save As� Opens the File Chooser for saving the defined Supervision Log profile in 

the Supervision Log Viewer to the specified folder. It is recommended 
that the default file extension .evt is used when renaming the profile file.

OK Activates the profile settings to be used in Supervision Log Viewer.
Cancel No change is being made to the profile settings.
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of the Supervision Log Viewer and are also stored into the user-specific parameter 
file. Next time the Supervision Log Viewer is opened, the same definitions are taken 
into use.

Fig. 11.4.4.-1 Options menu

Toolbar Visible
The toolbar buttons are visible or invisible by selecting this function.

Background Color�
By selecting this menu item the Color Chooser is displayed from which you can 
select the color that you want to use as background in the Supervision Log Viewer.

Foreground Color�
By selecting this menu item the Color Chooser is displayed from which you can 
select the color that you want to use as foreground in the Supervision Log Viewer.

Default Colors
Restore the default colors to be used both for the background and foreground in the 
Supervision Log Viewer.

Configure Font�
By selecting this menu item, the Font Chooser is displayed, see Fig. 11.4.4.-2, from 
which you can select the font and size of the text.
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Fig. 11.4.4.-2 Setting fonts for the Supervision Log Viewer

Default Font
Restores the default font settings in the Supervision Log Viewer.

Enlarge Font
Enlarges the font size used in the Supervision Log Viewer.

Reduce Font
Reduces the font size used in the Supervision Log Viewer.

Log Settings�

Toolbar entry:

The Log Settings function, see Fig. 11.4.4.-3, is used to access the Log Settings 
dialog. In this dialog, it is possible to define how many events that should be shown 
on each page of the Supervision Log Viewer. The value range for event count is 
between 100 and 1000.
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Fig. 11.4.4.-3 Log Settings

11.4.5. Help Menu
The Help menu provides information about the Supervision Log Viewer.
108



1MRS751267-MUM SMS 510

User�s Guide
12. Remote connections

There are several different types of remote connections possible with SMS 510, but 
in this chapter the focus is set on the function Remote Connections provided by SMS 
510, i.e. LAN, Remote/RAS and Dial-Up (SPA). Beyond the scope of this chapter 
is a description of how to establish a remote connection using fibre optic equipment. 
From an SMS 510 point of view, it is basically the same as using direct 
communication over cable to the relays.

12.1. General
In the SMS 510 Remote Connections function, there are three ways of establishing 
remote connections:

1. LAN over a local network
2. Remote/RAS (Remote Access Service) using a telephone modem 
3. Dial-Up (SPA) over the telephone network

12.2. Features
The SMS 510 Remote Communications function features are listed in the following 
sections.

12.2.1. LAN and Remote/RAS
� LAN and Remote/RAS functions support establishing of connections to projects 

made and managed by another SMS 510, COM 500 with LIB 5x0 or SYS 500 
with LIB 5x0.

� LAN and Remote/RAS do not necessarily need a project of their own in the SMS 
510 initializing the connection, since the accessed project is located in the target 
system.

� Password protected.

12.2.1.1. Application areas
� Direct connection to relays via the remote SMS 510, SYS+LIB 5x0 or COM 500 

+LIB 5x0, e.g. for parametrization tasks, but also enabling uploading of 
recordings from disturbance recorders (manual operation in DR-Collector Tool). 
The communication is based on the remote project.

� Task Scheduling for transfer of data to/from a remote project. For instance, DR-
Collector Tool for collecting already uploaded disturbance recordings from a 
remote system, at present supported when connecting one SMS to another SMS.

12.2.1.2. Supported relays and tools
SMS 510 to SMS 510 connection:

� RED 500 relays, RED Relay Setting Tool, DR-Collector Tool, Event Log Viewer
� SPACOM relays, SPACOM Relay Setting Tool, DR-Collector Tool
� REx 5xx relays, Parameter Setting Tool, HV/Collect
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SMS 510 to SYS+LIB 5x0 or COM 500 +LIB 5x0:

� RED 500 relays, RED Relay Setting Tools, DR-Collector Tool, Event Log 
Viewer

� SPACOM relays, SPACOM Relay Setting Tool, DR-Collector Tool

12.2.2. Dial-Up (SPA) 
� The project used for the Dial-Up (SPA) connection is located in and managed by 

the SMS 510 performing the Dial-Up.
� Projects within the own SMS 510 project pool are available.
� Same operations possible as when using direct connection to the relays.
� Utilizing the telephone network.
� SPA protocol.

12.2.2.1. Application areas
� Connection to relays for data exchange like parametrization, disturbance upload, 

reading of registered values etc.

12.3. Activating a remote connection
A remote connection is activated by selecting the desired connection from the 
Remote Connections list, see Fig. 12.3.-1.

The following is carried out upon selecting an item from the Remote Connections 
list:

� When selecting an item from the Remote Connections list, an attempt to open the 
connection is made. In case another remote connection is open, that connection is 
first closed before the new connection is established.

� Remote connections change focus in the Project Navigator to the project that has 
been defined for the connection.

Fig. 12.3.-1 Selecting a connection from the Remote Connections list

Before the remote connection is established, you have to assure that it is OK to open 
a remote connection, see Fig. 12.3.-2.
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Fig. 12.3.-2 Dialog for establishing a remote connection

12.3.1. Remote/RAS activation
For Remote/RAS type of connections, you need to activate the RAS Service in the 
target system.

In the SMS 510 from which you initiate the Remote/RAS connection, the SMS 510 
initiating the connection is considered as client, but the target system is considered 
as RAS server. The RAS Server has to be started before connecting.

To see the status of the RAS service, select Administrative Tools and Remote 
Access Admin from the Programs menu in your OS. The service is started by 
selecting Start Remote Access Service� in the Server menu.

12.3.2. Connection Status
When being connected to a remote system, a Connection Status dialog opens, see 
Fig. 12.3.2.-1.

Fig. 12.3.2.-1 Connection status

In Fig. 12.3.2.-1, the button Task Monitor for Dial-Up (SPA) type of connections is 
disabled. The Connection Status dialog is available as long as there is a connection 
on-line and it also presents the time elapsed whilst being on-line.

12.3.3. Remote Task Monitoring
When there is a remote connection using LAN or Remote/RAS, the Connection 
Status dialog in Fig. 12.3.2.-1 is shown. The button Task Monitor opens the remote 
Task Monitor, see Fig. 12.3.3.-1 (disabled for Dial-Up (SPA) type of connections).
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Fig. 12.3.3.-1 Remote Task Monitor

The remote Task Monitor supervises possible ongoing tasks performed by the 
Scheduler in the remote target system.

The Task Monitor itself is described in Chapter 16. Task monitoring, but there are 
two buttons, which are not described there. The following table describes the buttons 
shown in Fig. 12.3.3.-1.

12.4. Closing a remote connection
A remote connection is stopped or ended as follows:

� By selecting Local Project the remote connection activity is closed, see 
Fig. 12.3.-1. This means that no projects will be opened in the PSN after the 
connection is closed, but the user can select one by choosing Open in the File 
menu.

� By selecting another remote connection, the present one is ended and a new 
connection is opened, see Fig. 12.3.3.-1

� By selecting any menu item in the File menu, i.e. Open, Close, Organize 
Projects and Exit (exiting the Project Structure Navigator)

� By pressing the Abort button which is available when there is a connection  
on-line, see Fig. 12.3.2.-1

The user is notified that the remote connection is being closed.

Table 12.3.3-1 Buttons enabled in the remote task monitor

Button Explanation
Stop Task Manager The Task Manager is stopped. After the connection is closed, the 

Task Manager is restarted automatically.
Terminate Task Select the task to be terminated
Close Closes the Task Monitor
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12.5. Initial steps before adding a remote connection
Before the remote connections can be taken into use, the following is required:

� For a LAN or RAS type of connection, there has to be a project available on 
remote; you cannot establish a connection in advance.

� Prior to using a RAS type of connection, the RAS functionality has to be 
installed.

� For a Dial-Up (SPA) type of connection, the project has to be available in the 
local SMS 510.

� Projects can be imported to SMS 510 by selecting Organize Projects from the 
File menu, when needed from e.g. CAP 50x, another SMS 510, COM 500 with 
LIB 5x0 and SYS 500 with LIB 5x0 when needed.

12.5.1. Passwords and access using LAN and Remote/RAS

When connecting manually from the Remote Connections list, see Fig. 12.3.-1, the 
user is prompted for password to login to the remote system.

12.6. Preparing remote connections

Toolbar entry:

By clicking this button, the Remote Connection List is opened, see Fig. 12.6.-1, and 
you can start creating new remote connections or modify/delete the existing ones.

Fig. 12.6.-1 Remote Connection List

A connection by means of LAN or Remote/RAS requires that the 
operator is a member of the administrator group in the operating 
system in both systems interconnecting. The user also has to use the 
same login password when using tools establishing automatic 
connections via LAN or Remote/RAS, e.g. Scheduler functions. 
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12.6.1. Adding an item to the Remote Connection List
By pressing the Add button in the Remote Connections dialog, see Fig. 12.6.-1, an 
empty item with description �---� is inserted into the list. The next step Properties 
is started directly upon clicking Add.

12.6.2. Modifying an item in the Remote Connection List
Select the item that is to be modified from the list and click on Properties to 
configure it, see Fig. 12.6.-1.

12.6.3. Deleting an item in the Remote Connection List
By selecting the list item to be deleted and clicking Delete, see Fig. 12.6.-1, the 
selected item with its properties is deleted.

12.6.4. Configuring properties for a Remote Connection List item
The Remote Connection List items are configured by selecting Properties in the 
Remote Connection List, see Fig. 12.6.-1. The Properties function is started 
automatically when the Add button has been pressed.

The Remote Settings are described separately for each Remote Connection type in 
the following sections.

12.6.4.1. Configuring a LAN type of connection

For more information on additional settings of the target system, refer to the SMS 
510 Installation & Commissioning Manual.

There are two scenarios when configuring a LAN connection, depending on the type 
of �Target System� selected.

� Connecting to a remote SMS 510
� Connecting to COM 500/LIB 5x0 or SYS 500/LIB 5x0

Depending on the �Target System�, the following applies to the project to be 
connected:

� When the �Target System� is SMS 510, the project to be connected to is the one 
set as �Local�.

� When the �Target System� is SYS 500/LIB 5x0 or COM 500/LIB 5x0, the 
application (project) to be connected to must be identified by both the �Local 
Station Address� as well as the �Target Station Address�. The Target Station 

 
The deletion is carried out without prior confirmation request.

A LAN type of connection can be established only when the password in 
both the actual SMS 510 (MicroSCADA User) and the remote system 
(MicroSCADA User) is the same. The password for SMS 510 can be 
changed from the Programs menu by selecting SMS 510/Tools/
MicroSCADA User Password.
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Address data is located in SYS_BASCON.COM in the remote system. It can 
either be detected by means of the Detect function or inserted manually.

The following settings are to be made in the Remote Settings page, see 
Fig. 12.6.4.2.-1 and Fig. 12.6.4.2.-2.

Description
Give the name of the LAN connection. That name is presented in the Remote 
Connections List, see Fig. 12.3.-1 and Fig. 12.6.-1.

Connection Type
Select LAN

Target System
Select whether it is another SMS 510 installation, a SYS 500/LIB 5x0 or COM 500/
LIB 5x0.

Installed on
Select the drive where the Target System is located

IP Address
Give the IP address of the remote computer

Local Station Address
When the target system is SYS 500/LIB 5x0 or COM 500/LIB 5x0, the Local Station 
Address is the address of the SMS 510. The setting you specify must not overlap 
with any station address used by the target system. To find out which station 
addresses are in use by the target system, either use the target system�s System 
Configuration Tool or inspect the target system�s SYS_BASCON.COM.

Target Station Address
When the target system is SYS 500/LIB 5x0 or COM 500/LIB 5x0, the Target 
Station Address is the station address of the remote system. The setting is not 
available when the �Target System� is SMS 510. The setting can be given manually 
or by using Detect.

Application
The application number refers to the number in the SYS_BASCON.COM file used 
for LIB 5x0 applications in SYS 500 and COM 500. Use the Detect button to get a 
list with the names of the applications. The setting is not available when the �Target 
System� is SMS 510. The setting can be selected from the numbers available or from 
the application names presented by using Detect.
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Exit and save
After having configured the LAN connection, you can exit the Remote Connection 
Properties by clicking OK.

12.6.4.2. Two LAN setting examples
Fig. 12.6.4.2.-1 shows the configuration made for a connection to another SMS 510 
and Fig. 12.6.4.2.-2 shows a configuration made for a connection to a COM 500.

SMS 510

Fig. 12.6.4.2.-1 LAN connection to another SMS 510

COM 500/LIB 5x0 or SYS 500/LIB 5x0

Fig. 12.6.4.2.-2 LAN connection to a COM 500 system
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12.6.4.3. Checking connection
The LAN connection configuration can be done without checking that a connection 
can be established, but it is more convenient to check the connection already during 
the configuration.

Try
The function Try can be applied after the IP address has been given to verify that 
the connection is OK, see Fig. 12.6.4.3.-1. 

Fig. 12.6.4.3.-1 Remote computer found, connection is OK

Detect
Upon a successful Detect operation the �Station Address� is given the remote station 
address and the applications numbers in �Application� are changed to the texts as 
defined in the remote SYS_BASCON.COM to which the detect is done.

12.6.4.4. Configuring a remote type of connection (RAS)

Additional settings required in the target system are that the remote system is 
configured as RAS server, while the target system is configured as client. These 
definitions are made when installing the RAS functions.

For more information on additional settings of the target system, refer to the SMS 
510 Installation & Commissioning Manual.

There are two scenarios when configuring a RAS connection, depending on the type 
of �Target System� selected.

� Connecting to a remote SMS 510
� Connecting to COM 500/LIB 5x0 or SYS 500/LIB 5x0

Depending on the 'Target System,' the following applies to the project to be 
connected:

� When the �Target System� is SMS 510, the project to be connected to is the one 
set as �Local�. 

A RAS remote type of connection can be established only when the 
password in both the actual SMS 510 (MicroSCADA User) and the 
remote system (MicroSCADA User) is the same. The password for 
SMS 510 can be changed from the Programs menu by selecting 
SMS 510/Tools/MicroSCADA User Password.
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� When the �Target System� is SYS 500/LIB 5x0 or COM 500/LIB 5x0, the 
application (project) to be connected to must be identified by both the �Local 
Station Address� as well as the �Target Station Address�. The Target Station 
Address data is located in SYS_BASCON.COM in the remote system.

The following settings are to be made on the Remote Settings page, see 
Fig. 12.6.4.5.-1.

Description
Give the name of the Remote/RAS connection. That name is then presented in the 
Remote Connections List, see Fig. 12.3.-1 and Fig. 12.6.-1.

Connection Type
Select Remote

Target System
Select whether it is another SMS 510 installation, a SYS 500/LIB 5x0 or a COM 
500/LIB 5x0

Installed on
Select the drive where the Target System is located

IP Address
Give the IP address of the remote computer

Phone Number
Give telephone number

Comm. Port
Select the serial port

Advanced
The Advanced button brings up a Windows system dialog for configuration of the 
connection. This function is shortly described in Section 12.6.4.6. Advanced 
settings.

Local Station Address
When the target system is SYS 500/LIB 5x0 or COM 500/LIB 5x0, the Local Station 
Address is the address of the SMS 510. The setting you specify must not overlap 
with any station address used by the target system. To find out which station 
addresses are in use by the target system, either use the target system�s System 
Configuration Tool or inspect the target system�s SYS_BASCON.COM.
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Target Station Address
When the target system is SYS 500/LIB 5x0 or COM 500/LIB 5x0, the Target 
Station Address is the station address of the remote system. The setting is not 
available when the �Target System� is SMS 510. The setting is given manually.

Application
The application number refers to the number in the SYS_BASCON.COM file used 
for LIB 5x0 applications in SYS 500 and COM 500. The setting is not available 
when the �Target System� is SMS 510. The setting is selected from the numbers 
available.

Exit and save
After having configured the Remote/RAS connection, you can exit the Remote 
Connection Properties by clicking OK.

12.6.4.5. Remote/RAS setting example
In Fig. 12.6.4.5.-1, a setting example for a Remote/RAS type of connection is given. 
The settings in grey are disabled, i.e. they are not settable.

Fig. 12.6.4.5.-1 Example settings for Remote over RAS to another SMS 510

12.6.4.6. Advanced settings
By clicking the Advanced button in Fig. 12.6.4.5.-1, an Edit Phonebook Entry 
dialog is opened, see Fig. 12.6.4.6.-1. This dialog is part of the operating system 
RAS subsystem. For details, refer to the operating system documentation about 
RAS.
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Fig. 12.6.4.6.-1 The Basic page

12.6.5. Connecting to SYS 500 or COM 500 

12.6.5.1. Connecting to SYS 500 or COM 500 systems that have LIB 5x0 
installed
The global logical path CMD_TOOL has to be defined in the base system attribute 
SYS:BPH. The path has to point to a directory, where the file BGU_PRODUCT.INI 
resides. In LIB 5x0 systems this path is /LIB4/BASE/BBONE/USE. The definition 
can be made in the file BGU_GLPATH.TXT in the directory /LIB4/BASE/BBONE/
USE.

For example:
; ##LIB 500 revision 4.0.2##
; Global paths used in LIB500 4.0
;if executed by sys_bascon.com, return list of global paths
;otherwise create global paths
@HOST = SCIL_HOST
#IF HOST:VNAME == "MAIN" #THEN #BLOCK
   @GLOBAL_PATHS = LIST(-
            BBONE      = VECTOR("/LIB4/BASE/BBONE/USE"),-
            BBONE_INST = VECTOR("/LIB4/BASE/BBONE/INST"),-
            B_4TRPRI   = VECTOR("/LIB4/BASE/BBONE/USE"),-
            CMD_TOOL   = VECTOR("/LIB4/BASE/BBONE/USE"))
   #RETURN %GLOBAL_PATHS
#BLOCK_END
#ELSE_IF LENGTH(SELECT(LIST_ATTR(APL:BPH),"==""BBONE""")) == 0 #THEN #BLOCK
   ;path for reading paths 
   #PATH BBONE /LIB4/BASE/BBONE/USE
   ;path for creating standard function list (MLIB_INDEX.TXT)
   #PATH BBONE_INST /LIB4/BASE/BBONE/INST
   ;path for transparent printout method from FORM pictures
   #PATH B_4TRPRI /LIB4/BASE/EVENT/USE
#BLOCK_END
;Path for default project (handled separately, directory may not exist)
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@APL_NAME = APL:BNA
#PATH DEF_PRJ /APL/'APL_NAME'/PROTECTION
;DR-Collector Tool: Default directory for the disturbance recordings
#PATH RECORDER /APL/'APL_NAME'/RECORDER
;this logical path determines where Project Manager resides,
;(defined only in a LIB4 application)
#IF LENGTH(PATH("LIB4")) > 0 #THEN #PATH CMD_TOOL NO_CREATE, /LIB4/BASE/BBONE/
USE

If the RAS connection is used, the file NETEXT.EXE has to reside in the directory 
of Communication manager, i.e. in /LIB4/BASE/BBONE/USE, into which it 
should be copied from the SMS 510 directory /SERVICES/COMMUNICATION/
USE. NETEXT.EXE is used for fetching the IP address from the remote computer.

12.6.5.2. Connecting to SYS 500 or COM 500 systems that have no LIB 
5x0 installed
The project has to exist in the remote system. When the LIB 5x0 is not installed in 
the system, the project has to be created elsewhere and be copied to the remote 
system. The directory structure should comply with the rules of LIB 5x0, i.e. the 
project should reside in the directory: /APL/APL_NAME/PROTECTION/PRJ.

File BGU_PRODUCT.INI has to be copied to a remote system from the system 
where the project has been created. The path for the file should comply with the rules 
of LIB 5x0, i.e. the file should reside in the directory: /LIB4/BASE/BBONE/USE.

The global logical path CMD_TOOL has to be defined in the base system attribute 
SYS:BPH. The path should point to a directory, where the file BGU_PRODUCT. 
INI resides. The definition can be made for example in the file /STOOL/DEF/
PATH_DEF.TXT.

Example of PATH_DEF.TXT:
;File:         Path_Def.txt
;Description:  MS-STool Path definitions
;              Version 8.4.2
;---------------------------------------
@t_Error_State = Error_State
@l_Global_Paths = List(GPRC     = vector("/LAN/ACTIVE/GPRC"),-
                       CONF     = vector("/LAN/ACTIVE/CONF"),-
                       TEMP     = vector("/TEMP"),-
                       START    = vector("/Prog/Exec"),-
                       SYS_TOOL = ("/STool/Misc", "/STool/AplBuild",
                                   "/STool/SysConf",-
                                   "/STool/Def", "/STool/Superv"),-
                       SYS_CONF = vector("/SYS/ACTIVE/SYS_"),-
                       CMD_TOOL = VECTOR("/LIB4/BASE/BBONE/USE"))
#path TEMP /TEMP
@l_Host = Scil_Host
#if l_Host:Vname == "MAIN" #then #block;  Sys_bascon.com
   #Error 't_Error_State'
   #Return %l_Global_Paths
#block_end
#else #block
   #if length(Path("SYS_TOOL")) == 0 #then #block;  no tool paths created
      @v_Path_Names = List_attr(%l_Global_Paths)
      #loop_with i=1..length(%v_Path_Names)
         @t_Path_Name = %v_Path_Names(%i)
         @t_Directories = collect(l_Global_Paths:v't_Path_Name',",")
         #path 't_Path_Name' no_create, 't_Directories'
      #loop_end
   #block_end
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   ;------------ Create Par directorys to application --------------
   #Path tmp     +Par              ;** Create Par     **
   #Path Apl_Par  Par/Apl          ;** Create Apl     **
   #Path User_Par Par/Default      ;** Create Default **
   ;----- Create dummy files for shadowing ---------------
   @Dummy = write_text("Apl_Par/Info.txt",vector("Rev"))
   @Dummy = write_text("User_Par/Info.txt",vector("Rev"))
   #Error 't_Error_State'
#block_end

If the RAS connection is used, the file NETEXT.EXE has to reside in the directory 
of Communication manager, i.e. in /LIB4/BASE/BBONE/USE, into which it 
should be copied from the SMS 510 directory /SERVICES/COMMUNICATION/
USE. NETEXT.EXE is used for fetching the IP address from the remote computer.

12.6.5.3. Remote Connection Properties when connecting to SYS 500/LIB 
5x0 or COM 500/LIB 5x0 systems over LAN or RAS
This section applies to connections from SMS 510 to SYS 500/LIB 5x0 or COM 
500/LIB 5x0 over LAN or RAS.

On the Remote Connection Properties dialog, the field Station Address has been 
renamed to Target Station Address. It represents the station address of the remote 
SYS 500/LIB 5x0 or COM 500/LIB 5x0 system, respectively. The data for this field 
is located in the file SYS_BASCON.COM of the remote system. You can use the 
Detect function to fetch the value automatically or you can insert it manually.

A new field, named Local Station Address, has been added to the Remote 
Connection Properties dialog. The purpose of this field is to allow per-connection 
definition of the local station address (i.e. the station address of the SMS 510). 
Initially, SMS 510 assigns a default station address to this field. However, in case 
this default value is in use in the remote system, it has to be changed to avoid 
overlapping station addresses. Notice that in addition to the Target Station Address, 
a SYS 500/LIB 5x0 or COM 500/LIB 5x0 system may use several station addresses 
which you cannot use as the Local Station Address. To find out which addresses you 
can use, either use the System Configuration Tool of the remote SYS 500/LIB 5x0 
or COM 500/LIB 5x0 system, or manually inspect the remote system's 
SYS_BASCON.COM, looking for reserved station address definitions.

12.6.6. Configuring Dial-Up (SPA) type of connection
The Dial-Up (SPA) type of connection is based on telephone modems and there is 
one telephone number for each project. The project has to be located in the actual 
SMS 510 installation.

Using Dial-Up (SPA) requires configuration by two different tools i.e.

� Properties in Remote Connections List for the Dial-Up (SPA) connection
� System Configuration of the actual project, see Fig. 12.6.6.-2

The following settings are to be made on the Remote Settings page, see 
Fig. 12.6.6.-1.
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Description
Give the name of the Dial-Up (SPA) connection. That name is then presented in the 
Remote Connections List, see Fig. 12.3.-1 and Fig. 12.6.-1.

Connection Type
Select Dial-up (SPA).

Phone Number
Give the telephone number that is to be used.

Exit and save
After having configured the Dial-Up (SPA), you can exit the Remote Connection 
Properties by pressing OK.

Example setting
Fig. 12.6.6.-1 shows an example of settings for a dial-up connection. The settings in 
grey are disabled.

Fig. 12.6.6.-1 Configuring Dial-Up SPA 

System configuration for Dial-Up (SPA)
In addition to the Dial-Up (SPA) made to the Remote Connections List, the system 
configuration, see Fig. 12.6.6.-2, has to be prepared for each project using modem. 
In the System Tools menu, select System Configuration and the Communication 
page.

The project that is to be prepared for modem connection has to be 
open in the Project Structure Navigator. In case the project is not 
open, open it by choosing Open in the File menu.
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Fig. 12.6.6.-2 Selecting Connection Type: modem on COM1 and the default 
initialization string for the modem and SPA default settings.

The following settings should be made in System Configuration, see Fig. 12.6.6.-2.

Serial Port
Add a Serial port in case there is no port in the list.

Protocol
Protocol is always SPA.

Connection Type
The connection type should be set to Modem.

Modem Command (AT)
By default, the modem initialization string gives the initialization string AT Q0 %C0 
&K0, but other AT commands can be given as well. When you have pre-configured 
the modems, you can leave this field empty.
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SPA dial-up configuration
When configuring a SPA dial-up connection, the following modem settings should 
be used.

The following AT commands have to be set to the modem in the station (SPA IBB):

� %C0 Disables Data Compression 
� &K0 Flow control disabled
� Q1 Disable Result Codes
� &D0 Respond as if DTR is always on

The following AT commands have to be set in the modem connected to the SMS 510 
computer:

� %C0 Disables Data Compression
� &K0 Flow control disabled
� Q0 Enable Result Codes
� &D2 Hang up if DTR is dropped

Header timeout
The Header Timeout attribute of the SPA lines defines the maximum waiting time 
in milliseconds within which the first byte of a response from the slave should have 
been received after the transmission of a message. The default value for a modem 
connection is 2000 ms, but the value can be increased by clicking the "< Advanced" 
button, if having a poor communication link.
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13. Time/Date Settings, Time Synchronization and 
General Settings

In this chapter, time based activities such as setting of date and time of the PC, time 
synchronization of the relays and the Automatic Logoff function are described.

13.1. Time/Date Settings
The Time/Date Settings function is used to check the date and time settings of the 
system and also to adjust date and time of the PC.

13.1.1. Starting Time/Date Settings
Start the function by selecting Time_Date in the System Tools menu in the Project 
Structure Navigator, see the figure below:

SyTo_TD

Fig. 13.1.1.-1 Starting the Time/Date function

Upon selecting Time_Date, the view in Fig. 13.1.1.-2 appears.

Fig. 13.1.1.-2 Time/Date settings in SMS 510

13.1.2. Menus
There are two menus in Time/Date Settings; Settings and Help.
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13.1.2.1. Settings menu
Exit

Fig. 13.1.2.1.-1 Exit the Time/Date tool

You exit the Time/Date tool from the Settings menu by selecting Exit, see 
Fig. 13.1.2.1.-1. 

13.1.2.2. Help menu
About

Fig. 13.1.2.2.-1 About the Time/Date Settings

The menu item About Time/Date Settings, see Fig. 13.1.2.2.-1, presents the About 
Dialog.

13.2. Time synchronization
Time synchronization supports two protocols: LON and/or SPA. LON time synch is 
not described in this manual, refer to the SMS 510 Installation and Commissioning 
manual. Time Synchronization is available on the Communication page of the 
System Configuration in the System Tools menu in the Project Navigator. When 
devices configured to use SPA protocol are directly connected [Connection Type: 
Direct, see Fig. 13.2.1.-1], they are being synchronized by default. The 
synchronization can also be disabled. The time is taken from the PC.

Synchronization over the SPA protocol is done using a broadcast address as follows:

� Once per second:>900WT:ss.sss:CCCr
� Full synchronization message>900WD:yy-mm-dd hh.mm;ss.sss:CCCr once per 

minute.

CC = Checksum, Cr = Carriage return.

More details about setting up and configuring Time synchronization over LON/SPA 
is given in the SMS 510 Installation and Commissioning manual.

13.2.1. Starting/Stopping Time Synchronization (SPA)
The time synchronization of remote devices using SPA protocols can be stopped/
restarted from the Communication page in System Tools available from the 
System Configuration menu by clicking the Send Time Synchronization check 
box, see Fig. 13.2.1.-1.
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Fig. 13.2.1.-1 Time synchronization is enabled on COM1

13.3.  General Settings

13.3.1. Automatic Monitor Logoff
The function Automatic Monitor Logoff is used for enabling automatic logoff. This 
function is found on page General Settings in the System Configuration in the 
System Tools menu in the Project Structure Navigator, see Fig. 13.3.1.-1.
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Fig. 13.3.1.-1 The Automatic logoff function is enabled after 15 minutes

The time for logoff can be set between 10 to 60 minutes. The logoff is performed if 
the specified time elapses without any user activity. The current cursor position is 
compared to the previous position, and if it is the same, the idle time counter is 
increased.

Before the actual logoff, a warning message is shown. This message box includes a 
button for cancelling the logoff. The predefined times for showing the warning is 
dependent on the defined idle time setting:

� Idle time 10...19 min. → Warning time before logoff = 1 min.
� Idle time 20...29 min. → Warning time before logoff = 2 min.
� Idle time 30...60 min. → Warning time before logoff = 5 min.

The logoff function is also valid when the user authorization mechanism is disabled, 
see Section 14.3. User Manager main switch.

13.3.2. System Self Supervision
For more information about enabling/disabling the System Self Supervision 
function, see Section 10.4. Enabling System Self Supervision and Section 10.5. 
Disabling System Self Supervision.

13.3.3. MicroSCADA user settings for remote connections
The password for the MicroSCADA user in remote computer can be defined on the 
General Settings page in the System Configuration Tool. If the password is not 
given, the default MicroSCADA user password "microscada" is used when creating 
connections. This is because the value used in the net use command has to differ 
from empty string "". Otherwise the net use command (executed in the console) 
pauses and prompts the user to type the password. Thus, the execution of the SCIL 
is stopped until the password is given.

The password defined by the user (or the default password respectively) is used 
while opening the connections both in the invisible monitor by the Scheduler and in 
the visible monitor opened by the user via the navigator window. If the login fails in 
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the invisible monitor, an error dialog is shown and the execution of the task is 
cancelled. If the login fails from the navigator, the login dialog is shown and the user 
can enter the new password manually.
131



132



1MRS751267-MUM SMS 510

User�s Guide
14. User Management

This chapter describes the User Management function and how to configure it.

14.1. General
The User Management Tool is for defining users and user authorities. In SMS 510, 
all of the currently included tools belong to the authorization group �GENERAL�. 
The menu items for adding and removing authorization groups are therefore 
disabled.

The authorization levels used:

� View (0) = Not authorized to make operations
� Control (1) = Authorized to make operations
� Engineering (2) = All rights, but user definition
� Reserved (3) = Reserved for future
� Reserved (4) = Reserved for future
� System manager (5) = All rights

The user with rights on level 5 (system manager) can make changes in the User 
Management function.

14.2. Starting User Management
The User Management tool is opened from the System Tools menu by selecting User 
Management, see Fig. 14.2.-1.

SyTo_UM

Fig. 14.2.-1 Selecting User Management from the System Tools menu

14.3. User Manager main switch
The whole login mechanism can be disabled by the system manager by setting the 
User Management and Authorization Mechanism "Off", see Fig. 14.3.-1. Click the 
check box to toggle mode enable/disable. An �x� in the check box means that the 
Disable authorization mechanism is selected and authorization disabled.

The modifications will not become active until they are saved in the 
User Management dialog and SMS 510 is restarted.
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Fig. 14.3.-1 The authorization mechanism is enabled (part of Fig. 14.3.2.-1) 

Authorization is taken back into use by �emptying� the check box in Fig. 14.3.-1, by 
clicking at the check box.

14.3.1. User language
The language can be chosen from a list of supported ones, the default is English (0).

14.3.2. User interface
The authorization levels of the selected user are displayed. The levels can be directly 
modified by the system manager.

The GENERAL level for the system manager cannot be changed. Changing of levels 
is done by selecting the authorization group(s) from the list and then selecting the 
new authorization level with the combo-box below the list.

Access to the various tools and functions is provided by means of a toolbar, menus 
and keyboard shortcuts. Fig. 14.3.2.-1 illustrates the tool�s user interface and its 
elements.

Fig. 14.3.2.-1 User interface of the User Management

A description of the elements in Fig. 14.3.2.-1 is given in the following table.

At start up of SMS 510, the login can therefore be performed 
without giving a User name and a Password. In that case, the user is 
granted all authorization rights.

Table 14.3.2-1 User Management user interface components
Caption bar Displays the name of the tool. It also contains the standard operating 

system�s window management commands for minimising, 
maximising and closing the window.

Menu bar File, Edit, Tools and Help menu.
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14.4. File menu
 The File menu, see Fig. 14.4.-1, contains the save, print and exit functions.

Fig. 14.4.-1 File menu

14.4.1. Save

Keyboard entry: <Ctrl>+<S>

Toolbar entry: 

By selecting this function, the currently open User Management settings are saved.

14.4.2. Print

Keyboard entry: <Ctrl>+<P>

Toolbar entry: 

By selecting this function the following is printed:

� User
� User language
� Authorization group list
� Authorization level list

Toolbar The toolbar contains shortcuts for fast access to the frequently used 
functions.

Disable 
authorization 
mechanism

Enabling/Disabling of User Management ("main switch")

User Contains a list of users
User Language Contains a list of supported languages
Authorization group Contains all authorization groups that have been defined.
Authorization level The authorization level is shown for corresponding authorization 

group
Level for selected 
row

Opens a list of the access rights 0..4, the selected level is updated to 
the authorization level list for the selected authorization group.

Table 14.3.2-1 User Management user interface components
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14.4.3. Print Setup
By selecting this menu alternative, the user can set up the printer.

14.4.4. Exit

Toolbar entry:

Exit closes the User Management session.

14.5. View menu
The View menu, see Fig. 14.5.-1, enables/disables the viewing of the Toolbar 
buttons.

Fig. 14.5.-1 View menu

14.6. Tools menu
The Tools Menu, see Fig. 14.6.-1, contains the tools menu items for User 
Management.

ToolsMenu

Fig. 14.6.-1 Tools menu

14.6.1. Add User
The system manager can add users with the dialog shown in Fig. 14.6.1.-1.

Fig. 14.6.1.-1 Adding a user and copying authorization
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In the following table, the buttons in Fig. 14.6.1.-1 are described.

The name for the new user can be given in the "Username" field. The name may not 
include special characters and it may not consist of two characters followed by a 
number.

In addition, the name cannot begin with a number. Authority levels can be copied 
from other normal users (not from system manager) by selecting the source. The 
password for a new user is <enter> before the user changes it with the Change 
Password dialog.

After the system manager has added new users to SMS 510, then exit SMS 510. 
Then each new user may perform a login with the new user name in order to assign 
a new individual password instead of the empty password. Alternatively, the 
password may also remain unassigned; then the empty password remains valid until 
changed later. 

14.6.2. Remove User
The system manager can remove users with the Remove User function, see 
Fig. 14.6.2.-1.

Fig. 14.6.2.-1 Removing a user

In the following table, the buttons in Fig. 14.6.2.-1 are explained.

The user selected from the list is removed when the remove button is clicked. The 
system manager cannot be removed.

14.6.3. Add Group
The function is not relevant in SMS 510 and is therefore disabled.

Table 14.6.1-1 Button functions in the Add User dialog

Button Explanation
Apply Saves the changes without closing the dialog
Done Closes the dialog, NO SAVING
Help Run-time help

Table 14.6.2-1 Button functions in the Remove User dialog

Button Explanation
Remove Removes the selected user without closing the dialog
Done Closes the dialog, NO SAVING
Help Run-time help
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14.6.4. Remove Group
The function is not relevant in SMS 510 and is therefore disabled.

14.6.5. Change Password
All users can change their own password by means of the function Change 
Password, see Fig. 14.6.5.-1.

Fig. 14.6.5.-1 Dialog for changing the password

In the following table, the buttons in Fig. 14.6.5.-1 are explained.

If the old password is correct, the password is changed to the one given in the new 
password field.

14.6.6. Define View Monitors
The function is not relevant in SMS 510 and is disabled.

14.7. Help menu
The Help menu, see Fig. 14.7.-1, contains the General User Management Help and 
the About User Management dialog.

Fig. 14.7.-1 Help menu

14.7.1. Help
A run-time help that gives the user information about the User Management 
functions.

14.7.2. About User Management
The About User Management item shows the Tool Information.

Table 14.6.5-1 Button functions in the Change Password dialog

Button Explanation
OK Approves the changed password and closes the dialog
Cancel Cancels the proposed change of password and closes the dialog
Help Run-time help
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15. Task scheduling

This chapter describes the usage of task scheduling in SMS 510 and preparation of 
Scheduled Tasks. Since uploading of disturbance recordings is a major 
implementation area for task scheduling, the examples in this chapter are mainly 
based on disturbance uploading tools, but others may be used as well. Finally, the 
principles for how DR-Collector Tool is operating in the scope of task scheduling 
are described.

15.1. General
There are situations when tasks are needed to be performed automatically on a 
cyclical basis. One example is uploading of disturbance recordings from relay 
modules. Therefore, SMS 510 has a Scheduler function that enables tasks to be 
automatically and repeatedly performed based on time intervals, see Fig. 15.5.-2.

The SMS 510 Scheduler is a function that starts programs or functions defined in a 
Scheduled Task. There can be one or several Scheduled Tasks with one or more 
tasks each. Each Scheduled Task has a time interval and the tasks are started 
according to this interval. There is a Task Manager in the Scheduler that 
synchronises and controls starting of tasks from different Scheduled Tasks.

Depending on the program, a user interface of the tasks started by the Scheduler can 
be shown. The DR-Collector Tool, for example, is carrying out its tasks without any 
user interface when started from the Scheduler. 

The status of the tasks is presented in the Task Monitor function, see Chapter 16. 
Task monitoring.

15.2. Scheduler operating principles
The Scheduler is a function that is working independently and is automatically 
started by SMS 510. What you need to do is to define the tasks to the Scheduler as 
described in Section 15.6. Task preparation for task scheduling. The Scheduler task 
activation is automatic and is executed when you have logged out from SMS 510.

15.3. Activation of scheduled tasks
The tasks are activated by the Scheduler when:

� SMS 510 is started, but the login has not been performed
� Logging out from SMS 510, but not exiting SMS 510

In the Scheduler view, see e.g. Fig. 15.5.-2, the tasks are not 
executed. The Scheduler that is described in this chapter is used for 
assigning and preparing tasks to the Scheduler.

Task Monitoring, described in Chapter 16. Task monitoring, helps 
you observe the task execution.
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Furthermore, the following conditions have to be fulfilled:

�  �In use� = �Yes� for Scheduled Tasks (individual setting)
�  �Enable Scheduler� should be selected (setting applicable for all tasks)
�  Tasks are assigned (Scheduled Tasks definitions)

The Task Monitoring, described in Chapter 16. Task monitoring, enables 
monitoring of the task status.

15.4. Stopping of Scheduler tasks
The tasks in the Scheduler are stopped in any of the following ways:

� By closing the SMS 510 session by choosing Exit in the login window
� By logging in to SMS 510
� By setting �In use� for a Scheduled Task in the Scheduler to �No�
� By deleting tasks in the Scheduled Task, see Fig. 15.5.-2. 
� By taking the Scheduler entirely out of use, �Enable Scheduler� in the 

Scheduler window, see Fig. 15.5.-2.

In case there are tasks waiting to be performed and you want to stop these tasks from 
being performed, refer to Section 16.4. Removing of tasks with status waiting.

15.5. Opening the Scheduler for task preparation
The Scheduler is opened for task preparation by selecting System Configuration in 
the System Tools menu, see Fig. 15.5.-1, and clicking the page Scheduler.

SyTo_SC

Fig. 15.5.-1 Selecting System Configuration from the System Tools menu

In Fig. 15.5.-2, an example with five Scheduled tasks is shown. The tasks are 
executed according to the conditions described in Section 15.3. Activation of 
scheduled tasks.

Since the Scheduler is a part of SMS 510, it is running only when the 
SMS 510 system is running. When a user is logged on to the SMS 
510 system, the Scheduler only adds tasks to be performed during 
that time to the task list. These waiting tasks are performed later 
when the user has logged off either manually or due to an automatic 
logoff.
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Fig. 15.5.-2 Examples of task lists in the Scheduler

In the following two tables, the Scheduler contents in Fig. 15.5.-2 is described.

Table 15.5.-1  Columns and check box explanations to the Scheduler

Column Explanation
Scheduled Tasks Scheduled Task Number
In Use �Yes� or �No�, the option is changed by double-clicking at it. �No� means 

that the Scheduled Task is taken out of use, but can be activated later 
by clicking �Yes�. Tasks in waiting mode are executed, even if in �In 
Use� is set to �No�.

Connection The type of connection that is used for the tasks. Note that the 
connection is said to be local also for tasks that do not use SMS 510 
projects.

Starting Time The time when the task is started
Execution Interval The interval for executing the tasks in the Scheduled Task
Tools The name of the files and programs to be executed, the path is shown 

for User defined type of programs

Check box
Enable Scheduler An �x� in the check box means that the Scheduler function is enabled, 

an empty check box that it is taken out of use. Tasks in waiting mode in 
the Task List are cleared (after OK or Apply) when (temporarily) taking 
the Scheduler out of use. Click the check box to toggle mode.

Table 15.5.-2  Scheduler buttons

Button Explanation
Add Adding tasks to Scheduled tasks, see Section 15.6. Task preparation 

for task scheduling.
Delete Deletes selected Scheduled Task. Select the task to be deleted and 

press Delete. Confirm the removal.
Properties Shows the properties of a Scheduled Task and enables modification 

of it. Select a Scheduled Task and press Properties to enter the edit 
mode.

OK Confirm the Scheduled task settings and exit the Scheduler
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The Task Scheduling preparation session is closed either by pressing OK, Apply or 
Cancel.

15.6. Task preparation for task scheduling
In the following sections, the principles for adding tasks are described briefly and 
some recommendations are given.

Tool recommendation
Programs that are suitable for use in the Scheduler, are programs that close 
automatically after finishing the mission. Thereby you can avoid opening a new 
program session every time the Scheduler activates the task.

Types of tasks
There are two types of tasks (both types can be mixed in the same Scheduled Task):

� Predefined tasks available from a list of tasks (tasks available are defined by SMS 
510). Typical predefined tasks are the disturbance uploading tools like DR-
Collector Tool and HV/Collect.

� User defined tasks. Examples are disturbance evaluation tools or any other 
program defined by the user. Start-up arguments for the program can be given.

Callback Function
Using the callback function means that the task execution is supervised by the Tool 
Manager in the Scheduler. When the program is closed (automatically by the 
predefined types and manually by user defined types of tool), closing of the program 
is noticed and the callback is received. Before the callback is received, new tasks in 
the Scheduled Task list are not started, even if the time to start has elapsed.

The tasks to be performed are set in waiting mode until the callback is obtained from 
the previous task. User defined tasks, not using callback function are also set on a 
waiting list when used in the same Scheduled Task as predefined tasks.

15.6.1. Adding tasks
In the following section, we will follow two examples of how to add tasks to the 
Scheduler. The examples feature a predefined task and a user defined task.

� DR-Collector Tool is run every 4th hour using remote communication and 
performs a copy of recordings from an SMS 510 project in another location.

� Notepad is opened every Monday at 7.30 in the morning. The operator may close 
the program when finished.

Cancel Exit without saving the tasks
Apply Confirm the tasks and settings, but without leaving the Scheduler

Table 15.5.-2  Scheduler buttons

Button Explanation
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These tools are set into different tasks, because the wanted time intervals are 
different for each tool. A task list can contain one or more tools. Notepad is added 
just because it is a harmless example, but it gives the idea of using user defined tools.

In Scheduler, start by clicking the Enable Scheduler check box, step number 1 in 
Fig. 15.6.1.-1. Then click Add, step number 2 in Fig. 15.6.1.-1, to open the Task 
Properties.

Disabling the Scheduler is done by clicking the Enable Scheduler check box again.

Fig. 15.6.1.-1 Enabling the Scheduler (1) and Adding a Scheduled Task (2) 

Task Properties
Upon clicking Add in Fig. 15.6.1.-1, the Task Properties view is opened, where you 
can assign the tasks to be performed as in Fig. 15.6.1.-2.
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Fig. 15.6.1.-2 Task properties view for setting up tasks

The following properties are set in the Task Properties window Fig. 15.6.1.-2:

Connection:
Select the type of connection you are using. Local (which refers to the project set as 
local in the actual SMS 510) is always available, but the remote connections that you 
have defined are also listed.

Time Settings:
Cycle is used for selecting type of interval

Available settings are:

� Fixed intervals, no synchronization
� Absolute point of time, once an hour
� Absolute point of time, once a day
� Absolute point of time, once a week
� Absolute point of time, once a month

Date is used for setting date 

Time is used for interval definition or synchronization point

The task is started after the interval has elapsed. This means that if setting the 
interval to e.g. 30 min., the task can be started at the earliest 30 min. after it was 
defined.

Fixed interval allows only time setting, no date settings. With the �Absolute point of 
time, once a week/month� settings you can set both time and date. You can use the 
arrows or type the value manually in the fields.
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Tools:
This field contains the tools that have been added to this task. Use Add to add tools. 
Once you have a tool in the tools list you can modify or add arguments to the tool 
by clicking the Properties button, or remove the tool by clicking the Delete button.

15.6.1.1. Adding a predefined tool
Press Add in the Tools field in Fig. 15.6.1.-2 to add tools. When you add a 
predefined tool, see Fig. 15.6.1.1.-1, the drop down list contains the available tools. 
These tools are defined by SMS 510. Press OK when the selection is ready.

Fig. 15.6.1.1.-1 Adding DR-Collector Tool

Defining properties for the added tool
Once the tool has been added and the �Connection:� has been made, add properties 
to the tool, see Fig. 15.6.1.1.-2.

Fig. 15.6.1.1.-2 Defining �Properties� for the selected tool
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Tool Properties
When clicking Properties, see Fig. 15.6.1.1.-2, the Tool Properties� view is opened, 
see Fig. 15.6.1.1.-3.

Fig. 15.6.1.1.-3 Selecting file uploading method for DR-Collector Tool

For the tools of type Predefined tools in SMS 510, the Callback required check box 
is always enabled. The File Upload Method check box is enabled when the type of 
connection is Remote or LAN, i.e. the disturbances are not uploaded from the relay 
modules directly, but from another remote system that already has performed the 
uploading.

Selectable settings are Copy disturbance recordings from station or Move 
disturbance from station. In the latter case, the recordings are deleted at the source 
after a successful transfer.

15.6.2. Adding a user defined tool
Press Add in the Tools field in Fig. 15.6.1.-2 to add tools. When you want to add a 
tool that is not in the list of predefined tools, you can add it by activating the User 
Defined Tool selection by clicking that field, see Fig. 15.6.2.-1.

You can add tools either manually by giving path and file name, or by using the 
browse function (Browse button).

Fig. 15.6.2.-1 Adding a User Defined Tool

15.6.2.1. Browsing for user defined tools
The browse function, see Fig. 15.6.2.1.-1, permits searching for tools on various 
volumes. There is a tree navigator, which is used for browsing.
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Fig. 15.6.2.1.-1 Browsing for tools

Click on directories in the tree to navigate. The path is shown in the lower left-hand 
corner.

When you have found the tool or file you are looking for, click on it and it is added 
to the �File name:� field.

Use the �C:� box to select the drive to search. Click the arrow to open the list.

The fields �Operating System Paths� and �Files of type� do not contain other options.

The files in the list in the field to the right can be sorted according to �Name�, �Size� 
and �Modified� by clicking on the wanted column.

Press �Open� when you have found the file you are looking for, and the tool is added, 
see Fig. 15.6.2.1.-2.

�Cancel� ends the browsing without selecting any tools.

Fig. 15.6.2.1.-2 Notepad is added
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When the Tool is added to the Add Tool as in Fig. 15.6.2.1.-2, press OK to return to 
the Task Properties window, see Fig. 15.6.2.1.-3. Now you can give properties to the 
tool.

Defining tool properties
Properties can be given for a user-defined tool as well. Select the tool and click 
Properties, see Fig. 15.6.2.1.-3.

Fig. 15.6.2.1.-3 Selecting properties for the Notepad tool

Tool Properties
The Tool Properties function is launched for the user defined tool, see Fig. 15.6.2.1.-
4.

Fig. 15.6.2.1.-4 Tool Properties for a user defined tool

As illustrated in Fig. 15.6.2.1.-4, the callback function can be selected and a tool 
start-up argument can be chosen.
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Callback required
In case callback is selected, the callback is given when the Notepad program is 
closed. This also means that in case Notepad remains open for a longer time, no 
other tasks are started until Notepad is closed and the callback received. Thus, the 
recommendation for user defined tools is to use Callback required only when you 
have programs that close automatically.

Arguments
The arguments are added as input parameters at start up of the tool. In the example, 
Notepad will open the file openme.txt located in the remarks directory.

Press OK to finish and save the settings, or use Cancel to exit without changes.

15.6.3. The finished example
After adding the tools as described above, the Scheduler contains two tasks, see 
Fig. 15.6.3.-1.

Fig. 15.6.3.-1 Two tasks are added to the Scheduler

15.7. Uploading of disturbance recordings using the Scheduler
The following explains the principles for using DR-Collector Tool as a task in the 
Scheduler.

15.7.1. Connection methods
There are two main types of connections:

Uploading of recordings from the relays directly
� Direct to the relays (the project is in the same PC as SMS 510 and set as local)
� Dial-Up (SPA) to the relays (the project is in the same PC as SMS 510)
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Uploading of recordings from a remote system
� LAN to another SMS 510 (the project is in the remote SMS 510)
� Remote/RAS to another SMS 510 (the project is in the remote SMS 510)

You need to define a separate Scheduled Task for each type of connection.

15.7.2. Connection type dependent upload
The tasks that DR-Collector Tool performs within the Scheduler depend on the type 
of connection.

Local and Dial-Up (SPA) connections
The project that is set as local and projects using dial-up modems (SPA bus only) 
perform the upload of the disturbances from the relay modules and saves the 
recordings in the SMS 510 project. The path is found from the DR-Collector Tool.

LAN and Remote/RAS connections (SMS to SMS only)
LAN or Remote/RAS can be used to copy or move already uploaded recordings. 
This means that the remote SMS 510 is performing the upload from the relay 
modules and the recordings are transferred to the other SMS 510 over LAN or RAS. 
At the moment, SMS to SMS is supported, SMS to COM 500 + LIB 5x0 or SYS 500 
+ LIB 5x0 are not supported for transfer of recordings.

15.8. Running DR-Collector Tool over LAN/Remote
This information concerns the usage of DR-Collector Tool when started from the 
SMS 510 Project Navigator (from the System Tools menu), connecting over LAN 
or Remote/RAS. The recordings of both the remote SMS 510 and the local SMS 510 
can be seen in the DR-Collector Tool recordings list, and the recordings are marked 
with local or remote depending on location. This means that the recordings can be 
accessed over remote within DR-Collector Tool as well.

The LAN or Remote/RAS connection is opened the usual way in this case, as in the 
the example in Section 12.3. Activating a remote connection.

LAN or Remote/RAS connections initiated by the Task Scheduler 
do not permit uploading of recordings from the relays. This has to be 
done locally, either by task scheduling or by the uploading tool. 
Uploading of recordings over remote from the relays can be done 
manually by using the DR-Collector Tool.
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16. Task monitoring

This chapter describes how the status of scheduled tasks is monitored.

16.1. General
There are two ways of checking the progress and status of tasks.

� On a general level by colors in the traffic light in the SMS 510 login window, see 
Section 16.2. Task status colors.

� On a detailed level by means of the Task Monitor window, see Section 16.3. Task 
Monitor.

16.2. Task status colors
The general status of the tasks is indicated by colors in the traffic light in the login 
window, see Fig. 16.3.-1.

In the following table, a description of the meaning of the colors used in the traffic 
light, as well as the effects of a login to SMS 510 for certain colors, is given.

16.2.1. Green color
The green color, see Fig. 16.2.1.-1, indicates that there are no tasks defined in the 
Scheduler. A login to SMS 510 can be performed without any effects on tasks in the 
Scheduler.

Fig. 16.2.1.-1 Task status green, no tasks are scheduled

16.2.2. Yellow color
The yellow color, see Fig. 16.2.2.-1, indicates that there are pending tasks. The tasks 
are not carried out at the moment, but will become active later according to the 
interval set for the task(s). Starting SMS 510 might postpone the start of the task(s), 
in case the time to execute the scheduled task elapses during the user is logged on to 
SMS 510.

Table 16.2.-1 Traffic light colors, meaning and login action influence

Color Status Login action
Green
(Fig. 16.2.1.-1)

No tasks scheduled Proceed with login

(Yellow
Fig. 16.2.2.-1)

Tasks are scheduled, but not 
performed at the moment

A login might postpone the execution of 
the task

Red
(Fig. 16.2.3.-1)

The Scheduler is busy with 
tasks.

A login or exit terminates the task 
execution. Consider if you should wait or 
continue with login. Check the task with 
the Task Monitor if needed.
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Fig. 16.2.2.-1 Status color is yellow, tasks are scheduled, but not executed

16.2.3. Red color
The red color, see Fig. 16.2.3.-1, indicates that a task is carried out at the moment. 
Consider if it is possible to wait for the task to finish or check with the Task Monitor 
to see what is being done at the moment, before you log in.

Fig. 16.2.3.-1 Status color is red, tasks are being performed 

Logging in to SMS 510 during red light means that the task executed is terminated, 
a login notification is shown as in Fig. 16.2.3.-2.

Fig. 16.2.3.-2 The dialog for logging in when a task is being executed

In the same way, when selecting exit in the SMS 510, the user will be informed that 
the task executed will be terminated, see Fig. 16.2.3.-3.

Fig. 16.2.3.-3 The dialog for closing when the Scheduler indicates activity

16.3. Task Monitor
The tasks in the Scheduler are monitored from the Task Monitor function, click 
Task Monitor, see Fig. 16.3.-1. 
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Fig. 16.3.-1 Starting the Task Monitor 

16.3.1. Task Monitor status list
The list in the Task Monitor shows the status of the tasks, see Fig. 16.3.-1. The Task 
Monitor Status List shows tasks running and waiting to be executed. When a task is 
finished, (callback received by the Scheduler), it is removed from the list.

Fig. 16.3.1.-1 List of tasks and corresponding status in the Task Monitor

In the following table, the columns and button in the Task Monitor, see  
Fig. 16.3.-1, are described.

Table 16.3.1-1 Task Monitor contents

Column Explanation
Task ID The number of the Scheduled Task in the Scheduler
Operation The tasks that have been executed are listed as well as operations 

concerning establishing the communication in regards to tasks.
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The Task Monitoring session is ended by pressing Close. 

16.3.1.1. Task with status waiting
Tasks in the Scheduler with status �waiting� are waiting for their turn to be 
performed and are started when there is a suitable occasion.

A task gets the status �waiting� as a result of the following:

� If the previous task needs more time than expected and it is of the type giving a 
callback to the Scheduler when finished, the next task to be started is set on the 
waiting list and is started when the callback signal has been received.

� When a user is logged on to SMS 510. The longer the user is logged on to SMS 
510, the more tasks get status �waiting�.

16.4. Removing of tasks with status waiting
It might be convenient to clear tasks with status �waiting�, in particular when there 
are many tasks in waiting mode.

Status The progress of the tasks.
Running means that the task is started but not finished (callback not 
received)
Waiting means that the time to be performed already has elapsed, but 
the task is waiting to start. 

Button
Close Close the Task Monitor

Table 16.3.1-1 Task Monitor contents

Waiting tasks are removed by temporarily taking the Scheduler 
function out of use (Enable Scheduler check box in the Scheduler 
window, see Fig. 15.5.-2). Pressing OK or Apply when the Enable 
Scheduler is in �off� mode, the tasks in waiting mode are removed. 
After this, you can take the Scheduler in use again, by clicking the 
Enable Scheduler check box

The Scheduled tasks that you have prepared in the Scheduler are not 
modified or deleted by the Enable Scheduler �on/off� operation.

 
Tasks in waiting mode are not removed by closing SMS 510 by exit.
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17. SMS Conversion Tool

This chapter describes how to import projects from SMS 010 to SMS 510.

17.1. Purpose
The purpose with the SMS Conversion Tool (SMSCT) is to import existing SMS 
010 application structures into the SMS 510 environment. Thereby the user can 
create new SMS 510 projects from existing SMS 010 applications, and view the 
summary report of operations. To reuse (import) applications made for SMS 010 
when upgrading to SMS 510, this SMSCT tool can be used. The original SMS 010 
application is not modified during the import procedure to SMS 510.

17.2. What is an SMS 010 application?
An SMS 010 application structure is an application containing five levels; 
Organization, Station, Object/Bay, Unit and Module and it is created by the SMS-
BASE program. The application has a name; e.g. DATA-EX. Another example of 
an SMS 010 application is C:\SMS\DATA-EX. The same names that have been used 
in the SMS 010 applications are also used in the imported project.

SMSCT also supports import of applications containing three or four levels (normal 
is five), which were possible to use in SPASET systems. 

17.3. Features
� Reusing of SMS 010 applications (SPACOM relays)
� Application tree browser and details
� Importing SMS 010 application structures to SMS 510 projects
� Import whole application or parts of it
� Skip empty elements at import
� Import report
� Import progress bar
� Support for several languages of the applications
� Setting data of relays converted to the SMS 510 project 
� Columns in the views can be resized to fit the contents
� Can select one organization out of several in an SMS 010 application to be 

imported to a project of its own. As default all organizations are imported

17.4. Limitations
The following limitations apply for SMSCT: 

� The units supported for import are relays from the SPACOM series of relays.
� The drives where the source application is to be imported and the destination 

project is to be produced are located on the hard disk where the SMS 510 is 
installed.
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� In case the SMS 010 application is on another disk, you can, before importing it 
by SMSCT, copy it to the same computer. This can be done by copying the 
application over the network, copying it to a floppy or compressing it to a ZIP file 
and then transferring it, using e.g. the AS Handler in SMS 010. Since the 
application is a stand-alone structure, it can be transferred to any location.

� In case you want to import a compressed SMS 010 application (*.ZIP), you have 
to decompress it before importing.

� The amount of relays that can be imported is limited to the maximum amount of 
relays that a project on SMS 510 can hold.

� A project used in SMS 510 can contain maximum 50 relays. Therefore, you 
should examine the SMS 010 application before importing it. You can use the 
Details... (see Fig. 17.8.2.-3) to check the amount of  "Unit" objects (= relays) in 
the SMS 010 application you want to import. In case you have more than 50 units 
in the application you intend to import, then you have to import portions of the 
application. Thus, via multiple import operations you create two or more separate 
projects out of the original. Use the Select button (see Fig. 17.10.-3), for partial 
import of selected branches of the SMS 010 application.

17.4.1. Import remarks
During the import, the following is automatically performed by SMSCT:

� Conversion of SACO 16D1B to SACO 16D2B
� Conversion of SPCD 3C2X to SPCD3C21, 3C22, 3C23
� If, for some reason, a relay is lacking some settings, i.e. parameters, these are 

completed during the conversion by default values
� The measuring transducer values in a SMS 010 application are given for each 

unit as primary and secondary values, plus the relay input value. Thus, if the 
transducer values have been set to 0, 1 or left empty these are ignored by the SMS 
Conversion Tool.

17.5. Abbreviations and terms
The abbreviations used in this chapter are described in the table below:

SMS 010 terms are mapped to SMS 510 terms as described in the table below:

Table 17.5.-1  Abbreviations

Abbreviation Full Text
SMSCT SMS Conversion Tool
Application SMS 010 Application
Project SMS 510 Project

Table 17.5.-2  SMS 010 and SMS 510 terminology

SMS 010 Term SMS 510 Term
Application Project
Application structure root level Level objects (views)
Organization level n/a
Station level n/a
Object/Bay level n/a
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17.6. Starting SMS Conversion Tool
The SMS Conversion Tool is started in the System Tools menu in SMS 510 by 
selecting the menu item SMS Conversion Tool, see Fig. 17.6.-1.

SyTo_SMSCT

Fig. 17.6.-1 Selecting SMS Conversion Tool in the System Tools menu

17.7. User interface
The main view of SMS Conversion Tool contains lists of applications both in SMS 
010 and applications that have been imported to SMS 510 projects.

SMSCT is divided into two sections; one for SMS 010 applications and one for SMS 
510. In the figure below, the SMS 010 applications and paths are the ones shown to 
the left:

Fig. 17.7.-1 The main view in the SMS Conversion Tool

Unit level Device objects
Module/Part of Unit level United in a single device object

Table 17.5.-2  SMS 010 and SMS 510 terminology
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The following table describes the fields in Fig. 17.7.-1.

17.8. Menus and toolbar
The following sections describe the Toolbar and the menus.

17.8.1. File menu
The File menu, see Fig. 17.8.1.-1, contains the menu item for the conversion of SMS 
010 applications to SMS 510 Projects and conversion reports as well as exit from the 
program.

Fig. 17.8.1.-1 File menu

Import

Toolbar entry:

This command opens the dialog containing the import options. The toolbar button 
and the menu item are enabled only when an application is selected in the SMS 010 
application list, which means that you have to select the application to be imported 
before you can start the import function. The Import function is described in Section 
17.10. Importing SMS 010 applications.

Import Report
This menu item shows the most recently performed import operation report.

Exit

Toolbar entry:

Exit and return to the SMS 510 Project Structure Navigator.

Table 17.7.-1  Fields in SMS Conversion Tool

Field Explanation
Path The path where the application or project is located 
Applications A list of the applications 
Project List of projects available to SMS 510
158



1MRS751267-MUM SMS 510

User�s Guide
17.8.2. Application menu
The Application menu items, see Fig. 17.8.2.-1, apply to the SMS 010 part of the 
SMS Conversion Tool view.

Fig. 17.8.2.-1 Application menu

Refresh
This menu item refreshes the list of applications.

Set Default Path
The path for location of SMS 010 applications is set back to the default path, e.g. 
C:\SMS\ in the Path: text box as in the figure below:

Fig. 17.8.2.-2 Path: text box with default SMS 010 application path

Details�
Select an application in the application list and then select Details�from the 
Application menu and a detail dialog pops up, see Fig. 17.8.2.-3. The same function 
can also be started by double clicking on an application in the application list.
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Fig. 17.8.2.-3 Details for an SMS 010 application

The following table describes the fields and buttons in Fig. 17.8.2.-3.

17.8.3. Project menu
The Project menu items, see Fig. 17.8.3.-1, applies to the SMS 510 part of the SMS 
Conversion Tool view.

Fig. 17.8.3.-1 Project menu

Table 17.8.2-1  Fields and buttons in the SMS 010 Application detail 
presentation

Field Explanation
Path: The path where the application or project is located
Source code page By means of the source code page selector you can select the 

proper code page in case you use another language than the 
default English

Destination code page Cannot be changed by the user
Button
Expand All Show the whole application tree
Select Has no function in this case, therefore disabled
Close Exit the details presentation
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Refresh
The Refresh menu item refreshes the list of SMS 510 projects that are in the projects 
list.

Set Default Path
The path for location of SMS 510 applications is set back to the default path e.g. 
C:\SMS510\Prj in the path text box as in Fig. 17.8.3.-2.

Fig. 17.8.3.-2 Path: text box with default path for SMS 510 projects

Details�
Select a project in the project list and then select Details� from the Project menu 
and a detail dialog pops up, see Fig. 17.8.3.-3. The same function can also be started 
by double clicking on a project in the project list.

Some options are disabled, while they are used when browsing applications for SMS 
010.

Fig. 17.8.3.-3 Browsing an SMS 510 project

The following table explains the fields and buttons in Fig. 17.8.3.-3.

Table 17.8.3-1 Fields and buttons in the SMS 510 Project detail presentation

Field Explanation
Path: The path where the project is located
Source code page Cannot be changed by the user
Destination code page Cannot be changed by the user

Button
Expand All Show the whole project tree
Select Has no function in this case, therefore disabled
Close Exit the details presentation
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17.8.4. Options menu

Options
The Toolbar Visible menu item, see Fig. 17.8.4.-1, toggles the presentation of the 
Toolbar in SMSCT.

Fig. 17.8.4.-1 Options menu

17.8.5. Help menu

About
The About menu item in Fig. 17.8.5.-1 presents the About dialog.

Fig. 17.8.5.-1 Help menu

17.9. Browsing for SMS 010 applications to import
Before you can start the import function, you have to select the application to be 
imported. This section describes how to select and browse application paths not 
available from the default C:\SMS\.

The applications are listed in the application list, see Fig. 17.9.-1, according to the 
path selected in the Path: text box. Therefore, what you need to know is the path 
where the applications are at, SMSCT detects the names of the applications.

Fig. 17.9.-1 The following applications were found in C:\SMS\

17.9.1. Select path
Click the arrow down button to the right of the Path: text box and the known paths 
are shown, see Fig. 17.9.1.-1.
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Fig. 17.9.1.-1 The list of paths containing SMS 010 applications known to 
SMSCT

Click the path you want to select and it is shown in the Path: text box. In case you 
have many SMS 010 installations, you get a scroll bar to the right, by which you can 
scroll through all paths in the list.

You can also type the path manually in the Path: text box or use the Select a directory 
function (explained as the next topic) to add a missing path. The paths listed in the 
Path: text box are remembered once they have been added to the path library.

17.9.2. Select a Directory
In case your SMS 010 application is found at another path than the default one, and 
this path is not included in the list, you can add it to the list by the Select a Directory 
function. In case you know the exact location, you can fill it in manually in the Path: 
text box, see the figure below:

Fig. 17.9.2.-1 Starting the browser by clicking the Select a Directory button

By clicking the Select a Directory button, you can start adding more paths, see 
Fig. 17.9.2.-2.
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Fig. 17.9.2.-2 Selecting a Directory from which to add SMS 010 application 
locations

The following table explains the menus and buttons in Fig. 17.9.2.-2.

You can add only one path per session, so you have to redo the procedure for every 
path you want to add.

Table 17.9.2-1 Menus and buttons in the Select a Directory function

Menu Explanation
History The recently visited paths are shown 
Special Home <Ctrl><H>

Mark <Ctrl><H>
Unmark

View By name (alphabetical)
By Date (according to date)
By Modified (according to date of modification)

Volumes The volumes available on the PC; e.g. A, C, D
Note! Normally network volumes cannot be accessed. In that case you first 
have to copy the SMS 010 application to the hard drive of the PC and then 
add these to the list and convert.

Button
Arrow left Go one directory back from the selected one
Arrow right Go one directory up from the selected one
Select Add the path marked to the Path: list

Note! Pressing <Enter> is the same as <Select>
Open Go one directory up, same function as arrow right
Cancel Exit the function without adding any paths

Note! Pressing <Esc> is the same as <Cancel>
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17.10. Importing SMS 010 applications
Once you have selected an application in the application list, you can import it, see 
Fig. 17.10.-1 below:

Fig. 17.10.-1 An application is selected in the application list

The import function is started by selecting Import in the File menu or by clicking 
the Import button:

The Import Options dialog is presented in Fig. 17.10.-3.

Fig. 17.10.-2 The project importing was stopped because of too many objects in the 
application
165



1MRS751267-MUM

User�s Guide

SMS 510
ImportingApl

Fig. 17.10.-3 Import Options shown

The following table explains the fields and buttons in Fig. 17.10.-3.

Table 17.10.-1 Fields and buttons in Import Options

Field/Button Explanation
SMS 010 application path The path where the application to be imported is located
SMS 010 application name Name of the application
Application root level
Application root node This field is empty by default, which means that the whole 

application is converted. By using the Select button, you can 
select a part of the application and only that part of the 
application structure will be imported 

SMS 510 project path Where the SMS 510 projects are located, changed by SMS 
510 Path: text box 

SMS 510 project name The project name that the imported application is getting in 
SMS 510.

Source code page Select the code page that have been used for the application.
Destination code page Cannot be set by the user, the program selects1252 Windows 

US English or 1251 Cyrillic
Skip empty objects 
(check box)

The tool converts only those organizations, stations, bays and 
units, for which at least 1 child unit or module would be 
transferred to the new project (that is, object type was 
recognized).

Include relay names into 
object names 
(check box)

When check box is selected, the relay name (for example 
SPAJ 140) is included in the object name of the converted 
object. The name can then be seen in the tree structure (for 
example �SPAJ 140 Phase and neutral overcurrent relay�).
When the check box  is cleared, only the relay description can 
be seen (for example "Phase and neutral overcurrent relay").

Select You can select parts (organization or station) of the structure 
to be imported. See Fig. 17.10.1.-1 as an example.
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17.10.1. Select Application Root Node

Fig. 17.10.1.-1 Selecting a node from which to import

The following table describes the fields and buttons in Fig. 17.10.1.-1.

17.10.2. Starting the import operation
By clicking the Import button in Fig. 17.10.-3, the import operation starts. In case 
the SMS 510 project already exists, a warning is given, see Fig. 17.10.2.-1.

Import The import starts according to the conditions given
Cancel Exit without importing

Table 17.10.-1 Fields and buttons in Import Options

Field/Button Explanation

Table 17.10.1-1 Fields and buttons in Select Application Root Node for Import

Field Explanation
Path The path where the application to be imported is located
Source code page Select the code page that has been used for the application to 

present the texts in the right way.
Destination code page Cannot be set by the user, the programs selects 1252 Windows US 

English or 1251 Cyrillic
Statistics (list) The amount of elements on different levels in the application

Button
Expand all Show the expanded tree structure
Select Select the part of the application that you intend to convert, can be 

any station or organization within the application. The button is 
disabled on other levels in the application

Close Exit the function
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Fig. 17.10.2.-1 Warning saying that the specified project already exists

The import operation progress can be followed on-line as shown in Fig. 17.10.2.-2 
below:

Fig. 17.10.2.-2 Progress of the import

The second row shows the actual object being processed (in this case a SPCJ 4D29 
module), while the third row presents the corresponding path to this object as found 
in the source SMS 010 application.

The entire operation of scanning through the source application to perform the 
import of individual objects is shown in percentage on the fourth row. This is 
illustrated by the first progress bar.

The second progress bar is run when the settings of relay modules are imported.

17.10.3. Import Summary Report
After the import has been carried out, a summary report is presented. There are two 
ways of presenting it; as a tree view in Fig. 17.10.3.-2 and as a list view in 
Fig. 17.10.3.-3. The idea is to set focus on objects that for some reason have not been 
imported. For instance, REPORT and DR-COM stations are of no use to SMS 510; 
therefore, they are not imported. The whole sub-tree, where all objects have been 
successfully imported shows a message �The object is converted successfully�, see 
Fig. 17.10.3.-1.
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Fig. 17.10.3.-1 Station Wasa1 and all objects within it successfully converted

The whole imported application is shown in the SMS 510 part of SMSCT, see 
Fig. 17.7.-1.

When you have analysed the report, you can close it with the Close button. The 
report can also be saved by the Save button for later analysis. You should save it as 
a *.TXT file. You can recall the latest import report with the Import Report menu 
item in the File menu, but import reports made earlier have to be opened with e.g. 
Notepad (provided that you have saved them).

Fig. 17.10.3.-2 Import Summary Report as Tree View
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Fig. 17.10.3.-3 Import Summary Report as List View

17.10.3.1. Import summary messages
The following table explains the import summary messages.

17.11. Browsing SMS 510 projects
After the import of the projects, the project can also be browsed in the SMS 510 
project list. Select a project in the list and select Details from the Projects Menu or 
double click the item and the details window is opened.

17.12. Modifying imported projects
When you have imported an SMS 010 application to an SMS 510 project, you can 
modify the project the same way as a project that has been created by the tools in 
SMS 510. You just have to select the project to be active in SMS 510 (see the next 
section).

Table 17.10.3.1-1 Import summary messages

Message Explanation
The object is 
converted

Conversion successful

Object type could 
not be mapped

The element in the application could not be mapped. Reason for this 
can be that it is an unknown element to SMS 510 Project Manager, 
e.g. a Manual Entry module, or that it has meaning only for SMS 010 
like REPORT and DR-COM station settings.

The object is not 
converted

The object was not converted, and neither was any possible child 
elements on the next level.

None of child 
objects converted

The objects within the element were not converted (only the previous 
level designation), e.g. REPORT station is converted but not the 
REPORT station configuration.

Duplicate title 
resolved

Means that the object title was not unique within the application sub-
tree being imported. Therefore, a unique numeric suffix is added to 
such titles. For example, if the source SMS 010 application contains 
three objects "SPAC 535 C Feeder terminal", they would be named 
"Feeder terminal 1", "Feeder terminal 2" and "Feeder terminal 3" in the 
new project. An information message notifies the user that the object 
title was changed.
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17.13. Taking the imported project into use in SMS 510
Exit the SMSCT function. Select Open from the File menu and a dialog for opening 
project is opened, see Fig. 17.13.-1. More details about opening projects can be 
found in Section 4.7.1. File Open.

Fig. 17.13.-1 The list of projects with description

Select the project you intend to use and click Open.

Check that the system configuration is OK, see Fig. 3.11.-1. Furthermore, you 
should add and configure relays that for some reason have not been imported to the 
project.
171



172



1MRS751267-MUM SMS 510

User�s Guide
18. Index

A
Abbreviations ........................................................................................... 12
Application Events

N/A .....................................................................................................98
Application Menu � SMS Conversion Tool

Details� ........................................................................................... 159
Refresh .............................................................................................. 159
Set Default Path ................................................................................ 159

Application State Monitoring
Application memory pool supervision ............................................... 83
Application state ................................................................................. 83

Application State Supervision
Application memory pool supervision ............................................... 90
Application state ................................................................................. 90

Authorization Level
Control (1) ........................................................................................ 133
Engineering (2) ................................................................................. 133
Reserved (3) ...................................................................................... 133
Reserved (4) ...................................................................................... 133
System manager (5) ..........................................................................133
View (0) ............................................................................................ 133

Automatic Monitor Logoff .....................................................................129
Disable .............................................................................................. 130
Enable ............................................................................................... 130

C
CAP 2/316 Tool ........................................................................................ 21
Clear All Events ..................................................................................... 100
COM 610 .................................................................................................. 79

Communication setting .......................................................................81
Insertion .............................................................................................. 80
Supported protocols ............................................................................79

Common Events
Predefined Events ............................................................................... 94

Configuring Objects
Procedure ............................................................................................ 33
REB 500 Relays ................................................................................. 39
RED 500 Relays ................................................................................. 34
REx 216/316 Relays ...........................................................................38
REx 5xx Relays .................................................................................. 39
SPACOM Relays ................................................................................ 36

Corrective Measure - SSS
Application State Supervision ............................................................ 90
Icon Dimmed ...................................................................................... 88
Icon No ............................................................................................... 89
173



1MRS751267-MUM

User�s Guide

SMS 510
Icon NoConf ....................................................................................... 88
Icon Red ............................................................................................. 88
Icon Stop ............................................................................................ 89
Line Comminication Supervision ...................................................... 90
OS Events Supervision ....................................................................... 91

D
Definitions � SMS Conversion Tool

Application ....................................................................................... 156
Project .............................................................................................. 156

Details � SMS Conversion Tool
Close ................................................................................................. 160
Destination code page ...................................................................... 160
Expand All ....................................................................................... 160
Path ................................................................................................... 160
Select ................................................................................................ 160
Source code page .............................................................................. 160

Dial-Up (SPA)
Configuring ...................................................................................... 122
Modem Command Initialization String ........................................... 124
System Configuration ....................................................................... 123
System Configuration for Modem ................................................... 123

Disable
Automatic Logoff ............................................................................. 130
Scheduler .......................................................................................... 143
System Self Supervision .................................................................... 85
Time Synchronization (SPA) ........................................................... 128
User Management ............................................................................ 133

Disturbance Draw Tool ............................................................................ 22
Disturbance evaluation tools .................................................................... 22
Disturbance recording tools ..................................................................... 21
DR-Collector Tool ................................................................................... 21

E
Edit Menu - Project Structure Navigator

Delete Object ...................................................................................... 53
Insert Object ....................................................................................... 51
Object Properties ................................................................................ 53

Enable
Automatic Logoff ............................................................................. 130
Scheduler .......................................................................................... 143
System Self Supervision .................................................................... 84
Time Synchronization (SPA) ........................................................... 128
User Mangement .............................................................................. 133

Example Figure
Activating Remote Connection ........................................................ 110
Common Events View ....................................................................... 95
174



1MRS751267-MUM SMS 510

User�s Guide
Configuring General Object Attributes .............................................. 34
Configuring Serial Ports Project ......................................................... 32
Disabling System Self Supervision .................................................... 85
Enabling Authorization Mechanism ................................................. 134
Enabling Automatic Logoff .............................................................. 130
Enabling System Self Supervision ..................................................... 85
Enabling Task Scheduling ................................................................ 143
Enabling Time Synchronization (SPA) ............................................ 129
Entering User View Data ....................................................................40
Example Tasks Added to Scheduler ................................................. 149
General Object Attributes for REF54X .............................................. 54
Launching Tools ................................................................................. 42
Login to SMS 510 .............................................................................. 48
Open Project ............................................................................... 49, 171
Quick Start Project View ....................................................................31
REF54X Configuration ......................................................................35
Remote Connection Dial-Up (SPA) Settings ................................... 123
Remote Connection LAN to COM 500 or SYS 500 Settings .......... 116
Remote Connection LAN to SMS 510 Settings ............................... 116
Remote Connection Remote/RAS to SMS 510 Settings .................. 119
Scheduled Tasks in Scheduler .......................................................... 141
Setting Time/Date ............................................................................. 127
SMS Conversion Tool View ............................................................ 157
SMS Conversion Tool, Import View ................................................ 166
SPACOM Address Configuration ...................................................... 37
SPACOM Configuration ....................................................................37
System Events View ...........................................................................96
System Self Supervision Alert ............................................................ 86
Task Monitor View ...........................................................................153
Task Scheduling, Browsing for Tools .............................................. 147
Traffic Light, Green Color ............................................................... 151
Traffic Light, Red Color ...................................................................152
Traffic Light, Yellow Color ............................................................. 152
User Management, Adding User ...................................................... 136
User Management, Changing User Password .................................. 138
User Management, Removing User ................................................. 137

Exit
Project Structure Navigator ................................................................ 50
Remote Connection ..........................................................................112
SMS Conversion Tool ......................................................................158
Supervision Log Viewer ...................................................................100
System Self Supervision .....................................................................86
Task Monitoring ............................................................................... 154
Task Scheduler ................................................................................. 142
Time/Date Settings Tool ...................................................................128
User Management ............................................................................. 136
175



1MRS751267-MUM

User�s Guide

SMS 510
F
File Menu � SMS Conversion Tool

Exit ................................................................................................... 158
Import ............................................................................................... 158
Import Report ................................................................................... 158

Filter Menu � Supervision Log Viewer
Common System Message Log Type .............................................. 105
Log Types ......................................................................................... 104
Operating System Events ................................................................. 103
Supervision Log Profile ................................................................... 104
Unknown Process Object Log .......................................................... 104

Floppy disks
Importing projects from multiple floppy disks .................................. 66

G
Gateway object types (COM 610) ............................................................ 79
Graphical I/O Setting Too ........................................................................ 21
Green Color

Traffic Light ..................................................................................... 151

H
Help Menu � SMS Conversion Tool

About ................................................................................................ 162
HV/Collect Tool ....................................................................................... 21

I
Import Option - SMS Conversion Tool

Application root level ....................................................................... 166
Application root node ....................................................................... 166
Cancel ............................................................................................... 167
Destination code page ...................................................................... 166
Import ............................................................................................... 167
Select ................................................................................................ 166
Skip empty objects ........................................................................... 166
SMS 010 application name .............................................................. 166
SMS 010 application path ................................................................ 166
SMS 510 project name ..................................................................... 166
SMS 510 project path ....................................................................... 166
Source code page .............................................................................. 166

Import Summary Messages - SMS Conversion Tool
Duplicate title resolved .................................................................... 170
None of child objects converted ....................................................... 170
Object type could not be mapped ..................................................... 170
The object is converted .................................................................... 170
The object is not converted .............................................................. 170

Import Summary Report - SMS Conversion Tool
List View .......................................................................................... 168
Tree View ......................................................................................... 168
176



1MRS751267-MUM SMS 510

User�s Guide
Introduction
Project Structure Navigator ................................................................ 17
SMS 510 Applications ........................................................................17
SMS 510 Base System ........................................................................17
SMS 510 Functions and Tools ........................................................... 17
SMS 510 Operational Features ........................................................... 16
SMS 510 Supported Communication Protocols ................................. 17
SMS 510 User Interface .....................................................................17
Supported LON cards .........................................................................17

Introduction � Monitoring Functions
Relay Setting Tools ............................................................................20
Supervision Log Viewer .....................................................................19
System Self Supervision .....................................................................19
Task Monitor ...................................................................................... 19

Introduction � Project Handling
Organize Projects ................................................................................ 17
SMS Conversion Tool ........................................................................18

Introduction � Relay Setting Tools
CAP 2/316 Tool .................................................................................. 20
PST Tool ............................................................................................. 20
REBWIN HMI Tool ...........................................................................20
RED Relay Tool ................................................................................. 20
SPA Relay Tool .................................................................................. 20

Introduction � System Configuration
Device Level Communication Settings .............................................. 18
Plant Structure Settings ......................................................................18
Remote Connections ...........................................................................19
System Configuration Tool ................................................................ 18
System Configuration Tool � Automatic Logoff ............................... 18
System Configuration Tool � Basic Communciation Settings ........... 18
System Configuration Tool � Task Scheduling .................................. 18
Time/Date ........................................................................................... 19
User Management ............................................................................... 19

K
Kernel

Starting the MicroSCADA service ............................................... 25, 48
Stopping the MicroSCADA service ................................................... 50

L
LAN

Checking Connection .......................................................................117
Configuring ....................................................................................... 114
Examples .................................................................................. 115, 116

Launching Tools
REB 500 Tools ................................................................................... 43
RED 500 Tools ................................................................................... 43
177



1MRS751267-MUM

User�s Guide

SMS 510
REx 216/316 Tools ............................................................................ 43
REx 5xx Tools .................................................................................... 44
SPACOM Tools ................................................................................. 43

Line Communication
Devices ............................................................................................... 83
LON Channels .................................................................................... 83
Serial Ports ......................................................................................... 83

Line Communication Supervision
Devices ............................................................................................... 90
Serial ports ......................................................................................... 90

Log Menu � Supervision Log Viewer
Application Events from the Operating System ................................. 99
Common System Events .................................................................... 99
Security Events from the Operating ................................................... 99
System Events from the Operating System ........................................ 99

Login
SMS 510 ............................................................................................. 48

Login Mechanism
Disable .............................................................................................. 133
Enable ............................................................................................... 133

LON
Time Synchronization ...................................................................... 128

M
Master Design View

Insertion of Objects ............................................................................ 51
Master protocol ........................................................................................ 79
Menus � Project Structure Navigator

Edit Menu ........................................................................................... 50
File Menu ........................................................................................... 49
Help Menu .......................................................................................... 59
System Tools Menu ............................................................................ 58
Views Menu ....................................................................................... 55

Menus � SMS Conversion Tool
File Menu ......................................................................................... 158
Help Menu ........................................................................................ 162
Options Menu ................................................................................... 162
Project Menu .................................................................................... 160

Menus � Supervision Log Viewer
Filter Menu ....................................................................................... 102
Log Menu ........................................................................................... 99
Options Menu ................................................................................... 105
View Menu ....................................................................................... 100

Menus � Time/Date Settings
Help Menu ........................................................................................ 128
Settings Menu ................................................................................... 128
178



1MRS751267-MUM SMS 510

User�s Guide
Menus � User Management
File Menu .......................................................................................... 135
Help Menu ........................................................................................ 138
Tools Menu ....................................................................................... 136
View Menu ....................................................................................... 136

MicroSCADA Network Control system
Plant structure compatibility ............................................................... 72

MicroSCADA service
Starting the MicroSCADA service ............................................... 25, 48
Stopping the MicroSCADA service ................................................... 50

MicroSCADA Service Access manager ................................................... 22
MicroSCADA user settings for remote connections .............................. 130
Moving Objects ........................................................................................ 31

O
Object Type Groups

Gateway .............................................................................................. 46
Plant Structure .................................................................................... 46
Protection & Control ..........................................................................46
SMS 510 Object Type Groups ........................................................... 46
User Structure ..................................................................................... 46

Object Types
Compound Object Types ....................................................................46
Device Level Object Types ................................................................ 46
Level Object Types ............................................................................. 46
SMS 510 Object Types .......................................................................46
User Structure Object Type ................................................................ 77

Objects
Basic Object Properties ......................................................................51
Configure objects ................................................................................ 55
Deleting Objects ................................................................................. 53
General Object Attributes ...................................................................54
Inserting Objects ................................................................................. 51
Insertion of Level Objects in the User Views .................................... 53
Insertion of Objects in the Master Design View ................................ 51
Insertion of Objects in the User Views ............................................... 52
Move objects ...................................................................................... 55
Procedure for Moving Objects ........................................................... 55
Save changes to objects' general attributes ......................................... 54
View/change objects' name ........................................................ 54, 164
View/change objects' title ...................................................................54
Viewing object properties ...................................................................53

Operating System
Event Viewer ...................................................................................... 91
Operating System events from the operating system ......................... 83
Security events from the operating system ......................................... 83
System events from the operating system .......................................... 83
179



1MRS751267-MUM

User�s Guide

SMS 510
Operating System Events
AUDIT FAILURE ........................................................................... 104
AUDIT SUCCESS ........................................................................... 104
ERROR ............................................................................................ 104
Handler State .................................................................................... 104
INFORMATION .............................................................................. 104
Settings ............................................................................................. 104
WARNING ...................................................................................... 104

Operating System Events Supervision
Application events .............................................................................. 91
Security events ................................................................................... 91
System events ..................................................................................... 91

Options Menu - SMS Conversion Tool
Tool bar Visible ................................................................................ 162

Options Menu � Supervision Log Viewer
Background Color ............................................................................ 106
Configure Font ................................................................................. 106
Default Colors .................................................................................. 106
Default Font ..................................................................................... 107
Definitions ........................................................................................ 105
Enlarge Font ..................................................................................... 107
Foreground Color ............................................................................. 106
Log Settings ..................................................................................... 107
Reduce Font ..................................................................................... 107
Toolbar Visible ................................................................................. 106

P
Password

Change User Management Password ............................................... 138
LAN and Remote/RAS .................................................................... 113

Plant Structure Object Attributes
Field Length ....................................................................................... 72
Level Description ............................................................................... 72
Level Id .............................................................................................. 72

Plant Structure Object Types
Bay Objects ........................................................................................ 74
Overview ............................................................................................ 73
Station objects .................................................................................... 73

Plant Structure Objects
Insertion Constraints .......................................................................... 73
Modifiable Attributes ......................................................................... 71

Plant Structure Settings Tool
Overview ............................................................................................ 71
Starting Tool ....................................................................................... 71

Project Export/Import Tool
Accessing Network Projects ............................................................... 63
Copying projects between network computers .................................. 63
180



1MRS751267-MUM SMS 510

User�s Guide
Creating Projects ................................................................................ 68
Deleting projects ................................................................................. 67
Duplicating projects ............................................................................68
Exporting projects .............................................................................. 65
General project properties .................................................................. 67
Importing projects .............................................................................. 66
Overview ............................................................................................ 61
Selecting projects ................................................................................ 62
Set as Local ......................................................................................... 68
Starting Tool ....................................................................................... 61
Storage location for temporary projects ............................................. 65

Project Menu � SMS Conversion Tool
Details� ........................................................................................... 161
Refresh .............................................................................................. 161
Set Default Path ................................................................................ 161

Project Structure Navigator
Alerts .................................................................................................. 47
Caption bar ......................................................................................... 47
Changing/Viewing Project Properties ................................................ 57
Closing the Current Project ................................................................ 50
Customizable System Tools Menu ..................................................... 59
Deleting Objects from Project ............................................................ 53
Deleting User Views ...........................................................................57
Edit Menu ........................................................................................... 50
Entering .............................................................................................. 48
Exiting the session .............................................................................. 50
File Menu ............................................................................................ 49
Help Menu .......................................................................................... 59
Inserting Objects to Project ................................................................ 51
List of Views ...................................................................................... 58
Menu bar ............................................................................................. 47
Moving Objects .................................................................................. 55
Object tools list ................................................................................... 47
Opening Projects ................................................................................ 49
Overview ............................................................................................ 45
Projects ............................................................................................... 45
ROOT ................................................................................................. 58
Status bar ............................................................................................ 47
Structure ............................................................................................. 47
System Tools Menu ............................................................................58
Tool bar .............................................................................................. 47
User Interface ............................................................................... 46, 47
User Interface Elements .....................................................................47
Viewing Object Properties ................................................................. 53
Views Menu ........................................................................................ 55

Project System Configuration
Modem Connection ..........................................................................123
181



1MRS751267-MUM

User�s Guide

SMS 510
Projects
Accessing Network Projects ............................................................... 63
Built-in Master Design View ............................................................. 45
Changing/Viewing Project Properties ................................................ 57
Closing the Current Project ................................................................ 50
Copying projects between network computers .................................. 63
Creating Projects ................................................................................ 68
Deleting Objects from Project ............................................................ 53
Deleting projects ................................................................................ 67
Duplicating projects ........................................................................... 68
Exporting projects .............................................................................. 65
General project properties .................................................................. 67
Importing projects .............................................................................. 66
Importing projects from multiple floppy disks .................................. 66
Inserting Objects to Project ................................................................ 51
Maximum number of projects ............................................................ 45
Opening Projects ................................................................................ 49
Overview ............................................................................................ 45
Overview of project views ................................................................. 45
Plant Structure Attributes ................................................................... 71
Procedure for Moving Objects ........................................................... 55
Project list ........................................................................................... 62
Project's system configuration ............................................................ 64
Selecting projects in the Project Export/Import Tool ........................ 62
Set as Local ........................................................................................ 68
Storage location for temporary projects ............................................. 65
Tool for Project Management ............................................................ 61
Viewing/Changing Object Attributes ................................................. 54

Q
Quick Start

Apl Utils� ......................................................................................... 36
Configuring Objects ........................................................................... 33
Configuring REB 500 Objects ........................................................... 39
Configuring RED 500 Objects ........................................................... 34
Configuring REx 216/316 Objects ..................................................... 38
Configuring REx 5xx Objects ............................................................ 39
Configuring SPACOM Objects .......................................................... 36
Creating User Views .......................................................................... 40
Example .............................................................................................. 23
Insertion of Objects ............................................................................ 25
Launching Object Tools ..................................................................... 42
Launching REB 500 Tools ................................................................. 43
Launching RED 500 Tools ................................................................. 43
Launching REx 216/316 Tools .......................................................... 43
Launching REx 5xx Tools ................................................................. 44
Launching SPACOM Tools ............................................................... 43
182



1MRS751267-MUM SMS 510

User�s Guide
Making System Configuration ........................................................... 32
Moving Objects .................................................................................. 31
Relay Configuration Procedure .......................................................... 33
SOST Project ...................................................................................... 24
Uploading of Application Configuration for RED 500 Objects ......... 36

R
Red Color

Traffic Light ..................................................................................... 152
Remote Connections

Activating a Remote Connection ...................................................... 110
Adding .............................................................................................. 114
Application Areas � Dial-Up (SPA) ................................................. 110
Application Areas � LAN and Remote/RAS .................................... 109
Checking LAN Connection .............................................................. 117
Closing a Remote Connection .......................................................... 112
Configuring ....................................................................................... 114
Configuring Dial-Up (SPA) ............................................................. 122
Configuring LAN ............................................................................. 114
Configuring Remote/RAS ................................................................ 117
Connection Status ............................................................................. 111
Deleting ............................................................................................ 114
Dial-Up (SPA) .................................................................................. 109
Features ............................................................................................. 109
Features � Dial-Up (SPA) ................................................................ 110
Features � LAN and Remote/RAS ................................................... 109
Initial Steps ....................................................................................... 113
LAN Examples ......................................................................... 115, 116
LAN over a local network ................................................................ 109
Modifying ......................................................................................... 114
Overview .......................................................................................... 109
Password and Access for LAN and Remote/RAS ............................ 113
Preparing ........................................................................................... 113
Remote Task Monitoring .................................................................. 111
Remote/RAS ..................................................................................... 109
Remote/RAS Activation ...................................................................111
Remote/RAS Example ......................................................................119

Remote/RAS
Configuring ....................................................................................... 117
Example ............................................................................................ 119

S
Security Events

N/A .....................................................................................................97
Select Application Root Node - SMS Conversion Tool

Close ................................................................................................. 167
Destination code page .......................................................................167
183



1MRS751267-MUM

User�s Guide

SMS 510
Expand all ......................................................................................... 167
Path ................................................................................................... 167
Select ................................................................................................ 167
Source code page .............................................................................. 167
Statistics ........................................................................................... 167

Select Directory - SMS Conversion Tool
Arrow left ......................................................................................... 164
Arrow right ....................................................................................... 164
Cancel ............................................................................................... 164
History .............................................................................................. 164
Open ................................................................................................. 164
Path text box ..................................................................................... 163
Select ................................................................................................ 164
Special .............................................................................................. 164
View ................................................................................................. 164
Volumes ........................................................................................... 164

Select Path � SMS Conversion Tool
Path text box ..................................................................................... 162

Slave protocol ........................................................................................... 79
SMS 010 Application List

Application List ................................................................................ 162
SMS 010 Application Structure

Module ............................................................................................. 155
Object/Bay ........................................................................................ 155
Organization ..................................................................................... 155
Station .............................................................................................. 155
Unit ................................................................................................... 155

SMS 010 Terms
Application ....................................................................................... 156
Application structure root level ........................................................ 156
Module/Part of Unit level ................................................................. 157
Object/Bay level ............................................................................... 156
Organization level ............................................................................ 156
Station level ...................................................................................... 156
Unit level .......................................................................................... 157

SMS 010/510
Project .............................................................................................. 158

SMS 010/510 Field
Applications ..................................................................................... 158
Path ................................................................................................... 158

SMS 510
Applications ....................................................................................... 17
Base system ........................................................................................ 17
Contents of Manual ............................................................................ 15
Documentation ................................................................................... 15
Documentation Navigation ................................................................ 15
Exit ............................................................................................... 25, 50
184



1MRS751267-MUM SMS 510

User�s Guide
Introduction ........................................................................................ 15
Login ................................................................................................... 48
Login Window .................................................................................... 48
Multiple instances not allowed ........................................................... 49
Operational Features ...........................................................................16
Requested product information when contacting your local support .59
Start .....................................................................................................25
Starting SMS 510 ............................................................................... 48
Starting the MicroSCADA service ..................................................... 25
Stopping the MicroSCADA service ................................................... 50
Substation Monitoring System ........................................................... 15
Supported communication protocols .................................................. 17
Supported LON communication cards ............................................... 17
User Interface ..................................................................................... 17
Viewing Product Version Information ............................................... 59

SMS 510 Introduction
Disturbance Recordings Tools ........................................................... 21
Functions and Tools ...........................................................................17
Monitoring Functions .........................................................................19
Project Handling ................................................................................. 17
Project Structure Navigator ................................................................ 17
Relay Setting Tools ............................................................................20
System Configuration .........................................................................18

SMS Conversion Tool
Abbreviations ................................................................................... 156
File Menu .......................................................................................... 158
Help Menu ........................................................................................ 162
Import Operation .............................................................................. 165
Import Remarks ................................................................................ 156
Import Report ................................................................................... 158
Import Summary ............................................................................... 168
Limitations ........................................................................................ 155
Options Menu ................................................................................... 162
Overview .......................................................................................... 155
Project Menu .................................................................................... 160
Start Tool .......................................................................................... 157
Starting Import Operation ................................................................. 167
User Interface ................................................................................... 157

SOST Project ............................................................................................ 24
SPA

Time Synchronization ......................................................................128
SPA Terminal Emulator ...........................................................................22
SPTO Configuration Tool ........................................................................21
Start

Open Project Export/Import Tool ....................................................... 61
Open System Self Supervision ........................................................... 85
Open Task Scheduler ........................................................................140
185



1MRS751267-MUM

User�s Guide

SMS 510
Open User Management ................................................................... 133
Project Structure Navigator ................................................................ 48
SMS 510 ............................................................................................. 48
SMS Conversion Tool ...................................................................... 157
Supervision Log Viewer .................................................................... 98
Task Monitor .................................................................................... 152
Time Synchronization (SPA) ........................................................... 128
Time/Date Settings Tool .................................................................. 127

Stop
Time Synchronization (SPA) ........................................................... 128

Supervision Log Profile
Cancel ............................................................................................... 105
Load New� ..................................................................................... 105
OK .................................................................................................... 105
Profile Settings ................................................................................. 105
Save As� ......................................................................................... 105

Supervision Log Viewer
Application Events ............................................................................. 97
Common Events ................................................................................. 94
Device ................................................................................................ 94
Engineers and after sales support engineers ....................................... 93
Event Types ........................................................................................ 95
Events ................................................................................................. 93
Exit ................................................................................................... 100
Filter Menu ....................................................................................... 102
Filters .................................................................................................. 93
Glossary .............................................................................................. 94
Help Menu ........................................................................................ 108
Log Entries ......................................................................................... 93
Log Menu ........................................................................................... 99
Maintenance people ............................................................................ 93
MicroSCADA .................................................................................... 94
NET .................................................................................................... 94
Net Line .............................................................................................. 94
Operating System Based Events ........................................................ 95
Operators ............................................................................................ 93
Options Menu ................................................................................... 105
Overview ............................................................................................ 93
Running .............................................................................................. 94
Security Events ................................................................................... 97
Start Viewer ....................................................................................... 98
Station ................................................................................................ 94
Suspended .......................................................................................... 94
System Events .................................................................................... 95
Toolbar and Menus ............................................................................ 98
Toolbar buttons .................................................................................. 98
Updating ............................................................................................. 93
186



1MRS751267-MUM SMS 510

User�s Guide
System Configuration ............................................................................... 32
System Events

N/A .....................................................................................................97
System Self Supervision .........................................................................130

Alert .................................................................................................... 87
Application State Supervision ............................................................ 89
Enabling SSS ...................................................................................... 84
Exit .....................................................................................................86
Line Communication Supervision ...................................................... 90
Object Status Representation .............................................................. 86
Open from Alert message ...................................................................85
Open from Views Menu .....................................................................86
Overview ............................................................................................ 83
Project ................................................................................................. 84
Status Code ......................................................................................... 87
Status Icons ......................................................................................... 87
Status Information .............................................................................. 86
Status Text .......................................................................................... 87
Stopping SSS ...................................................................................... 85
Viewing .............................................................................................. 85

System Self Supervision Status Icons
Icon Dimmed ...................................................................................... 88
Icon No ............................................................................................... 89
Icon NoConf ....................................................................................... 88
Icon Not OK ....................................................................................... 87
Icon OK .............................................................................................. 87
Icon Stop ............................................................................................. 89

System Tools
Customizing ........................................................................................ 59

T
Task Monitoring

Colors ............................................................................................... 151
Green Color ...................................................................................... 151
Open ................................................................................................. 152
Overview .......................................................................................... 151
Red Color .......................................................................................... 152
Removing Waiting Task ...................................................................154
Status List ......................................................................................... 153
Traffic Light ............................................................................. 151, 152
Waiting Task .................................................................................... 154
Yellow Color .................................................................................... 151

Task Scheduling
Adding Predefined Tool ...................................................................145
Adding Tasks .................................................................................... 142
Adding User Defined Tool ............................................................... 146
Callback Function ............................................................................. 142
187



1MRS751267-MUM

User�s Guide

SMS 510
Example .................................................................................... 141, 149
Open Scheduler ................................................................................ 140
Overview .......................................................................................... 139
Running Tasks .................................................................................. 139
Stopping Tasks ................................................................................. 140
Task Types ....................................................................................... 142
Tool Arguments ............................................................................... 149
Tool Recommendation ..................................................................... 142
Uploading Disturbance Recordings ................................................. 149

Time Synchronization
LON .................................................................................................. 128
SPA .................................................................................................. 128
Starting (SPA) .................................................................................. 128
Stopping (SPA) ................................................................................ 128

Time/Date Settings ................................................................................. 127
Help Menu ........................................................................................ 128
Open Tool ......................................................................................... 127
Settings Menu ................................................................................... 128

Traffic Light
Green Color ...................................................................................... 151
Red Color ......................................................................................... 152
Yellow Color .................................................................................... 151

U
Universal Naming Convention

Specifying paths in (UNC) format ..................................................... 63
User Defined Tool

Arguments ........................................................................................ 149
User Interface � User Management

Authorization group ......................................................................... 135
Authorization level ........................................................................... 135
Caption bar ....................................................................................... 134
Disable authorization mechanism .................................................... 135
Level for selected row ...................................................................... 135
Menu bar .......................................................................................... 134
Tool bar ............................................................................................ 135
User .................................................................................................. 135
User Language .................................................................................. 135

User Management
Add Group ........................................................................................ 137
Add User .......................................................................................... 136
Authorization Groups ....................................................................... 133
Authorization Levels ........................................................................ 133
Change Password ............................................................................. 138
Disable .............................................................................................. 134
Enable ............................................................................................... 133
File Menu ......................................................................................... 135
188



1MRS751267-MUM SMS 510

User�s Guide
Help Menu ........................................................................................ 138
Overview .......................................................................................... 133
Remove Group .................................................................................. 138
Remove User .................................................................................... 137
Start Tool .......................................................................................... 133
Tools Menu ....................................................................................... 136
User Interface ................................................................................... 134
View Menu ....................................................................................... 136

User Structure Object Types
Overview ............................................................................................ 77
Usability In Project Views .................................................................. 77

User Views
Insertion of Objects ............................................................................52

User Views � Project Structure Navigator
Insertion of Level objects ...................................................................53

V
View Menu � Supervision Log Viewer

All Events ......................................................................................... 100
Details ............................................................................................... 101
Newest First ...................................................................................... 101
Next Page .......................................................................................... 102
Oldest First ....................................................................................... 101
Previous Page ................................................................................... 102
Refresh .............................................................................................. 102
Use Event Filter ................................................................................ 101

Views � Project Structure Navigator
Deleting User Views ...........................................................................57
List of Views ...................................................................................... 58
Master Design View ...........................................................................45
Overview ............................................................................................ 45
User Views ......................................................................................... 45

Y
Yellow Color

Traffic Light ..................................................................................... 151
189







A
D
P.
F
F
Te
F
w

1M
R

S
75

12
67

-M
U

M
 E

N
 0

2.
20

06
BB Oy
istribution Automation 
O. Box 699 
I-65101 Vaasa 
INLAND
l.  +358 10 22 11 

ax. +358 10 224 1094
ww.abb.com/substationautomation


	Contents
	About this manual
	Copyrights
	Trademarks
	Guarantee
	General
	Use of symbols
	Abbreviations
	Related documents
	Document revisions

	Introduction to SMS 510
	General
	Documentation guidance
	Documentation in general
	Navigating in the SMS 510 User’s Guide
	SMS 510 User’s Guide contents
	Separate documentation

	Operational features
	User interface
	Base system
	Applications
	SMS 510 functions and tools
	Project Structure Navigator
	Project handling
	System configuration
	Monitoring functions
	Relay Setting tools
	Disturbance recording tools
	Disturbance evaluation tools
	Additional tools


	Quick start example
	Inserting objects, to observe
	Summary of steps
	Projects
	Views
	Object types
	Object type groups
	Starting SMS 510
	Exiting SMS 510
	Insertion of objects
	Moving objects in the project
	System configuration
	Configuration of device objects
	General
	Relay configuration procedure
	RED 500 relay object types
	SPACOM relay object types
	REx 216/316 relay object types
	REB 500 relay object type
	REx 5xx relay object types

	Summary

	Using user views
	Launching object tools
	Launching tools for RED 500
	Launching tools for SPACOM
	Launching tools for REx 216/316
	Launching tools for REB 500
	Launching tools for REx 5xx


	Project Structure Navigator
	General
	Projects
	Master Design View
	User views

	Object types
	Object type groups
	User interface
	Entering the Project Structure Navigator
	File menu
	File Open
	File Close
	Organize Projects
	File History List
	Exit

	Edit menu
	Insert Object
	Delete Object
	Object Properties
	General Object Attributes dialog
	Moving objects


	Views menu
	Create View
	Delete View
	View Properties
	View List

	System Tools menu
	Customize...

	Help menu
	About Project Structure Navigator
	About SMS 510


	Project Export/Import Tool
	General
	Starting the Project Export/Import Tool
	Features
	Updating the project list
	Project Storage
	Copying projects between network computers
	Choosing storage location for temporary projects
	Exporting projects
	Importing projects
	Project properties
	Deleting a project
	Duplicating a project
	Creating a new project
	Set As Local
	Errors accessing remote disk resources


	Plant Structure Settings
	General
	Starting the Plant Structure Settings Tool
	Attributes of Plant Structures
	Level Id
	Level Description
	Field Length


	Plant Structure object types
	Overview
	General
	Field Length
	Station
	Bay

	User Structure object types
	Overview
	General
	Inserting Level objects


	Gateway object types (COM 610)
	General
	Supported protocols
	Insertion
	Communication setting
	Communication settings of COM 610 object
	Communication settings of device object

	Using COM 610 object

	System Self Supervision
	General
	System Self Supervision activation
	Objects supervised by System Self Supervision
	System Self Supervision object presentation
	System Self Supervision object maintenance

	Enabling System Self Supervision
	Disabling System Self Supervision
	Opening the System Self Supervision view
	Exiting the System Self Supervision view

	SSS object status representation
	Status information
	Status icons
	Icon OK
	Icon Not OK
	Icon Dimmed
	Icon NoConf
	Icon Stop
	Icon No

	Application State supervision
	Line Communication supervision
	Operating System Events supervision


	Supervision Log Viewer
	Overview
	Supervision Log Viewer users

	Types of log events
	Glossary
	Common events
	Operating System events
	System events
	Security events
	Application events


	Starting Supervision Log Viewer
	Toolbar and menus
	Log menu
	View menu
	Filter menu
	Options menu
	Help Menu


	Remote connections
	General
	Features
	LAN and Remote/RAS
	Application areas
	Supported relays and tools

	Dial-Up (SPA)
	Application areas


	Activating a remote connection
	Remote/RAS activation
	Connection Status
	Remote Task Monitoring

	Closing a remote connection
	Initial steps before adding a remote connection
	Passwords and access using LAN and Remote/RAS

	Preparing remote connections
	Adding an item to the Remote Connection List
	Modifying an item in the Remote Connection List
	Deleting an item in the Remote Connection List
	Configuring properties for a Remote Connection List item
	Configuring a LAN type of connection
	Two LAN setting examples
	Checking connection
	Configuring a remote type of connection (RAS)
	Remote/RAS setting example
	Advanced settings

	Connecting to SYS 500 or COM 500
	Connecting to SYS 500 or COM 500 systems that have LIB 5x0 installed
	Connecting to SYS 500 or COM 500 systems that have no LIB 5x0 installed
	Remote Connection Properties when connecting to SYS 500/LIB 5x0 or COM 500/LIB 5x0 systems over LAN or RAS

	Configuring Dial-Up (SPA) type of connection


	Time/Date Settings, Time Synchronization and General Settings
	Time/Date Settings
	Starting Time/Date Settings
	Menus
	Settings menu
	Help menu


	Time synchronization
	Starting/Stopping Time Synchronization (SPA)

	General Settings
	Automatic Monitor Logoff
	System Self Supervision
	MicroSCADA user settings for remote connections


	User Management
	General
	Starting User Management
	User Manager main switch
	User language
	User interface

	File menu
	Save
	Print
	Print Setup
	Exit

	View menu
	Tools menu
	Add User
	Remove User
	Add Group
	Remove Group
	Change Password
	Define View Monitors

	Help menu
	Help
	About User Management


	Task scheduling
	General
	Scheduler operating principles
	Activation of scheduled tasks
	Stopping of Scheduler tasks
	Opening the Scheduler for task preparation
	Task preparation for task scheduling
	Adding tasks
	Adding a predefined tool

	Adding a user defined tool
	Browsing for user defined tools

	The finished example

	Uploading of disturbance recordings using the Scheduler
	Connection methods
	Connection type dependent upload

	Running DR-Collector Tool over LAN/Remote

	Task monitoring
	General
	Task status colors
	Green color
	Yellow color
	Red color

	Task Monitor
	Task Monitor status list
	Task with status waiting


	Removing of tasks with status waiting

	SMS Conversion Tool
	Purpose
	What is an SMS 010 application?
	Features
	Limitations
	Import remarks

	Abbreviations and terms
	Starting SMS Conversion Tool
	User interface
	Menus and toolbar
	File menu
	Application menu
	Project menu
	Options menu
	Help menu

	Browsing for SMS 010 applications to import
	Select path
	Select a Directory

	Importing SMS 010 applications
	Select Application Root Node
	Starting the import operation
	Import Summary Report
	Import summary messages


	Browsing SMS 510 projects
	Modifying imported projects
	Taking the imported project into use in SMS 510

	Index

